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Installation Overview

Download TIBCO MDM from the TIBCO eDelivery website . To login, you need user name
and password. If you have not received a user name and password, contact TIBCO
Technical Support. After you download TIBCO MDM, install it using the installer provided.

Default Installation Directory

o Microsoft Windows The default installation location is STIBCO_HOME where all
TIBCO products are installed. Typically, STIBCO_HOME is at c:\tibco.

o UNIX The default installation directory depends on who performs the installation:
o For root users, the default installation directory is /opt/tibco.

o For non-root users, the default installation directory is /myhome/tibco, where
myhome is the home directory of the user.

Installer Disk Space Requirements in Temporary Area

« Microsoft Windows Platforms The entire package is extracted into a temp folder
(minimum requirements 40 GB and 4 GB RAM), typically SystemDrive:\Temp or
SystemDrive:\Documents and Settings\user_name\Local Settings\Temp.

o UNIX Platforms The installer launcher first extracts a Java Virtual Machine (JVM) in a
temporary directory (minimum requirements 40 GB and 4 GB RAM) and uses this
JVM to launch itself. The size of the extracted JVM differs from platform to platform.
You can select the temporary area using the following option when starting the
installer:install_package_name.sh -is:tempdir /temp_area

Prerequisites for Installation

Before you start the TIBCO MDM installation, ensure that your system meets all of the
requirements.

TIBCO® MDM Installation and Configuration Guide
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Prerequisites

Software
Component

JDK

JMS Server

Application
Server -

For Typical
install only

Database -
For Typical
install only

Description

TIBCO MDM is certified with AdoptOpenJDK. TIBCO MDM also bundles Java
with the installer. You do not need to download Java from the Oracle
download site. If any updates to Java 11, TIBCO MDM continues to ship
through the hotfix installers.

e For the JBoss WildFly and WebLogic application servers, TIBCO MDM
supports Java 11.

o For WebSphere application server, TIBCO MDM supports Java 1.8.

To install JDK, download the executable file from the Oracle web site, run it
and follow the instruction screens. For open Java, if you come across any
TIBCO MDM problems that require support, download and point to the Oracle
release (JAVA_HOME) to verify that the issue is reproducible before contacting
TIBCO support.

On Windows, JDK is installed in the install_directory\Program Files\Java\
directory. The install_directory is the directory where Windows is installed.
Though a typical JDK installation sets the JAVA_HOME environment, ensure
that the variable has been set correctly.

Consult the readme shipped with your installation of TIBCO MDM for the most
up-to-date software requirements.

The JMS Server must be installed and running with the required queues and
topics created

The Application Server must be installed and running with the correct service
packs applied.

For IBM WebSphere, make sure that JDK patch level matches the application
server fix pack level.

The Database server must be ready with either Oracle, PostgreSQL, or SQL
Server installed and must have a user account with full privileges for the
database. It is also recommended that a second user be created, but with
restricted privileges.

TIBCO® MDM Installation and Configuration Guide
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Software
Component

Client - For
Typical
install only

Web Server
- For
Typical
install only

Cache
Server -
For Typical
install only

Description

The client for the database must be installed on the TIBCO MDM system
machine and must have access to Java JDBC connectors. The SQL Server client
is required for creating new seed data. However, we do not need clients for the
PostgreSQL database.

Oracle Client Software should be Developer Edition or Enterprise Edition and
must be on the computer hosting the application server. TIBCO MDM uses the
sqlldr utility shipped with these Oracle Client Software editions.

Web server is optional and is needed only if you do not plan to use direct URL
access to the application server. if the Web server is going to be used, install it
first.

Cache server is optional and is needed only if a centralized cache sever is
proposed. Make sure the cache server is installed (but not running).

Note: For information about the Cache server, see Enable Apache Ignite for
TIBCO MDM.

Additional Software Components

TIBCO MDM requires additional software components as listed in the following table. The
requirements of components depend on your installation choices and supported
platforms. For a complete list of versions and platforms supported, see the Readme.txt

file.

Required Components

Component to

Install

JDK

Supported options For more information, see:

o For WebSphere application « Installation Overview

server, use JDK 1.8.

o For JBoss WildFly and
WebLogic application

TIBCO® MDM Installation and Configuration Guide
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Component to
Install

Database

Install and configure
a database.

Database Client

JMS Server

Configure a JMS
Server

Application Server

Configure a
supported
Application Server.

Optional Components

Component to Install

1. AS2 Gateway

Supported options

servers, use JDK 11.

Oracle
Microsoft SQL Server
PostgreSQL

Oracle
Microsoft SQL Server

TIBCO Enterprise
Messaging Service

Websphere with or without
Websphere ND

Weblogic
JBoss WildFly

Supported
options

o Any AS2

Server

For more information, see:

Configuration of Oracle
Database

Configuration of SQL
Server Database

Simple Installation with
PostgreSQL

Creating TIBCO EMS
Queues and Topics

Configuring TIBCO MDM
for WebSphere
Application Server

Configuring TIBCO MDM
for WebLogic Application
Server

Configuring TIBCO MDM
for JBoss WildFly
Application Server

For more information,
see:

Configuration of TIBCO

TIBCO® MDM Installation and Configuration Guide
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Component to Install Supported For more information,
options see:

Configure AS2 Gateway for secure (such as TIBCO BusinessConnect and

communication with other systems. BusinessConnect) TIBCO BusinessWorks

(required only for GDSN mode or

external communication). Details for configuring

TIBCO BusinessConnect.
See appropriate
documentation for other
gateways.

2. Cache Server Apache Ignite Configuration Properties

of Apache Ignite
Configure a cache Server. P &

3. Web Server e IBMHTTP  Configuration of Web
Servers
Configure a supported Web Server to « Apache
connect to the application server. Server
o Microsoft
IS
4. X Server RealVNC Installing X Server

Configure to upload images for any
records maintained using TIBCO MDM.

Installing X Server

X Server should be running, if you plan to upload images for any records maintained
using TIBCO MDM. TIBCO MDM uses the X server's rendering buffer to resize an image
when it is uploaded. The DISPLAY environment variable is used in conjunction with the X
server.

TIBCO® MDM Installation and Configuration Guide
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X Server
Need X .
Skip
T —
Yes
Install X
server
arine
Have DBA -
environment
vars
No
Contact DBA, get
MDM user created

One popular X server is RealVNC (http://www.realvnc.com/). Some UNIX distributions come
with a bundled X server or with the VNC X server pre-installed.

For example, to start VNC on a machine running Linux,

Procedure

1. Run the following VNC server command: [vsadmin@hgstage0l vsadmin]$
vhcserver

A message is displayed to create a password, which is required to access your
desktop.

2. Type the password.
The following message is displayed: New 'X' desktop is hgstage01l.tibco.com:1

3. Setthe DISPLAY environment variable as follows: export
DISPLAY=hqgstageOl.tibco.com:1.0

If image upload does not work even though the VNC Server is running, add the
following property in the generic JVM arguments:-Djava.awt.headless=true.

o Default startup script is available in: /home/vsadmin/.vnc/xstartup
« Starting applications specified in: /home/vsadmin/.vnc/xstartup

o Logfile is located in: /home/vsadmin/.vnc/hgstage0l.tibco.com:1.log

TIBCO® MDM Installation and Configuration Guide
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Third-Party Libraries

In addition to the distribution provided by TIBCO, MDM requires additional software. This
software must be provided for the installation and might have different licensing.

This table lists all the software which might be required.

Third Party Libraries
Library Library Name
JDK jsse.jar
Library
XMLC xmlc.jar,
related xmlc-base.jar,
Libraries xmlc
chtml.jar,
xmlc—
taskdef.jar,
xmlc—
xerces.jar,
xmlc-all-
runtime.jar,
and Sunec.jar
gnu-regexp.jar
EMS tibjms.jar and
related jms-2.0.jar
Libraries

Description

Required, if you will be using SSL.
Can be obtained from JDK.

Vendor: ORACLE/IBM/HP

Required for TIBCO MDM UlI.

Click the XMLC Download link under the TIBCO MDM area
at the eDelivery site to download the xmlc-2.2.x.z1ip.

You can choose to download the library or let the installer
download the library during the installation process.

Required for compiling HTML.

Required, if you are using TIBCO EMS as a JMS vendor.

The libraries can be obtained from the installation directory
of TIBCO EMS (pointed by EMS_HOME).

Note: EMS libraries are not applicable for the PostgreSQL database.

JDBC
related
Libraries

ojdbc8.jar
mssql-jdbc-
7.2.2.jrell.-
jar
postgresql-
42.2.11.jar

e 0jdbc8.jar is required for Oracle.

e mssql-jdbc-7.2.2.jrell.jar ( Microsoft JDBC
Driver 7.2 for SQL Server, Java Development Kit (JDK)
11.0) is required for Microsoft SQL Server.

TIBCO® MDM Installation and Configuration Guide
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Library

Hibernate
Assembly

Library Name Description

e postgresql-42.2.11.jar is required for PostgreSQL.
(Not required if you are using Simple Installation)

Copy the following JAR files to SMQ_
HOME/configurator/server/configurator/lib/ext

e 0jdbc8.jar copy from SORACLE_HOME /jdbc/1lib.

o Download the mssql-jdbc-7.2.2.jrell.jar (
Microsoft JDBC Driver 7.2 for SQL Server, Java
Development Kit (JDK) 11.0) file from Microsoft
Download Center.

e postgresql-42.2.11.jar file copy from SMQ_
HOME /bin/pgsql/driver

hibern- Required by TIBCO MDM for some database interactions.
ate3.jar and
cglib-2.2.5ar You can choose to download the library or let the installer

download the library during the installation process.
Click the Download link under the TIBCO MDM area at the

eDelivery site to download the product_tibco_hibernate_
1lgpl_3.6.10.003.z1ip.

All the required libraries are to be added to the distribution provided (ECM.ear) with

TIBCO MDM.

Creating a Consolidated JAR File with Third-Party
Libraries

For EMS related libraries, create a consolidated JAR file with the third-party libraries.
Other JAR files are created during installation.

Ensure the STJAVA_HOME /bin is set in the environmental variable PATH.

Procedure

1. Create a third-party folder in your local drive and copy all the third-party libraries in

TIBCO® MDM Installation and Configuration Guide
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the folder.

2. Go to the third-party directory using the command prompt. For example: cd
../thirdparty

3. To create a JAR, for example, ThirdParty.jar, run the following command:

$JAVA_HOME/bin/jar -cfM
ThirdParty.jar *.jar

This command creates a JAR file of all the .jar files located in the third-party
directory.

After creating JAR files with the third-party libraries, you need to merge the third-
party libraries with ECM.ear post TIBCO MDM installation. For information, see
Performing Postinstallation Tasks for Typical Installation.

TIBCO® MDM Installation and Configuration Guide
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Installation Checklist

Before you install MDM, you need to decide the various options and components.

Installation Checklist

Checklist

Do you need to
install more than
one instance of
MDM and cluster
it?

Have you
installed TIBCO
EMS?

Do you plan to
use text search?

Do you plan to
customize cache
servers?

Do you need
GDSN support?

Description

More than one instance of MDM may be
required to implement:

a) High availability.
b) support higher workloads.

When more than one instance is installed, you
also need to install a web server to provide
load balancing between the instances and to
provide a single URL for all instances.

As part of the installation process, you need to
configure TIBCO EMS for TIBCO MDM.

Text searching provides support for fuzzy
searches.

Cache servers are required when a large
amount of data is to be cached and peer-to-
peer topology is not sufficient.

Global Data Synchronization plug in provides
predefined models for synchronization with
1Sync.

Reference

Clustering Set Up

Configuration of Web
Servers

Configuration of Java
Messaging Server

Text Search and Setup
and Configuration

sections in TIBCO MDM
System Administration

Apache Ignite

o GDSN Overview

o Configuration
of TIBCO
BusinessConne
ct™and TIBCO
BusinessWorks
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Checklist Description Reference
Do you need toa  MDM Ul is localized and is supported in many Support for
enable Ul for languages. Language Pack

languages other
than English?

o Plan the capacity. The capacity planning worksheet is available with TIBCO support
which allows you to estimate the required disk space, memory required for cache
and CPU capacity required for processing workloads.

o Decide the components. For example, text indexing.

« Plan the deployment layout. Decide the components to be installed on different
servers. Decide for sharing the common dir and configuration files. If you need more
than one TIBCO MDM instance and to know how such instances will share the
common directory and configuration files, see Clustering Set Up.

o Decide the Application server and database. As installation steps vary based on
application server and databases, these are important decisions.

o Determine the languages in which you want the data to be stored in MDM. The
storing of multiple languages requires the databases to be set up with correct
options.

o Determine whether there are any custom components to be deployed with MDM.

o Decide whether you want to partition the data. You should consider partitioning the
data if the data volume is high. For example, more than 300 M unique master data
records. If the partitioning is required, contact TIBCO Support or Professional
Services Group to understand how the partitioning can be done.

TIBCO® MDM Installation and Configuration Guide
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Planning for Installation

TIBCO MDM provides two types of installations: simple and typical. Use the installation
roadmaps to get started.

Simple Installation Roadmap

The simple installation provides minimal prompts and installs standard components in the
default locations. You can change the default locations, if required.
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Click a box for more information.
‘{b Shift-click to open a new browser.

Simple Installation

Install JDK and set JAVA HOME

.

Download TIBCO MDM (PostgreSQL+JBoss)

Install TIBCO MDM Using
TIBCO Universal Installer
Download JBoss Application Server and specify the location of the
downloaded JBoss ZIP file
No Create

Enterprise

\L Yes

No Select Data

Model Template

\L Yes

Add sample data

Specify Configurator
> Settings

l

Start TIBCO MDM
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Typical Installation Roadmap (Basic)

Prompts you to choose the basic components of the product that you want to install and

installs only those components.

(Click a box for more information. Shift-click to open a new browser.

Install JOK and set JAVa, HOME

Download TIBCO MDM

Install TIBCO MDM l

Install TIBCO MDM using the TIBCO Universal Installer

¥

Marge Third Party Libraries with ECM.ear

¥

Copy EMS Libearies

\/

Creala TIBCO EMS Queues and Topics

Configure Database

Complete Configuration of Complete Prerequisites
S0L Server Database +
> Start Configurator
Complete Configuration of *
Oracle Dataggma Install Seed Data Using Database Wizard

Configure Application Server and Deploy TIBCO MDM

Configure JBoss WildFly Configure WebSphers Configure WeblLogic
application server application server application server
Deploy TIBCO MDM on Deploy TIBCO MDM on Dagloy TIBCO MDM on
JBoss WildFly application WebSphere application Weblogic application

server Server server
Start TIBECC MDM
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Typical Installation Roadmap (Advanced)

Prompts you to choose the advanced components of the product that you want to install
and installs only those components.

. ? lick a box for more information. Shift-click to open a new browser.

Perform Typical Installation Basic Steps

v

No

Need GDSN
Yes 1

Mo
Install GDSN Plugin Need Central
Cache |
Yes l Yes
Need No
Install AS2 Gateway Install Cache Servers Clustering ~ ¥
L MNeed Other  No|
* ' | Languages
Configure Apache
C?aﬁf;:ﬁ,;?m&ﬂgmfh Web Server Plug-in
| for Webloge Yas
Install Language Pack
v v ¥ ¥ Y

Start TIBCO MDM
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Configuration

The configurations are provided as a reference to plan the deployment. Based on the
number of users and data volume, you can choose how to configure TIBCO MDM.

o Low-End Configuration: All components (web server, application server, JMS server,
and database server) run on the same machine. This configuration is commonly
used for development purposes.

« Mid-Range Configuration: The database server, application server, and web server
run on separate machines. The JMS server can share the same hardware as the web
server. This configuration is typically used for test environments.

« Mid-Range Clustered Configuration: This configuration is similar to mid-range
configuration except that two or more application servers are clustered to support a
large number of users. The clustered application supports load balancing using the
round robin method. Optionally, a hardware or software-based load balancer can be
used to implement the required load balancing algorithm.

» High-End, High-Availability Configuration: This configuration supports high
availability and high data volumes. The database, application server, and web server
run on separate machines. More than one application server and web server are
used for high availability. The database is paired with a standby machine. In this
configuration, each component is paired for redundancy.

You can use a combination of low, mid, and high-end configurations.

Configuration Based on Concurrent Users and Records

Use the following guidelines to determine which configuration is best for your company.
Contact TIBCO Support for a detailed capacity planning spreadsheet.

Recommended Configuration for Concurrent Users

Concurrent Recommended Configuration
Users

1to 20 Low-end
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Concurrent Recommended Configuration

Users
20 to 50 Mid-range
50 to 100 Mid-range clustered with 2 application servers. Each additional application

server supports 30 additional concurrent users.
100 to 500 High-end

Over 1000 Contact TIBCO Customer Support.

Recommended Configuration Based on Number of Records

Number of Records Recommended Configuration
Less than one million Low-end

1 million to 10 million Mid-range / Mid-range clustered
10 million to 50 million High-end

Over 50 million Contact TIBCO Customer Support.

Hardware Configuration

The following table lists sample hardware configurations. Additional memory may be
required to accommodate data caching needs.

Hardware Configurations

Configuration Quantity Type Memory
Sun IBM Intel
Low End
Single machine 1 Sun Fire X4100 - IBM Xeon 4 GB RAM, 50 -100
for web server, 2 CPU xSeries 2 2GHz, GB disk
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Configuration

application
server, and DB
server

Quantity Type

Sun

Mid-range [ Mid-range clustered

Web server

Application
server

Database server

Storage

High-end

Web server

1-2

1-2

Sun Fire x2100 or
Sun Fire x4100
equivalent, 1-2
CPU

Sun Fire x4100 2
CPU with Dual
core processors
or Sun Fire V240
with 4 CPU

Sun Fire 445 or
equivalent with
2-4 CPU

Sun Fire, V100, 1-
2 CPU

IBM

CPU (AMD
or Xeon) or
equivalent

IBM
xSeries 1-2
CPU or
pSeries
entry level
servers

IBM i520 or
IBM 630
with 2-4
core/CPU

IBM i520 or
P630 with
2-4
Core/CPU

IBM P610,
1-2 CPU

Intel

CPU

Xeon

GHz,

CPU

Xeon

GHz,
2-4
CPU

Xeon
GHz,

2-4
CPU

Xeon

Memory

8 GB RAM and Dual
core processors are
recommended to
achieve increased
throughput.

1 GB RAM, 36 GB
internal disk

4- 6 GB RAM, 36 GB
disk

8 GB RAM and dual
core processors are
recommended for

higher throughput.

6-8 GB RAM, 200-
500 GB disk.

Disk array, disks of
100 - 200 GB.

2 GB RAM, 36 GB
internal disks
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Configuration Quantity Type Memory
Sun IBM Intel
2
GHz,
1-2
CPU
Application 2-4 Sun Fire V490 IBM P650, Xeon 6-8 GB RAM, 40 GB
server with 4 CPU or 4-8 CPU 3 disk for each server
Sun Fire x4100 GHz, 12 GB RAM
with 2 CPU dual 4-8
recommended for
core CPU ]
higher throughput.
Database server 1 Sun Fire V4800, IBM P650, Xeon  Minimum 12 GB
4-8 CPU 3 RAM
4-8 CPU
GHz, 400-600 GB disk
48 - isk.
CPU
Storage 1 Disk array, disks of

200 to 500+ GBb.

The hardware required depends on many factors including, number of concurrent users,
usage patterns, retention of history and rate of change for the data. A more accurate
capacity planning exercise should be done based on detailed scenario tests done in
performance labs.

Contact TIBCO Professional Services or TIBCO Customer support for more details on how
to calculate the required hardware. It is recommended that any production hardware
planning must be done using scenario based testing results. A sample capacity planning
worksheet can be obtained from TIBCO Customer Support.

Environment Variables

You must set the important environment variables before installing TIBCO MDM.
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Note:

« Itis recommended that you use ASCII characters for all file names. If these
names include non-ASCII characters, copying the files from Windows to
UNIX or Linux and vice versa may result in corruption of file names.

« While setting environment variables on all platforms, if the ‘\’ character is
used as a path separator instead of ¢/’, it leads to errors as ‘\’ is treated as
an escape character.

o For Simple install, set only JAVA_HOME environment variable.

o For Typical install, set all the environment variables mentioned in the
Environment Variables table.

Environment Variables

Variable

MQ_HOME

MQ_LOG

MQ_ COMMON_
DIR

Description

Define MQ_HOME to point to the installation directory. It is recommended that
you allocate at least 8 GB to this directory. In a clustered environment, each
application server should point to a separate location.

Example: /home/tibco/mdm/version

The location where log files will be generated (the recommended location is
$MQ_HOME/log). In a clustered environment, each server should point to a
separate location. Define MQ_LOG to point to this directory. A minimum of 1
GB should be allocated to this directory. The best practice is to change the
default location such that the directory is not a subdirectory of MQ_HOME.

Example: SMQ_HOME/log

All standard configurations files for workflow and data validation as well as
all customizations are stored in this directory. This directory also holds all
files generated during normal application processing. It is shared by all
application servers in the cluster, and should be mounted to each server. All
disk space indicated in the section Hardware Configuration should be
assigned to this directory, and the MQ_COMMON_DIR variable should be set.
The best practice is to change the default location such that the directory is
not a subdirectory of MQ_HOME.

Example: /home/tibco/mdm/version/common
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Variable

MQ_CONFIG_
FILE

JAVA_HOME

EMS_HOME

ANT_HOME

MQ_HTTP_
SESSION_
REPLICATION_
ENABLED

Description

If you plan to create a copy of the TIBCO MDM instance across operating
systems (for instance, Linux to Windows or Windows to Linux) and if the
path contains any non English characters, such a copy may not be possible.
For example, using Japanese characters in the path.

Points to SMQ_HOME /config/ConfigValues.xml. The values/parameters in
this file can be set using the Configurator.

Example: /home/tibco/mdm/version/config/ConfigValues.xml

The directory where JRE/JDK is installed.

Example: /opt/jdkversion

The directory where TIBCO EMS (or the messaging software) is installed.

Example: /home/tibco/ems

The Directory path where ant is installed.
Example: /opt/antversion
If you use multiple nodes and want to replicate the session, then set the

value of the MQ_HTTP_SESSION_REPLICATION_ENABLED environment variable
to true to enable the session replication.

Application Server Specific

WAS_HOME

JBOSS_HOME

JBOSS_HOME
(Simple

The directory where WebSphere is installed (required only if using
WebSphere).

Example: /opt/WebSphere/AppServer

For JBoss WildFly Application Server. Specify the path value until the root of
the WildFly directory.

Example, E:\JBoss\wildfly-version.Final.

The directory where JBOSS is installed (required only if using simple
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Variable Description

Install) installation).
Example: %$MQ_HOME%\bin\wildfly-version.Final
BEA_HOME For WebLogic Application Server. Specify the path value of the WebLogic
Application Server directory.
Example:
e For Linux: /opt/bea

o For Windows: G: /WebLogic/wlserver_version
Database Specific

ORACLE_HOME  For Oracle database. The directory where Oracle is installed.
Example:
e For Windows: /home/oracle/product/version/db_1

e On UNIX: $export ORACLE_
HOME=/u01/app/oracle/product/version

LD_LIBRARY_  For Oracle database: SORACLE_HOME/1ib
PATH

NLS_LANG For Oracle database. Example:

e On UNIX:

export NLS_LANG=AMERICAN_AMERICA.UTF8

¢ On Windows:

set NLS_LANG=AMERICAN_AMERICA.UTF8

POSTGRESQL_  For PostgreSQL database. The directory where PostgreSQL is installed.

HOME
Example: SMQ_HOME/bin/pgsql
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Variable
0S

DISPLAY

LD_ASSUME_
KERNEL

PATH

SHLIB_PATH

LIBPATH

NODE_ID

Description
The Operating system. For example, Linux.

This environment variable is used by X-Windows based applications. It points
to a device capable of displaying an X-Windows based Ul.

Used on the Linux platform to make Linux use the old Linux threads library,
particularly required for Oracle installation (required only if Oracle is used as
the database).

This is a list of directories separated by a separator. When any command or
program is executed, the OS tries to locate the program in the directories
listed in PATH. If the program is not found in any of the directories, the OS
cannot load and execute the program. The Separator character is ‘.’ for Unix
and Linux platforms, and ‘;’ for the Windows platform.

Ensure that there is no space with the commas and colons between the
program in the directories listed which are separated by ":' for Unix and
Linux platforms, and ;' for the Windows platform.

List of directories separated by a separator (see PATH) where a dynamic
linker tries to find the libraries. Used on UNIX platforms.

List of directories separated by a separator (see PATH) where the Operating
system as well as the application library files reside. Used on UNIX

platforms.

Points to the current cluster member. Example: NODE_ID=Member1l

TIBCO MDM REST API through Swagger Ul

SWAGGER_
MDM_HOST

SWAGGER_
MDM_PORT

An IP address of the TIBCO MDM server on which you want to try out the
TIBCO MDM REST APIs.

Port of the TIBCO MDM server on which you want to try out the TIBCO MDM
REST APIs.
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Storage Requirements

The space allocation requirements depend on many factors, including the number of
records and the number of messages sent and received from other applications.

Space is required for the following components:
o Common directory
o Work
o Temp
» Database
o Log directory
o Local disk for Application Server
« Installation directory
o Other Software

For most development and test environments, 10 GB is sufficient. However, the disk space
required for production and most user acceptance test environments is much higher. A
sample capacity planning worksheet can be obtained from TIBCO Customer Support,
which can help you calculate the disk capacity required.

As disks start to fill up, you can archive or purge data. Space allocation varies according to
the storage systems used and depending on how the disks are arranged, including any
mirroring and archive log retention policies.

Storage Requirement Components

Component Description

Name
Common TIBCO MDM stores some configuration and temporary files on disks. It also
Directory stores files associated with master data on disks.

TIBCO MDM stores certain data in files, including data imported and received
as messages and data output from the application. This type of data is stored
on file systems, with an entry in the database.

Disk requirements depend on size of the files (which directly relate to number of
attributes and size of data for each record), retention period, and rate of
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Component
Name

Database

Log
Directory

Local Disk
for
Application

Description

changes to data. Additionally, the frequency of data synchronization with other
systems and number of such systems may also influence the disk space
requirements. A sample capacity planning worksheet can be obtained from
Customer Support. File systems have work and temp directories besides other
smaller directories.

TIBCO MDM stores most of the master data in a database. The storage needs of
the database depend on various factors including rate of change, data
retention policies and complexity of the data model.

The disk space requirements vary a lot based on usage patterns and the
following numbers should be used as indicative only:

Small: 5GB

Medium: 10-50GB

Large: 50-500GB

It is recommended that 1 GB space be allocated for the log directory so that
sufficient number of debug logs can be accumulated. The debug logs are

generated when TIBCO MDM runs in the debug mode. Using the Configurator,
you can configure the debugging parameters.

You can select the DEBUG option for the Debug Log Logging Level Threshold
parameter. The other options are FATAL, ERROR, WARN, and INFO. The size of
the logs is determined by the following two parameters:

o Debug Log File Backup Size: Indicates the number of debugging log
backup files. By default, the size is 70.

e Debug Log Maximum File Size- Indicates the maximum size of the
debugging log file. By default, the log file size is 5MB.

The log file location is specified by the Standard Log Appender File
parameter. By default, the location is SMQ_LOG/elink.log.

The application server needs at least 6 GB of local free disk space to deploy the
application. This storage is separate from $MQ_COMMON_DIR (8 GB)and SMQ_
HOME (8 GB), and is used by the application server.
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Component Description
Name

Server

Installation This is where MDM is installed. 700 MB is recommended.
Directory

Other Additional disk space is required for:
Software o JMS server

o Web server

o Backups, if taken on disks

See the appropriate documentation from the software vendor for an
estimate of the space required.

Impact of In-Memory Workflows

Workflow can be defined to run in-memory. Such workflows produce less persistent data
and hence require less disk space, both on the file system and the database.

For more information about running workflows in-memory, see TIBCO MDM Workflow
Reference.

Failover considerations

It is recommended that only smaller workflows be run in-memory and not long running
workflows, since in case of failover for an in-memory workflow, the entire workflow is re-
executed. For more information about workflow failover, see TIBCO MDM Workflow
Reference.

Connectivity with External Systems

Skip this section if you do not plan to perform Global Data Synchronization (GDSN).

To connect with 1Sync or similar other data pools, or with any other system requiring AS2
connectivity, you need to install and configure one of the supported AS2 servers as a
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gateway.

If you want to set up connectivity with your backend systems using AS2, you need to
install and configure a compatible AS2 software. Alternatively, you can use a JMS based
communication method.

Internationalization

To support internationalization (I118N) on your system, follow the internationalization

guidelines.

Internationalization Guidelines

Component

Operating
System
Layer

Application
Server Layer

Oracle
Database:

PostgreSQL
Database

SQL Server
Database

Description

Verify that the locale is set correctly to match the character set you will be
using, or to UTF8. Consult your OS documentation for information about how
to do this.

Verify that the JVM arguments for encoding - file encoding and client encoding
(file.encoding, client.encoding.override) - are both set to UTF-8.

This setting is recommended irrespective of whether you want to support
internationalization.

To ensure that language support or multibyte support is consistent throughout
the Oracle instance, set the language support at the time of setting up an
Oracle instance. To support multiple languages, set the flag to UTF-8. See
Configuration of Oracle Database for instructions.

To ensure that language support or multibyte support is consistent throughout
the PostgreSQL instance, set the language support at the time of setting up a
PostgreSQL instance. To support multiple languages, set the Encoding to UTF-
8.

To ensure that language support or multibyte support is consistent throughout
the SQL Server instance, set the language support at the time of setting up an
SQL Server instance. To support multiple languages, set the Collation flag to
the native language with Unicode, for example: Japanese_Unicode_CI_AS.
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Component

Internet
Explorer

Google
Chrome

Firefox

Data Files
and XML

Description

If characters in a certain language are not displayed correctly in the browser,
on the View menu of Internet Explorer, point to Encoding, point to More, and
then click the appropriate language.

If the specific language pack is not installed on the computer, you will be
prompted to download language support components; click Download.

If characters in a certain language are not displayed correctly in the browser,
on the View menu of Chrome, point to Encoding, and then click the
appropriate language.

If characters in a certain language are not displayed correctly in the browser,
on the View menu of Firefox, point to Character Encoding, and then click the
appropriate language or point to More Encodings to find more languages
option.

If you want to upload data using data sources, ensure that data files are saved
with UTF-8 encoding for text files. For any XML file upload, verify that the
encoding is set as follows: “<?xml version="1.0" encoding="UTF-8’?>"

Single Sign-Ons

You can set up
single sign-on.

TIBCO MDM to be used along with other authentication servers to support

o Note: Single sign-on with other authentication servers is not mandatory. If you

do not

use an authentication server for single sign-on or do not plan to manage

user authentication for TIBCO MDM login using authentication servers, skip this
section.

The single sign

-on plugins are provided as examples. These can be customized to

implement other methods of single sign-on. The supported platforms are:

o Any LDAP v3 compliant server, such as, Sunone Directory Server.

o IBM's Tivoli Access Manager.
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o Computer Associates eTrust SiteMinder.

Single Sign-Ons

Types of
Single
Sign-on

LDAP
Single
Sign-On

SiteMinder
Single
Sign-on

Description

With LDAP, you are expected to use LDAP authentication to access the TIBCO
MDM application and the same LDAP information can be used to bypass the first
login page if a single sign-on is configured (for instance, SiteMinder or TAM or
Oblix).

Preferred LDAP Platforms

Verify that the systems and software at your site meet the following requirements:

e Sunone Directory Server
o LDAP Server: Oblix COREid

e Tivoli Access Manager (TAM)

Organizations using Computer Associates eTrust SiteMinder for access
management can configure TIBCO MDM to work with SiteMinder. When TIBCO
MDM is configured to use the user authentication from SiteMinder, end users will
bypass the TIBCO MDM login page when accessing the TIBCO MDM application.

Clustered Deployment Recommendations

If you are deploying TIBCO MDM in a cluster (more than one application server), you can
deploy with one of these options.

Clustered Deployment Recommendations

Options

Option 1

Description

MQ_HOME is on a common file system which is shared between all

(recommended) application servers. The ConfigValues.xml file has configuration for all

instances. The advantage is that servers are guaranteed to run the same
version. Any mismatch of version will result of failures. In both options, MQ_

TIBCO® MDM Installation and Configuration Guide



39 | Configuration

Options Description

LOG is not shared, each application server should have its separate log
directory. It is recommended that MQ_LOG points to internal disks to reduce
the disk write overhead. MQ_COMMOM_DIR is on a common file system which
is shared between all application servers.

Option 2 Each application server has a separate MQ_HOME where all application
images are stored. The config/ directory must be identical for all
application servers, including ConfigValues.xml. The ConfigValues.xmlis
to be managed using the Configurator.

This option should be used only if MQ_HOME sharing is not possible. Care
should be taken to ensure that the config/ directory is synchronized
between all instances whenever a configuration change is made.

MQ_COMMOM_DIR is on a common file system which is shared between all
application servers.

Typical Deployment

A typical production deployment with high availability is illustrated in the Typical
Deployment figure.

Typical Deployment

) Primary
Citd Application G Applicattian CIM Cache Sarver /M Databiase Servar
Server Server

Application Sever
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Configuration of Java Messaging Server

As part of the installation process, you can configure TIBCO EMS for TIBCO MDM. In
general, this involves creating queues and configuring associated property files.

Predefined Queues and Topics

TIBCO MDM provides some predefined queues and topics. For a complete list of queues
and topics, see the "Queue Management" chapter in TIBCO MDM System Administration.

You can customize queue and topic names and also map logical and physical queue and
topic names using the Configurator.

Note: If TIBCO MDM changes the format of these configuration files in future, all
customizations made to these files may need to be applied to new files shipped
with the new version of TIBCO MDM.

Creating TIBCO EMS Queues and Topics

The required queues and topics are located in the $MQ_
HOME/bin/install/createQueues.txt file.

Before you begin
Ensure that the EMS Server is running.

Procedure
1. Go to All Programs > TIBCO > TIBCO EMS version and click Start EMS
Administration Tool. The command prompt is displayed.

2. Type Connect.

3. Enter login name and password.
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Note: If you have not created the administration credentials, press Enter.
By default, administration login name and password is retrieved.

The connected to: tcp://localhost:port_number message is displayed.
4. Go to $MQ_HOME/bin/install and open the createQueues. txt file.

5. Copy content of the createQueues. txt file and place it in the command prompt.

Queues and topics are created.

Verifying Queues and Topics

You can verify a list of created queues and topics.

Procedure

1. Go to All Programs > TIBCO > TIBCO EMS version and click Start EMS
Administration Tool.
The command prompt is displayed.

2. Type Connect.
3. Enter login name and password.

4. Type show queues in the command prompt and press Enter.
A list of created queues is displayed.

5. Type show topics in the command prompt and press Enter.
A list of created topics is displayed.

Configuring EMS over SSL

You can configure the EMS server to start running over SSL.

Procedure
1. Stop the application server.

2. Edit the following values in SEMS_HOME\tibco\cfgmgmt\ems\data\tibemsd.conf file.

o specify the SSL protocol in the listen parameter: listen=
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ssl://hostname:portno

e ssl_server_identity = TIBCO_HOME/ems/version_
number /samples/certs/server.cert.pem

e ssl_server_key = TIBCO_HOME/ems/version_
number /samples/certs/server.key.pem

e ssl_password = $man$WjtSRCpaXu7hoTkDLcEPr6KNKRr

e ssl_server_trusted =TIBCO_HOME /ems/version_
number /samples/certs/client_root.cert.pem

3. Start EMS server using the updated tibemsd.conf file.

TIBCO_HOME /ems/version_number /bin/tibemsd -config EMS_
HOME /tibco/cfgmgmt/ems/data/tibemsd. conf

The EMS server starts running over SSL.

Configuring EMS over SSL on Application Servers

To configure EMS over SSL, configure the application servers.

Application Steps

Server

WebSphere 1. Stop the application server.

Applicati

San)lécra on 2. Copy the following JAR files from $EMS_HOME/11ib to $WAS_

HOME/lib/ext folder:
e slfd4j-api-1.4.2.jar
e slf4j-simple-1.4.2.jar

3. Copy the server_root.cert.pem certificate from $SEMS_
HOME /samples/certs folder.

4. In WebSphere Application Server, perform the following steps:

a. Under Server Infrastructure, expand Java and Process Management
and click the Process definition link.

b. On the Configuration tab, under Additional Properties, click the
Java Virtual Machine link.
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Application Steps
Server

C. On the Configuration tab, in the Generic JVM arguments field,
enter the following JVM arguments:

-Dcom.tibco.tibjms.naming.security_protocol=ssl
-Djsse.providerClass=com.ibm.jsse2.IBMJSSEProvider2
-Dcom.tibco.tibjms.ssl.expected_hostname=server
-Dcom.tibco.tibjms.ssl.enable_verify _host_name=false
-Dcom.tibco.tibjms.ssl.enable_verify _host=false

-Dcom.tibco.tibjms.ssl.trusted=/local/vsadmin/server_root.cert.pem

Enter these arguments in a single line, separated by a single space.

5. Log in to the Configurator and navigate to InitialConfig > Memberl >
Security Provider > IBM

e Change the value of SSL Protocol Handler Package property

from:com.ibm.net.ssl.internal.www.protocolto
com.ibm.net.ssl.www2.protocol

e Change the value of SSL Provider property

from:com.ibm.jsse.JSSEProvider to
com.ibm.jsse2.IBMJISSEProvider2

JBoss 1. Create a module with name as com. tibco.mdm in JBoss WildFly
WildFly application server - 18.0.1 version. For information about creating
Application modules, see Module Creation.

Server 2. Copy the following JAR files in this module (inside the main directory)

from SEMS_HOME/1ib
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Application Steps
Server

e slfd4j-api-1.4.2.jar
e slf4j-simple-1.4.2.jar

3. Copy the following JAR files in this module. The JAR files are available in
the classpath of the JBoss WildFly application server or in JAVA_
HOME\jre\lib directory:

e jsse.jar
e jce.jar

4. Update the module.xml file as follows:

<module xmIns="um:jboss:module:1.3" name="com.tibco.mdm">
<resources>
<resource-root path="slf4j-api-1.4.2.jar"/>
<resource-root path="slf4j-simple-1.4.2.jar"/>
<!- ifthese 2 JARS copied in the module then add -->
<resource-root path="jsse.jar"/>
<resource-root path="jce.jar"/>
</resources>
<dependencies>

<module name="javax.api" />
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Application Steps
Server

<module name="javax.jms.api" />
<module name="javax.resource.api" />
<!I--These are required for EMS with SSL -->
<systemexport="true">
<paths>
<path name="sun/security/ssl" />
<path name="com/sun/net/ssl/internal/ssl" />
<path name="sun/security/util" />
<path name="sun/security/validator" />
<path name="sun/security/provider" />
<path name="javax/net/ssl" />
<path name="sun/net/www/protocol/https" />
</paths>
</system>

</dependencies>

5. Add the global module in subsystem section <subsystem
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Application Steps
Server

xmlns="urn:jboss:domain:ee:4.0"> in JBOSS_
HOME /standalone/configuration/standalone.xml.

<subsystem xmins="urn:jboss:domain:ee:4.0">

<global-modules>

<module name="com.tibco.mdm" slot="main"/>

</global-modules>

</subsystem>

OR

Add a dependency in jboss-deployment-structure.xml in
ECM.ear /META-INF in dependency section:

<dependencies>

<system export="true">

<paths>

<path name="com/sun/net/ssl/intemal/ssl" />

</paths>

</system>
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Application Steps
Server

<module name="com.tibco.mdm"/>

</dependencies>

6. Add the following in the JVM arguments in $JBOSS_
HOME /bin/standalone.conf.bat

-Dcom.tibco.tibjms.ssl.enable_verify_host_name=false
-Dcom.tibco.tibjms.ssl.enable_verify _host=true
-Dcom.tibco.tibjms.ssl.expected_hostname=server

-Dcom.tibco.tibjms.ssl.trusted=$EMS_HOME/samples/certs/server_root.cert.pem

Specify the values for the TIBCO EMS configuration properties in the Configurator.

1. Log in to the Configurator.
2. Navigate to Queue Setup > Messaging Cluster > TIBCO EMS.

Change the value of Localhost Server Connection String property to
ssl://hostname:portno

3. Navigate to Bus Setup > Cluster > TIBCO EMS.

4. Change the value of Localhost Server Connection String property to
ssl:/[hostname:portno
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What to do next
1. Start the application server.

2. Login to TIBCO MDM.

TIBCO MDM starts running on SSL.
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TIBCO MDM Installation

You can run the TIBCO installer in different modes, supported on all platforms.

TIBCO MDM may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the
Readme.txt file to locate whether or not TIBCO MDM is available on a particular operating
system.

Note: If you select Simple Installation with PostgreSQL, you can skip the sections
from TIBCO MDM Installation on Application Servers to Support for Language
Pack.

Simple Installation with PostgreSQL

The simple installation provides minimal prompts and installs standard components in the
default locations. You can change the default locations, if required.

The simple installation includes the following features:

o Currently supports JBoss WildFly Application Server and PostgreSQL database on
Windows and Linux.

« Similar to the existing installer, in addition, it bundles the following dependencies
except EMS.

o Apache Ignite

o TIBCO Patterns - Search(Netrics)
o PostgreSQL Database

o JBoss modules

« Installs dependencies in $MQ_HOME/bin directory. Therefore, not much control over
the directories.

« Provides an additional page to download the JBoss WildFly Application Server, that
is, the installer zip file.

« Provides default settings, thus TIBCO MDM is configured automatically.
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Installing TIBCO MDM (Simple Installation)

In Simple installation, the installer bundles, installs, and configures most of the required
software. You need not worry about dependencies. Thus, it simplifies the installation
process.

Before you begin

Verify that your computer meets the system requirements to install TIBCO MDM for
PostgreSQL. The system requirements are listed in the readme.txt file. All the
software components are installed under $MQ_HOME. Ensure that you have at least 5
GB of disk space.

Set the $JAVA_HOME environment variable.

Optional: Download the wildfly-18.0.1.Final.zip file from
http://wildfly.org/downloads/.

If you are installing in a Linux environment, ensure that you are a non ROOT user.

TIBCO MDM does not use the existing PostgreSQL instance. It re-installs and re-
configures PostgreSQL. Ensure that you have stopped the current PostgreSQL
instance, if running. Ensure that the default port 5432 is not in use.

Download TIBCO MDM from TIBCO eDelivery site. The application is available as a
ZIP file.

Extract contents of the ZIP file to a folder on your computer.

Search for the TIBCOUniversallnstaller application in the location where you have
extracted the ZIP file.

Procedure

1.

Run the TIBCOUniversalInstaller.exe application. The TIBCO Universal Installer
Welcome window is displayed.

Review the information and click Next. The license agreement is displayed.

Review the terms of the license agreement. If you agree with its terms, accept the
license agreement and click Next.

In the Installation Profile Selection window, do one of the following:

a. Select Create a new TIBCO_HOME option. A TIBCO installation environment is
used for software installations and consists of a Name and Directory. Products
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installed into different installation environments do not share components;
therefore you can keep product installations completely isolated from each
other.

« Directory: Browse to the directory where the product needs to be
installed and provide a unique environment name. Ensure that you have
write permission to this directory.

o Note: On Microsoft Windows, it is recommended that you do
not install under C:\Program Files or any other directory
which contains spaces in the name. The Simple installer does
not recognize the path if the folder name contains a space.

o Name: Specify the environment name.

b. If you have previously installed a TIBCO product using the Universal Installer,
you can select Use an existing TIBCO_HOME. By default, the installer detects
the directory for your TIBCO_HOME and displays the path.

Note: If you had installed the application earlier, the directory
cannot be modified. For a new installation, the directory can be
changed.

5. Click Next. The Installation Profile Selection window is displayed. By default, the
Typical installation profile is selected.

a. If you select the Customize Installation check box, a list of components is
enabled (Executable Image and Common Configuration).

b. Select your preferred options and click Next.
6. In the Download JBoss Application Server window, do one of the following:

a. Download the wildfly-18.0.1.Final.zip file by clicking the URL and save it to
your local drive.

b. Click Browse and select the ZIP file location. If you have already downloaded
the JBoss Application Server, point it to the existing ZIP file and click Next.
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o Note: The installer validates the wildfly-appclient-18.0.1.Final.jar

file located in the wildfly-
18.0.1.Final/modules/system/layers/base/org/jboss/as/appclient/ma
in directory.

7. In the Enterprise Creation window, do the following:
a. Select the Create Enterprise check box. The following fields are enabled:
Enterprise Name: Type the enterprise name.
Admin User Name: Type the user name of the administrator.

Admin Password: Type the password of the administrator.

o Note: The password must contain eight alphanumeric characters
with at least one lowercase and one uppercase alphabet and one
numeric entry. Additionally, if you want to add special characters,
change the default value of the Password Required property. For
information about password policy, see the section, "Configuration
Properties for Password" in TIBCO MDMSystem Administration.

Click Next.

o Note: If you do not select the Create Enterprise check box, an
enterprise and administrator credentials fields are disabled, and the
next Template Selection window is not displayed.

8. In the Template Selection window, do the following:
a. Select any one of the data models:

e None

o Note: If you select None, the Customer, Party and Insurance
options and the Add Sample Data check box are disabled.

o Customer

« Party
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10.

11.

12.

13.

« Insurance

b. If you select Customer or Party or Insurance option, you can also select the
Add Sample Data check box.

c. However, if you do not select the Add Sample Data check box, the customer,
party or insurance models are imported but the sample data is not added.

d. Click Next.

In the TIBCO MDM Configurator Settings window, the default port values are
displayed. You can change the default port values. Click Next.

o Note: The specified port values must not be in use by another application.

In the TIBCO MDM Common Config Location window, select the common
configuration location and click Next.

If you have selected the standard common configuration option, the default $mMQ_
HOME\ common directory location is displayed. You can retain the location or change it
by clicking Browse.

Note: If you do not specify the common configuration location,
Configurator does not start and you need to perform the manual
configuration. For information, see Manually Configuring TIBCO MDM.

In LGPL Assembly Download window, select one of the following options:

o Download HIBERNATE assembly from TIBCO: if you select this option, the
HIBERNATE assembly is downloaded and configured.

o Provide the location for the assembly previously downloaded from TIBCO: If
you select this option, the HIBERNATE Assembly Path field is enabled. Click
Browse to select the HIBERNATE assembly.

Click Next.

The HIBERNATE LGPL License Agreement window is displayed. If you agree with its
terms, accept the license agreement, and click Next.

The XMLC LGPL License Agreement window is displayed. If you agree with its terms,
accept the license agreement, and click Next.
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14.

15.

16.

17.

18.

19.

In LGPL Assembly Download window, select one of the following options:

o Download XMLC assembly from TIBCO: if you select this option, the XMLC
assembly is downloaded and configured.

o Provide the location for the assembly previously downloaded from TIBCO: If
you select this option, the XMLC Assembly Path field is enabled. Click Browse
to select the XMLC assembly.

Click Next.

The Oracle Elliptic Curve Library LGPL License Agreement window is displayed. If you
agree with its terms, accept the license agreement, and click Next.

In LGPL Assembly Download window, select one of the following options:

« Download Oracle Elliptic Curve Cryptography Library assembly from TIBCO: if
you select this option, the Cryptography assembly is downloaded and
configured.

o Provide the location for the assembly previously downloaded from TIBCO: If
you select this option, the Oracle Elliptic Curve Cryptography Library
Assembly Path field is enabled. Click Browse to select the Cryptography
assembly.

Click Next.

In the Pre-Install Summary window, review a list of the components that are going to
be installed and the installation environment details and click Next.

In the Post-Install Summary window, review a list of the components that are
installed and the installation environment details.

Click Finish to exit the wizard.

o Note: On some Windows environments, databases might not get created
postinstallation. For successful database creation, create a folder, apply
the Full Control permission to it, and then install TIBCO MDM in this
specific folder.

Performing Postinstallation Tasks for Simple Installation

For the first time installation, the TIBCO MDM server, Netrics server, and the Configurator
automatically start. You need to complete the postinstallation tasks for the second time
installation of TIBCO MDM.
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After installation, $MQ_HOME contains most of the required software.

Folder Component
$MQ_HOME/bin/ignite Apache Ignite Cache Server
$MQ_HOME /bin/wildfly-version.Final JBoss WildFly Application Server
$MQ_HOME/bin/pgsql PostgreSQL Database Engine
$TIBCO_HOME/tps TIBCO Patterns - Search Server

The following table lists the ports available after installation:

Port Number Component

8080 HTTP JBoss WildFly Application Start Server Port

8009 HTTP JBoss WildFly Application Stop Server Port

6080 Configurator HTTP Port

5051 TIBCO Patterns - Search Server Standard Port

5432 PostgreSQL Database Standard Port

48500 Apache Ignite Cache Server Default Port
Procedure

1. Start TIBCO MDM Server: Ensure that$JAVA_HOME is set.

a. Select the Start MDM Server option from the Programs menu or run
StartMDMServer.bat(.sh). The file is located at $MQ_HOME/bin/wildfly-
version.Final/bin.

The TIBCO MDM server starts. Starting the TIBCO MDM server starts the
PostgreSQL database instance and netricsServer.

b. Optional: If you want to stop the TIBCO MDM server, select the Stop MDM
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Server option from the Programs menu or run StopMDMServer.bat(.sh). The
file is located at $MQ_HOME/bin/wildfly-version.Final/bin.

The TIBCO MDM server stops. Stopping the TIBCO MDM server stops the
PostgreSQL database instance and netricsServer.

2. Start TIBCO MDM: Type http://localhost:8080/eml/Login in the browser. For more
information aboutaccessing TIBCO MDM, see "Introduction to TIBCO MDM" chapter
of the TIBCO MDMUser's Guide.

3. Optional: Start and Stop PostgreSQL Server
a. To start PostgreSQL, run pg_start.bat or pg_start.sh.
b. To stop PostgreSQL, run pg_stop.bat or pg_stop.sh.
The files are located at $MQ_HOME/db/postgreSQL/install.
4. Optional: Start and Stop TIBCO Patterns - Search Server

a. To start the TIBCO Patterns - Search Server, run netricsServer.bat -
startService Or netricsServer.sh -startService.

b. To stop the TIBCO Patterns - Search Server, run netricsServer.bat -
stopServer Or netricsServer.sh -stopServer.

The files are located at $MQ_HOME /bin.

For more information, see TIBCO MDMSystem Administration.

5. Optional: Start and Stop the Configurator

If you want to change default configuration, you can start the Configurator. Ensure
that the $JAVA_HOME environment variable is set and it points to the valid JDKversion
installation path.

a. Use the Start Server option or run startup.bat/.sh to start the Configurator.

b. Use the Shutdown Server option or run shutdown.bat/.sh to stop the
Configurator.

The startup.bat/.sh and shutdown.bat/.sh files are located at $MQ_
HOME /configurator/server/bin.

c. Use the Launch option or double-click $MQ_HOME/configurator/launch.html to
start the Configurator.

d. To login to the Configurator, type euc!1dAl as user name and password
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credentials.

To change the default credentials, edit the ConfiglLogin.info file located at
$MQ_HOME/config folder. Change the password in the

admin.password=password field.

Troubleshooting with Simple Installation

If you encounter an issue while installing TIBCO MDM with PostgreSQL, you may resolve
the issues by completing the common troubleshooting procedures.

Troubleshooting with Simple Installation

Issue Description

Database The following exception is
specific displayed in $MQ_

error HOME /log/elink.log: Unable

to get managed connection for
java:jboss/eCMDataSource

The exception may get display
due to the following reasons:

o PostgreSQL is not
running.

o PostgreSQL initialization
failed.

e MDM database schema
does not exist.

Solution

To resolve this error, perform the following
steps:

Execute pg_start.bat/.sh and pg_
stop.bat/.sh to start and stop PostgreSQL

Server. The files are located at $MQ_
HOME /db/postgreSQL/install.

Execute pg_init.bat/.sh to initialize the
PostgreSQL database instance. The files are
located at $MQ_HOME/bin/pgsql.

Perform the following tasks:

o Create the missing tablespace
directories:

$MQ_
HOME/bin/pgsql/tablespaces/velodb
data $MQ_
HOME/bin/pgsql/tablespaces/velodb
indx

Ensure that the logged in user is the
owner and has full permission to access
these directories.

e Execute install.bat from $MQ_
HOME /db/postgreSQL/install and type
the following:
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Issue Description Solution

$MQ_HOME /bin/pgsql localhost 5432

postgres USERNAME "" mdmuser
mdmpassword

Where USERNAME is the logged-in user
name.

$MQ_
HOME/bin/pgsql/tablespaces/velodb
data $MQ_
HOME/bin/pgsql/tablespaces/velodb
indx dev dev

Verify if the MDM schema exists by
starting the PostgreSQL Administration

console.
The When you run pgAdmin4.exe Install PgAdmin 4 Client standalone.
pgAdmin  from $MQ_
4 tool HOME\bin\pgsql\pgAdmin4\bi
Error n, the black page is displayed.

The issue occurs on Windows
2008 R2 and PostgreSQL
combination.

Installing TIBCO MDM (Typical Installation)

In the typical installation, the installer presents panels which you can select choices about
the product location, and so on.

Prerequisites

Verify that your computer meets the System requirements. The system requirements
are listed in the readme.txt file.

Download the Installer. The application is available as a ZIP file.
Extract the contents of the ZIP file to a folder on your computer.

Search for the TIBCOUniversallnstaller application in the location where you have
extracted the ZIP file.
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Procedure
1. Run the TIBCOUniversalInstaller.exe application. The TIBCO Universal Installer
Welcome window is displayed.

2. Review the information and click Next. The license agreement is displayed.

3. Review the terms of the license agreement. If you agree with its terms, accept the
license agreement and click Next.

4. In the Installation Profile Selection window, do one of the following:

a. Select Create a new TIBCO_HOME option. A TIBCO installation environment is
used for software installations and consists of a Name and Directory. Products
installed into different installation environments do not share components;
therefore you can keep product installations completely isolated from each
other.

« Directory: browse to the directory where the product needs to be installed
and provide a unique environment name. Ensure that you have write
permission to this directory.

o Name: specify the environment name that is easy to identify your
environment. For example, 'User Acceptance' or 'Procurement
Department'.

a. If you have previously installed a TIBCO product using the Universal Installer,
you can select Use an existing TIBCO_HOME. By default, the installer detects
the directory for your TIBCO_HOME and displays the path. For example, on
Windows, the default installation directory is c:\tibco.

Note: If you had installed the application earlier, the directory
cannot be modified. For a new installation, the directory can be
changed.

Click Next.

5. In the Installation Profile Selection window, by default, the Typical installation
profile is selected.

a. If you check the Customize Installation check box, a list of components is
enabled (Executable Image and Common Configuration).

b. Select your preferred options and click Next.
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6.

10.

In the TIBCO MDM Configurator Tomcat Settings window, the default port values are
displayed. You can change the default port values. Click Next.

A Warning: The specified port values must not be in use by another
application. If you do not specify configuration information, Configurator
does not start and you need to perform manual configuration. For more
information about the Configurator, see Configurator.

In the TIBCO Patterns - Search Settings window, the default user interface port value
(required for Patterns GUI tomcat server) and Patterns server port value (required
for Patterns binary) are displayed. You can change the default port values.

a. Select Install as a Windows Service check box if you want to install the
Patterns server binary as a service.

Click Next.

In the TIBCO MDM Common Config Location window, select the common
configuration location and click Next.

If you have selected the standard common configuration option, the default $MQ_
HOME\ common directory location is displayed. You can retain the location or change it
by clicking Browse.

° Tip: The best practice is to assign a location separate from MQ_HOME.
TIBCO MDM creates files in this directory and it is better to keep it
separate from MQ_HOME. In a clustered environment, this directory should
be shared for all instances.

o Note: If you do not specify the common configuration location,
Configurator does not start and you need to perform the manual
configuration. For information, see Manually Configuring TIBCO MDM.

The HIBERNATE LGPL License Agreement window is displayed. If you agree with its
terms, accept the license agreement, and click Next.

The LGPL Assembly Download window is displayed. Select one of the following
options:

o Download HIBERNATE assembly from TIBCO: if you are downloading the LGPL
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11.

12.

13.

14.

15.

assembly for the first time, select this option. The HIBERNATE assembly is
downloaded in the same folder as the installer. All the third party software
which is used in the application and their licenses are downloaded.

o Provide the location for the assembly previously downloaded from TIBCO: if
you have previously downloaded the LGPL assembly, specify the folder in which
you have downloaded the hibernate assembly. Browse to the directory where
the assembly is previously downloaded and saved.

Note: If the LGPL Assembly is already downloaded, the LGPL Assembly
Download window is not displayed.

Click Next.

The XMLC LGPL License Agreement window is displayed. If you agree with its terms,
accept the license agreement, and click Next.

Select the Download XMLC assembly from TIBCO option. The assembly gets
downloaded in the same folder as the installer. Click Next.

The Oracle Elliptic Curve Library LGPL License Agreement window is displayed. If you
agree with its terms, accept the license agreement, and click Next.

In LGPL Assembly Download window, select one of the following options:

« Download Oracle Elliptic Curve Cryptography Library assembly from TIBCO: if
you select this option, the Cryptography assembly is downloaded and
configured.

o Provide the location for the assembly previously downloaded from TIBCO: If
you select this option, the Oracle Elliptic Curve Cryptography Library
Assembly Path field is enabled. Click Browse to select the Cryptography
assembly.

Click Next.

Note: The steps 13 and 14 are applicable only for the JBoss WildFly
application server with Oracle and SQL server database combination.

In the Pre-Install Summary window, review a list of the components that are going to
be installed and the installation environment details and click Next to begin the
installation process.
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16. In the Post-Install Summary window, review a list of the components that are
installed and the installation environment details. Click Finish to exit the wizard.

Result

The following auto generated log files are created in the
C:\Users\username.TIBCO\install_currentyear-currentmonth-currentdate.uniquelD folder:
Using the log files, you can troubleshoot for errors in the installation process.

« antTask_log_installerConfig_currentyear-currentmonth-currentdate.uniquelD: consists
of configuration related logs.

o antTask_log_installerMergeXMLC_currentyear-currentmonth-currentdate.uniquelD:
consists of the XMLC merge related logs.

« tibco_universal_installer.username_install: consists of installer related logs.

o antTask_log_updateEARTolncludeHibernateLib_currentyear-currentmonth-
currentdate.uniquelD: consists of ECM.ear file related logs.

Postinstallation Task Roadmap for Typical Installation

After you install TIBCO MDM, you must complete other tasks, such as merging third-party
libraries with ECM.ear, deploying the updated ECM.ear, and so on.

See the following diagram for step by step postinstallation tasks:
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Troubleshooting with Typical Installation

If you encounter an issue while installing TIBCO MDM, you may resolve the issues by
completing the common troubleshooting procedures.
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Troubleshooting with Typical Installation

Issue

Display
Cannot be
Opened

Installer
Terminates

Description

The UNIX
installer
terminates
with the
following
error
message:

Could not
open
display

The installer
terminates
without any
error
message.

Solution

If you run the UNIX installer in a graphical mode, your local
display has to be specified to the server. This local display needs
to have a X Windows client installed. The local display is typically
indicated to the server by specifying the DISPLAY environment

variable. For example, on a bash shell: export DISPLAY=client
host name:0.0

The X windows client also requires that the connection from the
server is authorized. To enable the authorization, see the X
Windows client documentation. On many X Windows clients, the
authorization can be granted by using the Xhost command. For
example:

Xhost +

The installer creates a detailed time stamped log file in one of the
following places:

o If TIBCO_HOME did not exist at install time, the log file is
created in the temp directory of the user in a.TIBCO sub
folder.

 If TIBCO_HOME exists, the log file is created in the STIBCO_
HOME / Log folder.

Check the log file for any errors and then contact TIBCO
Technical Support.

You can also run the installer with the installer log enabled using
the -is:log option. For example:

./TIBCOUniversallnstaller-lnx-x86.bin -is:;javahome -is:log
path/log.dat

Installing in Console Mode

Using the Console mode, you can install the software in a non-Windows environment. The
installer prompts you for values.
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You can install TIBCO MDM in console mode with the following options:

« Installing with Typical Option for Simple Installation

« Installing with Typical and Custom Options

o Note: You can move through the installation process as follows:

Press key or 1: Moves forward in the installer
Press 2: Goes back to the previous page

Press 3: Cancels the wizard and exits the installation or uninstallation

Procedure

1.

On the command line, type the following command to launch the TIBCO Installer:
$ ./TIBCOUniversallInstaller-1nx-x86-64.bin -console

The TIBCO Universal Installer Welcome text is displayed along with the information
about products to be installed.

Press 1 to continue or 3 to cancel. If you press 1, the License Agreement text is
displayed.

Press 1 to continue reading or 2 to skip reading. If you press 1, read through the
entire license agreement using the Enter key. If you press 2, the following question
is displayed: Do you agree to the terms of the license agreement?

Type Yes to agree to the license terms or No to exit this installer.

Press 1 to continue, 2 to go back to the previous panel, or 3 to cancel. If you press 1,
the TIBCO Home Selections options are displayed.

o Press 1if you want to create a new TIBCO installation environment.
o Press 2 to select an existing environment.
If you press 1, the following options are displayed:

o Environment Name: Type the environment name. For example, TIBCO
MDMversion

o Environment Location: Type the environment location. For example,
/home/apps/TIBCO MDMversion

If you press 2, the existing environment name and locations are displayed:
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e Environment Name: For example, TIBCO MDMversion.

e Environment Location: For example, [lhome/apps/TIBCO MDMversion

8. Press Enter. The following confirmation message is displayed:

Is this the TIBCO Home environment you want to use?
9. Type Yes to confirm.

10. Press 1 to continue, 2 to go back to the previous panel, or 3 to cancel. The Install
Profile Selection options are displayed.

11. Press 1 for Typical or 2 for Custom installation.

Performing Postinstallation Tasks for Typical Installation

You need to merge third party libraries with ECM. ear that you have created for the
WebSphere and WebLogic application servers and manually copy TIBCO EMS libraries that
are not shipped with the product due to Licensing restrictions.

Procedure
1. Merge Third Party Libraries with ECM.ear.

a. Go to $MQ_HOME/build/custom.

b. Execute customUtil.bat or customUtil.sh-mergeExternallibrary.

This command creates the thirdPartyLibrary folder in $MQ_HOME.

c. Copy the consolidated third party JAR file (ThirdParty.jar) to this folder and
enter y to proceed for merging. For information about creating a consolidated
JAR file, see Creating a Consolidated JAR File with Third-Party Libraries.

Continue and complete the script. The updated ECM.ear is placed in $MQ_HOME.
2. Copy EMS Libraries.

a. Copythe tibjms.jar and jms-2.0.jar from $EMS_HOME/lib to $MQ_
HOME/lib/external directory.

A Warning: If you do not copy the tibjms.jar and jms-2.0.7jar files in $MQ_
HOME/1ib/external directory, the utilities do not work.
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Installing with Typical and Custom Options

The Console mode provides two options: Typical and Custom. You can choose to select
one of the options to install TIBCO MDM.

Procedure
1. If you have pressed 1 for Typical install, the Product Feature Selection options along

with the selection question are displayed:

Product Feature Selections

TIBCO MDM version
[X] Executable Image
[X] Common Configuration
Do you wish to proceed with the above feature selections?

a. Type Yes to proceed or No to make changes.
b. Press 1 to continue, 2 to go back to the previous panel, or 3 cancel.
2. If you have pressed 2 for Custom install, only the Product Feature Selection options

are displayed:

Choose the features to install.
1. [ ] Executable Image
2. [ 1 Common Configuration

a. Type 1 to select the Executable Image option.
b. Type 2 to select the Common Configuration option.

c. Type 0 when you have completed.

3. If you have pressed 1 in the Typical install and 2 in the Custom install, the default
TIBCO MDM Common Configuration location is displayed. If you want to change the
location, you can change the default path of Common Configuration Location, and

then press Enter.

Note: This step is not displayed if you select a custom configuration
option and did not opt to install the Common Configuration.

4. Press 1 to continue or 3 to cancel. The LGPL License Agreement text for hibernate
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10.

11.

12.

13.

assembly is displayed.

Press 1 to continue reading or 2 to skip reading. If you press 1, read through the
entire license agreement using the Enter key. If you press 2, the following question
is displayed: Do you agree to the terms of the license agreement?

Type Yes to agree to the license terms or No to exit this installer. After you agree to
the license terms, a page is displayed with the option whether or not to download
hibernate assembly or predownload Hibernate Assembly folder. Based on the
selection, the next page is displayed.

Press 1 to continue or 3 to cancel. If you have pressed 1, the hibernate assemblies
are downloaded from https://edelivery.tibco.com. Alternatively, you can opt to select
the location for the download.

Press Enter after the hibernate assembly download is complete. The LGPL License
displayed for XMLC library is displayed.

Repeat the steps from 5 to 8 to download the XMLC library.
The Preinstall summary (details about components to be installed along with total
size) is displayed.

Press 1 to continue or 3 to cancel. If you press 1, the installation starts and the MDM
Settings details are displayed.

While installation is in progress, the TIBCO Universal Installer - MDM Settings page is
displayed.

Press Enter to accept the default Server HTTP Port and Server Stop Port values.

Note: You can change the default values of the Server HTTP Port and
Server Stop Port.

Press 1 to continue or 3 to cancel. The postinstallation summary is displayed. Read
the postinstallation details.

Press Enter to exit the installer.

Installing with Typical Option for Simple Installation

The Typical option of the Console mode provides steps to install TIBCO MDM for simple
installation.
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Procedure

1. If you have pressed 1 for Typical install, the Product Feature Selection options along
with the selection question are displayed:

Product Feature Selections

TIBCO MDM version
[X] Executable Image
[X] Common Configuration
Do you wish to proceed with the above feature selections?
a. Type Yes to proceed or No to make changes.
b. Press 1 to continue, 2 to go back to the previous panel, or 3 cancel.
2. Enter the path of the wildFly-version.Final ZIP file.

3. Press 1 to continue or 3 to cancel.

4. If you have pressed 1 in the Typical install and 2 in the Custom install, the default
TIBCO MDM Common Configuration location is displayed. If you want to change the
location, you can change the default path of Common Configuration Location, and
then press Enter.

Note: This step is not displayed if you select a custom configuration
option and did not choose to install the Common Configuration.

5. Press 1 to continue or 3 to cancel.

6. If you have pressed 1, the enterprise and administrator credentials creation options
are displayed:

Would you like to create enterprise [Yes]

If Yes :-

Enterprise Name:-
Admin User Name:-
Admin Password:-

a. Type the enterprise name.

b. Type the user name of the administrator.
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c. Type the password of the administrator.

o Note: The password must contain eight alphanumeric characters
with at least one lowercase and one uppercase alphabet and one
numeric entry. Additionally, if you want to add special characters,
change the default value of the Password Required property. For
information about password policy, see the section, "Configuration
Properties for Password" in TIBCO MDM System Administration.

7. Press 1 to continue or 3 to cancel.

8. If you have pressed 1, the data model selection options are displayed:

Choose a data model.

1.
2. Customer
3.

4. Party

a.
b.
C.

d.

None

Insurance

Type 1 to select the None option.
Type 2 to select the Customer option.
Type 3 to select the Insurance option.

Type 4 to select the Party option.

9. If you have pressed 2 or 3, the following message is displayed:

Would you like to add sample data ? [Yes]

a.

b.

Type Yes to add the sample data.

Press 1 to continue or 3 cancel.

10. If you have pressed 2 or 3, the following message is displayed:

TIBCO MDM Configurator settings
Specify Server HTTP Port : [6080]
Specify Server Stop Port: [6009]

11. Specify the port values for the Configurator settings.
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12.
13.

14.

15.

16.
17.

18.

19.

20.
21.

Press 1 to continue or 3 to cancel.

The TIBCO MDM Common Configuration location is displayed. If you want to change
the location, you can change the default path of TIBCO MDM Common Configuration
Location, and then press Enter.

Press 1 to continue or 3 to cancel.

The LGPL License Agreement text for hibernate assembly is displayed.

Press 1 to continue reading or 2 to skip reading.
If you press 1, read through the entire license agreement using the Enter key. If you
press 2, the following question is displayed:
Do you agree to the terms of the license agreement?
Enter Yes to agree to the license terms or No to exit this installer:
Yes
Type Yes.
Press 1 to continue or 3 to cancel.

The LGPL Assembly Download message is displayed:

1.Download HIBERNATE assembly from the public TIBCO download site.
2.Specify the location of a previously downloaded HIBERNATE assembly.
Select an option by entering +its number from the list above. [1]

Depending on the option that you select, LGPL assembly is downloaded.

Press 1 to continue, 2 to go back to the previous panel, or 3 to cancel.

The XMLC LGPL license agreement text is displayed.

Press 1 to continue reading or 2 to skip reading.

If you press 1, read through the entire license agreement using the Enter key. If you
press 2, the following question is displayed:

Do you agree to the terms of the license agreement?
Enter Yes to agree to the license terms or No to exit this installer:
Yes

Type Yes.

Press 1 to continue or 3 to cancel.
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The LGPL XMLC Assembly Download message is displayed.

1. Download XMLC assembly from the public TIBCO download site.
2.Specify the location of a previously downloaded XMLC assembly.
Select an option by entering +its number from the list above. [1]

Depending on the option that you select, LGPL XMLC assembly is downloaded.
22. Type Yes.

23. Press 1 to continue or 3 to cancel.

The installation starts and the postinstallation summary is displayed. Read the
postinstallation details.

24. Press Enter to exit the installer.

Silent Installation

The TIBCO MDM installer supports silent installation to facilitate automatic installation on
to other computers. The silent installation option is based on a silent file which contains
all of the information the installer needs to perform the installation.

The Silent Installer is present in the same location as the TIBCO Universal Installer (the
location where you extract the TIBCO MDM distributable zip). Search for the
TIBCOUniversalInstaller.SILENT file.

Open the TIBCOUniversalInstaller.SILENT file in a text editor and change the content of
the response file to your needs. The separate entries are commented inside the file.

To execute a silent installation, copy the response file and the installer executable into the
same directory and use the -silent option of the installer executable. For example:

Windows
MDM_Installer_Location\TIBCOUniversalInstaller.exe -silent
UNIX

MDM_Installer_Location/TIBCOUniversalInstaller.bin -silent

Where MDM_Installer_Location is the path where the installer is extracted.
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Options in the Silent Installer File
Edit the options in the file as required.

The following options are available in the file:
Description of entries in the SILENT Install File

<!--accept the license agreement--><entry
key="acceptLicense">true</entry>

By default, this is set to true for acceptance of the license
agreement.

<I--If multiple environments are supported, create a new one or use and
existing one-->

<!I--If the product does not support multiple environments, then the
values below are ignored-->

<entry key="createNewEnvironment">true</entry>

<!--If using an existing environment then the installationRoot AND
environmentName MUST match a pre-existing environment-->

<!--If creating a new environment then the installationRoot AND
environmentName MUST BE UNIQUE and not match a pre-existing
environment-->

<entry key="environmentName">TIBCO_HOME</entry>

<entry key="environmentDesc">MDM Installation</entry>

By default, the root installation directory is c:\tibco. You can change this provided TIBCO_HOME
has not already been set, in which case, the existing TIBCO_HOME is used. Provide the
environment name and description. Environment name must exist if using a pre-existing one,
and in case of a new one, it must be unique.

<!--Product Specific Properties can be set below using the same 'entry
key=' format as above-->

<entry key="feature_Executable Image_mdm-jboss">true</entry>

<entry key="feature_Common Configuration_mdm-jboss">true</entry>
<entry key="feature_Documentation_mdm-jboss">true</entry>
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Description of entries in the SILENT Install File

By default, all three components (Executable Image, Common Configuration, and
Documentation) are set to true and will be installed. Replace with false for any components
that you do not want to install.

<!-- Specify the absolute path of jboss server zip file-->
<entry key="mdm.jboss.zipfile">D:\Softwares\wildfly-
version.Final.zip</entry>

You need to specify the absolute path of the ZIP file of JBoss WildFly application server. For
simple installation, you need to specify the absolute path of the ZIP file of JBoss WildFly
application server.

<!--Common Config settings-->

<!--if commonConfig_useDefault is true then the common config directory
will be-->

<!--based off the installationRoot setting above and the commonConfig_
directory setting-->

<!--will be dgnored. If commonConfig_useDefault is set to false then
you must provide-->

<!--a valid directory location for the commonConfig_directory setting.-
->

<entry key="commonConfig_useDefault">true</entry>

<entry key="commonConfig_directory">c:\tibco\MDMcommon</entry>

<entry key="tibco.cim.common.dir">c:\tibco\MDMcommon</entry>

The directory for common configuration (set to true by default) is based on the Install root. To
change this, enter false for CommonConfig_useDefault and provide the new location in the
commonConfig_directory.

The tibco.cim.common.dir is an additional key for external use of the common directory.
This is used for post install processing. The value should be the same as of the commonConfig_
directory key.

<!--MDM XMLC library download Settings->

<entry key="LGPLAssemblyLicenseAccepted">true</entry>

<entry key="LGPLAssemblyDownload">true</entry>

<entry key="LGPLAssemblyPath">c:\tibco\thirdpartyDownload</entry>
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Description of entries in the SILENT Install File

The LGPL license is accepted (set to true by default). By default, LGPL assembly download
option is set as true. If LGPLAssemblyDownload is false, then LGPLAssemblyPath contains
already downloaded assembly files.

<!--MDM Configurator Settings-->
<entry key="httpPort">6080</entry>
<entry key="stopPort">6009</entry>
<entry key="startServer">false</entry>

Provide the httpPort and stopPort of the Configurator or keep the default as is. By default,
the Configurator will not start after the installation is complete; to override this, set
startServer to true.

Specify details for the TIBCO Patterns - Search port parameters:

<!--TIBCO Patterns - Search Settings-->
<entry key="patterns.server.port">5051</entry>
<entry key="patterns.windows.service">false</entry>

<!--CIM Enterprise creation —-->

<entry key="mdm.create.enterprise">true</entry>
<entry key="mdm.enterprise.name">demo</entry>
<entry key="mdm.admin.user.name">admin</entry>
<entry key="mdm.admin.password">Admin$12</entry>
<entry key="mdm.template.type'">party</entry>
<entry key="mdm.import.data">true</entry>

For simple installation, you need to specify the enterprise details, administration credentials,
and the template details.

e For mdm.admin.password: The password must contain eight alphanumeric characters
with at least one lowercase and one uppercase alphabets and one numeric entry.
Additionally, if you want to add special characters, change the default value of the
Password Required property. For information about password policy, see the section,
"Configuration Properties for Password" in TIBCO MDM System Administration. If
password policy is not satisfied, the following error message is displayed: SEC-5539 :
Password must contain '8' alphanumeric characters with at least one lowercase and one
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Description of entries in the SILENT Install File

uppercase alphabet and one numeric entry.

o For mdm.template.type: specify the customer, insurance, party, or none option. The
value is case-sensitive and must be in lowercase. If you specify false for the
mdm.create.enterprise, specify none for the mdm. template.type and false for the
mdm.import.data.

Configurator

The Configurator is an independently deployable web-based configuration utility that
allows you to configure various properties for TIBCO MDM. It can be used for the initial
setup of the application as well as for ongoing maintenance of the TIBCO MDM
configuration.

Prerequisite

To start the Configurator on on-premises or enterprise servers, ensure that you have set
the MQ_NO_FS environment variable to false.

Type the following URL into your browser:protocol://host:port/config/index.html

For example, http://localhost:6080/config/index.html

Manually Configuring TIBCO MDM

If you have not specified configuration information during TIBCO MDM installation,
Configurator does not start. You need to perform manual configuration to start
Configurator. However, TIBCO recommends you to specify configuration information
during TIBCO MDM installation.

Procedure

1. Set the following environment variables for the Configurator: MQ_HOME, MQ_CONFIG,
and MQ_COMMON_DIR.

2. Set JRE_HOME

a. Navigate to $MQ_HOME/configurator/server/bin and open the setenv.bat file.
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b. Specify the value for the JRE_HOME parameter.
c. Save the setenv.bat file.
3. Start Configurator

a. Navigate to $MQ_HOME/configurator/server/bin folder and run the setenv.bat
file

b. Navigate to $MQ_HOME/configurator/server/bin and run the start.bat file.

c. The Configurator starts. You can verify the logs related to Configurator in the
$MQ_HOME /configurator/server/configurator/logs folder. For detailed
information on the Configurator, see the "Configurator" chapter in TIBCO MDM
System Administration.

Configuring TIBCO MDM to Connect with JMS

To connect to TIBCO EMS, enter the values for the Queue Setup and Bus Setup
configuration properties.

Prerequisites

o For Queue Setup: Ensure that the Cluster Association is set to TIBCOCluster (Queue
Setup > Queue Definition > Default Queue)

o For Bus Setup: Ensure that the Cluster Association is set to TIBCOCluster (Bus Setup
> Topic Setup > Default Topic)

Procedure
1. Log in to the Configurator.

2. Navigate to InitialConfig > Queue Setup > Messaging Cluster > TIBCO EMS.

3. Enter the values for the following properties:

Queue Setup Properties

Property Name Description Example Values
TIBCO EMS Server Enter the address and port for the tcp://10.97.118.57:7222
Connection URL property.
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Property Name Description Example Values
TIBCO EMS Cluster Clustering of the EMS server is LocalhostServer
Name supported by TIBCO MDM.

TIBCO EMS Server Enter the values for these properties  UTF-8

Default Encoding configured for each server.

4. Navigate to InitialConfig > Bus Setup > Cluster > TIBCO EMS.

5. Enter the JMS server address and port for the Localhost Server Connection String
property.

6. Click Save to save the entered values.

Superuser Password

The TIBCO MDM application runs under the context of a UNIX or Windows user. This user
account must be created.

After you install a new instance of TIBCO MDM, the default superuser information is as
follows:

o Note: On UNIX, it is recommended that the root user is not used to run MDM.

o Default company name: tibcocim
o User: tadmin
o Password: euc!1dAl

Attention: Al stands for Alexander, that is, capital A and small [ letter.

o Important: Important: Additionally, the new password configuration properties
are added in the Configurator. For more information, see the section,
"Configuration Properties for Password" in TIBCO MDM System Administration. If
you configure the Password Required property in the Configurator to add
special characters in the password, you need to customize the display error
message (SEC-5539) in the UserText.properties file. For customization, see the
section "Localize Text Strings" in TIBCO MDM Customization.
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Changing the Superuser Password

After logging in, you can change the password from Ul using My Account Profile and
Modify User pages.

Procedure

1. Using My Account Profile Page

a.

b.
C.
d.

e.

Click User name-Company name on the upper right corner of the main Ul page.
The My Account Profile page is displayed.

Type the old password in the Old Password field.
Type the new password in the Password field.
Re-type the new password in the Re-enter Password field.

Click Save. The new password is saved.

2. Using Modify User Page

a.

Click Administration > User Accounts.
The User Accounts page is displayed.

Select the check box next tadmin user name.

Click Modify.
The Modify User page is displayed.

Type the new password in the Password field.
Re-type the new password in the Re-enter Password field.

Click Save.
The new password is saved.

Configuration Requirements

The configuration requirements depend on if this is for a new installation, an upgrade
installation, or if any new properties need to be set for a specific release.

For new installations, all TIBCO MDM configurations described in this topic must be set to
meet your site’s standards.
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For upgrade installations, TIBCO MDM configurations that were set during the original
installation are automatically updated by the migration utility. Any new properties that
need to be set for a specific release are listed in the TIBCO MDM Release Notes.

Any new properties that need to be set for a specific release are listed in the TIBCO MDM
Release Notes.

Setting Crontab

The tibcocrontab.sh sample script is in $MQ_HOME/bin. Use the script to create crontab
entries required for a periodic cleanup of temporary files. The temporary files are
generated in the $MQ_COMMON_DIR/Work and $MQ_COMMON_DIR/Temp directories.

You can modify the tibcocrontab.sh file to change the frequency and retention policy and
to fit within your IT policies. If your IT policy does not allow a cron job to be setup, you
can use any schedule. You can run this script manually or using any job scheduler.

If you are defining crontab entries, ensure the crontab is defined for a user that owns the
TIBCO MDM Application.

Prerequisite

For Linux or Unix installations, you must set $MQ_HOME and $MQ_COMMON_DIR in
tibcocrontab.sh.

Procedure
1. At the Unix Shell prompt, enter:

Scrontab -e

2. Set $MQ_LOG environment variable by adding the following line: LOG_FILE=$MQ_
HOME /log/velocrontab. log

3. Edit the file to add the following line:

10 x/30 * * sh /opt/tibco/mdm/version/bin/tibcocrontab.sh >>
/opt/tibco/mdm/version/log/tibcocrontab.log 2>&1

indicates you to run the /opt/tibco/mdm/version/bin/tibcocrontab.sh shell script

with the sh shell at 00:01 every 30 days, appending (adding) the standard and error
output to the /opt/tibco/mdm/version/log/tibcocrontab. log file.
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® 1 /1 * x find MQ_COMMON_DIR/Work -type d -empty -mmin +23 -print0
| xargs -0 rm -rf;

indicates you to execute the find command on the $MQ_COMMON_DIR/Work directory.
The command produces an empty sub-directories list in the $MQ_COMMON_DIR/Work
that is at least 23 hours old. Piping that list (with a null terminator to accurately
capture directory names with spaces and other non-standard characters) to the
xargs command, so that it can build and execute the rm -rf <directory list>
command (the most efficient way to remove empty subdirectories).

4. Save and exit.
:wq!

5. Edit the RETENSION_POLICY variable in this script to specify the retention policy.
RETENSION_POLICY_DAYS=numberofdays

6. To check any crontab setting, run the following command:
$crontab -1

JRE Configuration Requirements

TIBCO MDM uses Sun’s JRE with WebLogic and IBM’s JRE with WebSphere on all other
platforms. You can set the configuration properties of TIBCO MDM using the Configurator.

The following code samples show the properties used for SSL setup. For the application
server to function, you must set one of these two properties:

o Set SSL for Sun JRE: In the Configurator, set:

o Security Provider > Sun > SSL Protocol Handler Package to
com.sun.net.ssl.internal.www.protocol

o Security Provider > Sun > SSL Provider to
com.sun.net.ssl.internal.ssl.Provider.

o Set SSL for IBM JRE: In the Configurator, set:

o Security Provider > IBM > SSL Protocol Handler Package to
com.ibm.net.ssl.internal.www.protocol.

o Security Provider > IBM > SSL Provider to com.ibm.jsse.JSSEProvider.
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Java Configuration Changes

Make the Java configuration changes listed in this topic.

1. Remove all JAR files from the $JAVA_HOME/jre/lib/ext directory.
2. Change the security provider list in the $JAVA_
HOME/jre/lib/security/java.security file to:

security.provider.l=com.ibm.crypto.provider.IBMJCEsecurity.provider.
2=com.ibm.jsse.JSSEProvidersecurity.provider.3=sun.security.provider
.Sun

Specifying Database User Details

Specify the database user details specific to each database in the Configurator.

Procedure
1. Login to Configurator.

2. Select the Basic configuration outline

3. Select Database. The common properties related to database are displayed in the
Table List pane on the right side.

4. Enter the database user details in the following fields. The database values are
based on the selected database in the Settings > Database option. The available
database options are Oracle and SQL Server.

o Database Name
o Database User Name
» Database Password
For information about the database credentials, see
o For Oracle: Creating Database User for Oracle Database

o For SQL Server: Creating Database User for SQL Server Database

5. Click Save to save the database configuration changes.

Result
For more information about the database configuration, see Setting up Databases.
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Database Analysis

It is a best practice to set up a periodic job for database analysis. The frequency of the job
depends on data volumes, frequency of change, and your IT policies. Consult your DBA.

Run the analyze option whenever the number of rows in various tables is changed by
more than 10%.

Purge Historical Data

You can set up a periodic purge workflow to reduce the historical data.

Setting Configuration for Decoupling of Documentation

TIBCO MDM documentation is decoupled from the product installation. Therefore, to
integrate documentation in the application, select either online or offline for the
com.tibco.cim.help.url (MDM Help Configuration) property in the Configurator. The
default value is online.

« Online: Using this mode, you can access the documentation online when you are in
the network. In the online mode, by default the documentation is linked to the latest
documentation site URL. For example, for the TIBCO MDM 9.1.0 release version, after
clicking the Help icon in the application, the documentation is linked to the URL.

« Offline: Select this mode if you are off the network and want to access the
documentation in the application. Stop the TIBCO MDM server if it is running, and
then perform the following steps:

Procedure
1. Copying Documentation Directory

a. Navigate to TIBCO Documentation site and access TIBCO MDM documentation.
b. Click the Versions tab to access the release specific documentation assembly.

c. Click Download All to download all documentation including PDF and HTML
Help.

d. Save tibco-mdm-version-documentation.zip file to your local directory.
e. Extract contents of the documentation ZIP directory.

f. Go to $SMQ_HOME and locate ECM.ear\EML.war.
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Create the doc subdirectory inside the help folder.

Copy the html directory extracted from the documentation ZIP directory inside
the doc subdirectory.

Deploy the modified ECM. ear file to the Application Server.

2. Specifying Configurations

a.

b.

g.

Restart the Configurator.

Click Advanced in the Configuration Outline section. A list of advanced
configuration categories is displayed.

Select the Ul Setting category.

Select offline from the MDM Help Configuration property drop-down list.
Click Save. The Save dialog box is displayed.

Enter the description, if any.

Click Save. The configuration changes are saved.

3. Hot Deploying on Application Server

a.

b.

Go to Initial ConfigNodelD

Click Save & Redeploy. The Save & Redeploy dialog box is displayed. For Host
Name, by default localhost is displayed.

Enter the description, if any.

Click Save. The MDM Help Configuration property is hot deployed on the
application server.

4. Verifying Help

a.

b.

Restart the TIBCO MDM server.

Click the Help icon on any page, the TIBCO MDM documentation is displayed.
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Uninstalling TIBCO MDM

The uninstaller presents panels using which you can select choices about the product
selection, product location, and so on.

Before you begin

Before uninstalling TIBCO MDM, ensure that Configurator instances are not running (if
they are when you attempt to uninstall TIBCO MDM, some files may be locked and
uninstallation may not take place correctly).

Procedure

1.

On Windows: navigate to $MQ_HOME/tools/universal_installer and run
TIBCOUniversallnstaller-x86-64.exe or navigate to All Programs > TIBCO and
click Uninstall.

On UNIX, navigate to $MQ_HOME/tools/universal_installer and run
TIBCOUniversalInstaller-1lnx-x86-64.bin.

The uninstaller tries to stop the server for the Configurator. If the server for the
Configurator is already stopped, a Connection refused error is displayed and an
exception is thrown as the server is already stopped. Ignore the error message and
the exception.

In the TIBCOlnstallation Manager window, select the Uninstall Products from a
TIBCO Home Location option. The TIBCO home location is automatically displayed.
Click Next.

In the Welcome window, review the information. Click Next.

In the Uninstallation Type window, select the Typical Uninstall (removes all
products in this TIBCO_HOME) option to uninstall all the products. Click Next to
continue with the uninstallation. The installer configures your uninstallation choices.

In the Pre-Uninstall Summary window, review the information and ensure that it is
correct.

« If you want to change any of your choices, click Back. You can then restart the
uninstallation process from the starting point.

« If you are satisfied with your choices, click Uninstall. The installer performs the
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necessary uninstallation tasks.

7. When uninstallation has completed, the cleanup message is displayed.
TIHIMSSTHE0AUY: Wirrning

Wonld v like to cloan ap the Gools direciory for this emvironmmoeni?

Yo, clean it up | Mo, do not clean it up |

8. Click the Yes, clean it up.

9. In the Post Uninstall Summary window, click Finish to exit from the installer.
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Setting up Databases

TIBCO MDM supports Oracle and SQL Server databases for data storage.

Configuring the database of TIBCO MDM consists of several steps, most of which are done
manually such as creating users, schemas, and tablespaces; changes to SQL scripts to
change location or default tablespace sizes, handling multibyte characters, and so on.

Supported Databases

Install anyone of the following databases as per your requirement. For a list of versions
and platforms supported, see the Readme.txt file shipped with installation of TIBCO MDM.

Supported Databases

Database Description

Oracle Download the supported version of the Oracle
database from the Oracle site and unzip it to the
required location.

SQL Server  Download the latest version of Microsoft SQL Server
from the following site and unzip it to the required

location

PostgreSQL  The PostgreSQL database is installed with the Simple
installation. You do not need to separately download
it. For more information about simple installation, see
Simple Installation with PostgreSQL.

Site Reference

Install the Oracle server
software as directed in

the Oracle installation
document.

Install the SQL Server
software as directed in
the appropriate SQL
installation
document.

Not Applicable
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Database Sizing Requirements

The database sizing requirements include the minimal sizing requirements for
initdbname.ora (initecm50.ora); for small, medium, and large databases.

Database Sizing Requirements

Database Low-end Mid- High-

Parameter range end

Setting

Db block size 8192 8192 8192

Db_file_ 8 16 32

multiblock_read_

count

Shared pool size 75 MB 150 200 MB *
MB

Processes (# of application servers)* (application server max

db connection pool size) + 200

Parallel max 2 4 5%
servers

Log_buffers 25% of the system memory

Timed_statistics True True True
Max_dump_file_ 5 MB 10 MB 20 MB
size

Rollback_segments 8 seg 16 seg 32 seg*
Open cursors 300 450 3000
Character set UTF-8

Buffer Pool Size 150 MB 300 500 MB -
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Database Low-end Mid- High-
Parameter range end
Setting

MB 2 GB*
db_writer_ 75% of the cpu_count parameter value
processes
Sessions 1.1* processes + 200
optimizer_mode ALL_ROWS
shared_servers # of dispatchers* 2
Transactions # sessions

* These values depend on various factors including concurrent users, message and
workflow volumes, number of records, and so on. Your DBA should adjust these values
based on the actual load and required performance characteristics.

Configuration of Oracle Database

To configure the Oracle database, use the Oracle Configuration Assistant. Consult your
Database Administrator on standard practices followed by your IT department to change
the recommended structure according to your needs.

Prerequisites

Ensure that all required environment variables are set. See Environment Variables.

Ensure that Oracle Client Software Developer Edition or Enterprise Edition is
installed on the computer hosting the application server ().

Ensure that the sqlldr utility is available.
Use the latest driver provided by Oracle.

A valid and tested connect string should be present in the TNSNAMES.ora file. For
example, the connection URL: jdbc:oracle:oci:@ORACLERAC

where ORACLERAC is the TNS entry in the client’s TNSNAMES . ora file and oci drivers are
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used to support TAF.

TNSNAMES.ora file (client)

ORACLERAC =
(DESCRIPTION =
(ADDRESS_LIST =

(ADDRESS = (PROTOCOL = TCP) (HOST = hostnamel.domainname.com) (PORT =
1521))
(ADDRESS = (PROTOCOL = TCP) (HOST = hostname2.domainname.com) (PORT =
1521))

)
(FAILOVER=0n)
(LOAD_BALANCE
(CONNECT_DATA
(SERVER = DEDICATED)
(SERVICE_NAME = orcl)
(FAILOVER_MODE =
(TYPE = SELECT)
(METHOD = BASIC)
(RETRIES = 180)
(DELAY = 5)

ON)

)
)
)

o Note: The TNS entry supports both failover and load balancing.

« Database port

o Database server host name

Recommended Configuration for TIBCO MDM
Follow the recommended configuration for setting up the database.
The following is the recommended configuration:

o Two sets of Redo logs with two members each.

« Analyze regularly (for instance, weekly) or after significant change in data (for
example, after importing records in the database).

o Database to be run in ARCHIVE LOG MODE.
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e Mirrored control files.

e Remove INSTALL users after the database is created.

Note: On Linux 5.1, for Oracle > sqplus to work, disable SELINUX as
follows:

echo 0 > /selinux/enforce

Creating Database User for Oracle Database

You need to create a database user for seed data creation.

If you select Use an Existing MDM Database User option while setting up the Oracle
database in the Configurator, the database user should be available. For information
about the Database Setup Wizard, see Installing Seed Data Using Database Setup Wizard.

Procedure
1. Connect to the database.

2. Run the createuser.sql script from $MQ_HOME/db/oracle/configure.

3. Specify the database username and password.

The database user is created.

Creating Seed Data Manually for Oracle Database

You can create seed data by using the database setup wizard or through manual
configuration. This is especially useful if you want to create the seed data independent of
the database installation.

To install seed data with the database wizard, see Installing Seed Data Using Database
Setup Wizard.

For a new database installation, you must create a database user ID and use the database
installation scripts to create all database objects. For manual seed data creation, perform
the following installation steps:

Procedure
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1. Modify $MQ_HOME/db/oracle/install/install.bat/.sh to change the USER,
PASSWORD, mdmInstanceName, mdminstanceDesc, and INSTANCE variables. The USER
and PASSWORD variables should be set to the user that you created.

Note: For non-Windows environments, ensure that the PATH variable
includes the Bourne shell or a compatible shell before running scripts to
create seed data.

2. From the install directory, run the script install.bat/.sh.

The script creates the sequences, tables, indexes, triggers, and views in the
appropriate tablespaces and inserts seed data into the tables.

Creating Tablespaces

Table spaces are required to hold data and indexes for all tables required for TIBCO MDM
and for all data sources uploaded.

TIBCO MDM uses the following different kinds of tables and indexes:
» Fixed tables

Indexes for fixed tables

Data source tables

o Master catalog tables

« Indexes for master catalog tables

Procedure
1. Change the default data file location specified in the createtablepsace.sql file based
on your Oracle installation.

a. Go to $MQ_HOME/db/oracle/configure/.
b. Open the createtablepsace.sql file.

c. Change the data file location for all tablespaces. For example, if you have
installed Oracle in the E: /app/oradata/orcl folder, change the
C:/oracle/version/oradata/orcl path to E:/app/oradata/orcl.

2. Run the createtablepsace.sql script to create the following tablespaces:
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Tablespaces
Tablespace Name
VELODBDATA
VELODBINDX1
VELODBDF
VELODBDATA

VELODBINDX

o Note:

Description

For fixed TIBCO MDM tables.

For fixed TIBCO MDM table indexes.
For TIBCO MDM data source tables
For TIBCO MDM master catalog tables.

For TIBCO MDM master catalog table indexes.

o The VELODBDATA1 tablespace has a minimum size of 100 MB and
maximum size of 500 MB. The remaining tablespaces are 100 MB.
You can change the size of the tablespaces based on you
requirement. You can also set the size as unlimited for the
tablespaces.

« If you are migrating from the earlier versions of Oracle to the latest
supported version of Oracle, you have to explicitly grant
UNLIMITEDTABLESPACE to the user. Oracle has discontinued the
support granting UNLIMITED TABLESPACE to the RESOURCE role user.

Run the following command:GRANT UNLIMITED TABLESPACE TO
username

3. For a complete installation (tablespaces and seed data), run the installation script
from $MQ_HOME/db/oracle/configure/doall.bat or doall.sh

a. To create tablespaces without seed data, run $MQ_
HOME /db/oracle/configure/createusertablespace.sh or .bat

b. To create only seed data, see Creating Seed Data Manually for Oracle

Database.

Tablespace Options

If you choose to create one, two, or three tablespaces, you need to modify the SQL scripts
in the $MQ_HOME/db/oracle/install/scripts/ddl directory to create data structures in the
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appropriate tablespaces.

o One tablespace for data and indexes

o Two tablespaces, one for data and one for indexes

« Separate tablespaces for each set of tables

o A combination of one of these three options

Database SQL Scripts - One, Two, or Three Tablespaces

SQL Script

create_
tabs.sql

create_
PK.sql

Create_
indexes.sql

create_ds_
tables.sql

Description

All fixed tables used in TIBCO MDM are created by this script. These
tables are created by default in the VELODBDATAL tablespace. The name
of the tablespace needs to be modified appropriately in this script. If the
default storage parameters are not good enough for some tables, contact
your Database Administrator to modify this script to create tables with
the appropriate storage parameters.

The primary keys for all the fixed tables are created by this script. These
primary keys are created by default in the VELODBINDX1 tablespace. The
tablespace name needs to be modified appropriately in this script.

The indexes for all the fixed tables are created by this script. These
indexes are created by default in the VELODBINDX1 tablespace. The
tablespace name needs to be modified appropriately in this script.

All data source tables used in TIBCO MDM are created by this script.
These tables are created by default in the VELODBDF tablespace. The
name of the tablespace needs to be modified appropriately in this script.

After modifying the SQL scripts, you need to perform the two steps required for the five
tablespace option. The output of these scripts goes into the log file $MQ_
HOME/db/oracle/install/logs/output.log. Ensure that errors do not exist during the
execution of these scripts.

Creating Tablespaces - Alternative Approach

In this approach, TIBCO MDM creates and manages tablespaces. A separate tablespace is
created for each enterprise that is used for data source upload.
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A Warning: This approach is not recommended.

Procedure
1. Create two different tablespaces, VELODBDATA and VELODBINDX.

2. Create mdmadm user identified by password default tablespace VELODBDATA
temporary tablespace temp.

Grant connect, resource to mdmadm.
Alter user mdmadm quota 1000m on VELODBINDX.
Grant create tablespace privilege to mdmadm.

Grant UNLIMITED TABLESPACE privilege to mdmadm.

N 0 oW

Set the following properties using the Configurator: (Advanced view, Database,
Oracle).

a. Set DatabaseTablespace Create Privilege to True.
o Note: For CSV data upload, you need to set the option to False.

b. Set DatabaseTable Space Name to VELODBDF. The default value is USERS.

c. Set DatabaseMaster Catalog/Repository Data Tablespace to VELODBDATA. The
default value is USERS.

d. Set DatabaseMaster Catalog/Repository Index Tablespace to VELODBINDX. The
default value is USERS.

Note: With this approach, you need to create tablespace privileges
for the TIBCO MDM database user.

8. If TIBCO MDM is responsible for creating a tablespace for each enterprise on the first
data load, set the following properties using the Configurator (Go to Initial Config >
Databasedatabasename ):

Tablespace File Size
Tablespace Next Size
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Tablespace Initial Storage Size
Tablespace Increase %

For the following properties, go to Initial Config > Database:

Dynamic Tablespace Location
Tablespace Name Prefix

After completion, you can create the seed data. See Tablespace Options.

Deleting User and Table spaces

Follow these steps to remove the user and tablespaces that were created with the
installation.

Warning: This removes all data related to TIBCO MDM and should be used very
carefully.

Procedure
1. Modify the $MQ_HOME/db/oracle/configure/dropuser.sql script to change the user
name to the user you created. By default, this script drops user mdmuser.

2. Modify the $MQ_HOME/db/oracle/configure/droptablepsace.sql script to change
the names of the tablespaces to what you have created.

3. From the configure directory, run the script dropusertablespace.bat. This script
removes the user and tablespaces.

Tip: In some cases, the data files may not get removed. Delete them
manually.

Handling Multibyte Characters

When the Oracle database is created, the database charset is set to UTF-8. In addition to
the UTF-8 charset, the TIBCO MDM database needs to be deployed with a configuration for
character semantics that enable globalization and enhance code portability.
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From Oracle9i onwards, you can set the default character semantics at either the session
or instance level using the NLS_LENGTH_SEMANTICS parameter. This parameter must be
effective before a table is created.

The NLS_LENGTH_SEMANTICS parameter decides how strings should be stored in the
database, as characters or bytes. TIBCO recommends that strings in the database be
stored as characters (CHAR). This setting takes care of globalization issues with strings.

e For a New TIBCO MDM Installation

The database object creation scripts specify the correct semantics. If you use these
scripts, you do not have to perform any additional steps.

o For an Existing TIBCO MDM Installation

Prior to TIBCO MDM 7.1, TIBCO MDM instances were created using the seed data
export dump provided. Depending on the database NLS_LENGTH_SEMANTICS, the
tables may not have been created with the correct semantics to handle NLS
characters. You can convert the older instances to the correct semantics as follows:

To convert an existing schema from byte semantics to character semantics and a
single-byte character set to a multibyte character set:

Procedure
1. Export the schema.

2. Setthe NLS_LENGTH_SEMANTICS parameter using either of the following methods:
e In the init.ora file, set NLS_LENGTH_SEMANTICS=CHAR.

o Issue the following command on the target database (This command modifies
the NLS_INSTANCE_PARAMETERS and NLS_SESSION_PARAMETERS views.
Storage is now measured in characters and not bytes):

ALTER SYSTEM SET NLS_LENGTH_SEMANTICS=CHAR SCOPE=BOTH

Note: This resolves defects associated with Data too long for the
Column when multibyte characters are used.

3. Stop and restart the database so that the parameter change takes effect.
4. Drop the original schema.

5. Recreate the original schema and its tables. You can use the IMPORT SHOW=Y option
to get the CREATE TABLE statements. Columns in the recreated tables will now use
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character semantics (as it is the default). The import command generates the create
table statements.

6. Run the create table statements and the schema is created.

~

Import the schema into the target database using the "IGNORE=Y" IMPORT option.

Export the dump and save it.

o ®

Retest the dump as follows:

alter system set nls_length_semantics=byte;

10. Import the dump.

Result
The tables should have correct semantics even when NLS_LENGTH_SEMENTICS is set to
byte.

Limitation for Data Source Upload Using the sqlldr utility

A data source with many columns hangs in the upload stage for a long time and later an
error occurs. This is using the Oracle sqlldr utility. When a large file is provided, the SQL
loader needs memory to run. Java separates the process, which has its own overhead.
Therefore, memory required is almost double of what it takes normally. The only solution
is to reduce the file size or increase memory available on your computer.

Troubleshooting with Oracle Database

Resolve the errors that you may come across while configuring the Oracle database.

Troubleshooting with Oracle Database

Issue Description Solution

Bad A “bad interpreter” error is displayed on  The first line of all scripts on UNIX
Interpreter UNIX. must be as follows: #! /usr/bin/sh
Issue

Check whether or not the first line of
the UNIX script follows this format.
You can also create a soft link as
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Issue

Insufficient
Shared
Memory
Issue

Inserting
and
Updating
Data from
ProcessLog
and
ProcessState
Tables

Description

Oracle database error, unable to
allocate required shared memory.

(ORA-04031: unable to allocate x
bytes of shared memory).

Two errors are intermittently thrown
when inserting or updating data from
ProcessLog and ProcessState tables,
even though the data to be inserted
has a valid value and length. This error
has been observed on Oracle 10.1.0.2.0.

ORA-01461: can bind a LONG value
only for -dnsert into a LONG

column

ORA-01483: -1invalid length for
DATE or NUMBER bind variable

Solution

follows: 1n -s /bin/sh
/usr/bin/sh

This error is related to the
insufficient shared pool size
allocation. Consult Oracle
documentation and your DBA to
resolve it. Usually the error may be
resolved by increasing the amount of
available shared memory.

Restarting the application server
might resolve the issue temporarily.

There are similar issues reported in
Oracle Metalink. Reference
Document IDs: 241358.1, 461670.1

If the problem persists, contact
Oracle support and consider
upgrading to the latest patch.

Configuration of SQL Server Database

Install the SQL Server software as directed in the appropriate SQL installation document.
Consult your Database Administrator about standard practices followed by your IT
department to change the recommended structure according to your needs. After the SQL
Server software is installed, configure the database.

TIBCO MDM works with SQL server configured with Windows authentication. For such a
setup, you need to configure JBoss WildFly application server. For information, see
Configuring TIBCO MDM for JBoss WildFly Application Server.

Note: To improve the performance, the SQL Server database must be installed
with collation as Caselnsensitive (Cl).
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Setting TCP/IP Port

The SQL Server installation must use the fixed TCP/IP port.

Procedure
1. Open SQL Server Configuration Manager.

2. In the left column, navigate to SQL Server Network Configuration > Protocols.

3. In the right column, in the Protocol Name field, double-click TCP/IP.
The TCP/IP Properties window opens.

TCP/IP Properties
Protocol [P Addresses |

B 1p1 =
Active Yes
Enabled Mo
IP Address fed0:b3aZ elde: 1679 f44d%:10
TCP Drynamic Ports a

1433

B 1p2 —
Active Es
Enabled Mo
IP Address 10,97, 105,64
TCP Drvnaric Ports a
TCP Port

B 1p3
Active Yes
Enabled Mo
1P Address !
TCP Drynamic Ports a

T Dok

TCP Port
TP port

(04 I Cancel | Apply Help

4. Click the IP Addresses tab.
5. Set the TCP Port number to 1433.

6. Click OK.

Set Transaction Isolation Levels

You must set the transaction isolation levels to READ_COMMITTED_SNAPSHOT and
ALLOW_SNAPSHOT_ISOLATION to avoid read locks in a highly concurrent environment.

The snapshot isolation level specifies that data read within a transaction does not reflect
changes made by other simultaneous transactions. The transaction uses the data row
versions that exist when it begins. Therefore, when the data is read, no locks are placed

TIBCO® MDM Installation and Configuration Guide



101 | Setting up Databases

and the snapshot transactions do not block other transactions from writing data. To
enable the snapshot isolation levels, specify the following two properties:

o READ_COMMITTED_SNAPSHOT: Set the READ_COMMITTED_SNAPSHOT database
option to ON to provide statement-level read consistency. The statements cannot
read data values that are modified, but not yet committed by other transactions.

To set this parameter, log in as admin and run the following script with an
appropriate database name:

ALTER DATABASE DATABASENAME SET READ_COMMITTED_SNAPSHOT ON

By default, the READ_COMMITTED_SNAPSHOT database option is set to OFF.

e ALLOW_SNAPSHOT_ISOLATION: Set the ALLOW_SNAPSHOT_ISOLATION database
option to ON to provide transaction-level read consistency. If another transaction
modifies the reading rows, the Microsoft SQL Server database engine instance
retrieves the version of the row that existed at the start of the transaction. You can
only use Snapshot isolation against a database.

To set this parameter, log in as admin and run the following script with an
appropriate database name:

ALTER DATABASE DATABASENAME SET ALLOW_SNAPSHOT_ISOLATION ON

By default, the ALLOW_SNAPSHOT_ISOLATION is set to OFF.

For the READ_COMMITTED_SNAPSHOT and ALLOW_SNAPSHOT_ISOLATION levels,
the read operations acquire only the Schema Stability (Sch-S) table level locks. It
does not lock any pages or rows.

o Note: These levels function similar to the SERIALIZABLE level, however
you need to ensure that READ does not lock rows.

For more information to set these transaction isolation levels, see the Microsoft site.

Creating Database User for SQL Server Database

You need to create a database user for seed data creation.
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Note: If you select Use an Existing MDM Database User option while setting up
the SQL Server database in the Configurator, the database user should be
available.

Procedure
1. Login to the SQL Server Management Studio as a Super User.
2. Run the createUser.bat script from $MQ_HOME/db/sqlserver/configure.
Where,
USERNAME is the database user name and PASSWORD is password for the specified
user name.
The database user is created.
To provide permission to the user for creating database, do the following:
3. Open the SQL Server Management Studio, select super usernameSecurity > Logins.
4. Right-click username and select Properties. The Login Properties - username window
is displayed.
5. In the left panel, select Server Roles. The server roles are displayed in the right
panel.
6. In the Server Roles section, select the sysadmin check box.
7. Click OK.
The system administration server role is created. This server role can grant server-
wide security privileges to a user.
Result

Also, specify the following parameters that are needed while installing TIBCO MDM:

o Database name

o Database port

o Database server host name or IP address
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Creating Seed Data Manually for SQL Server Database

You can create seed data by using the database setup wizard or through manual
configuration.

To install seed data with the database wizard, see Installing Seed Data Using Database
Setup Wizard.

Before you begin
Set the SQLSERVER_HOME environment variable before running doall.bat, where the data
files are created.

Procedure
1. Open the command prompt and type the command to go to the SQL Server
directory. For example: C:\> cd %MQ_HOME%\db>cd sqlserver

2. Open the Configure directory from the SQL Server location. For example:
C:\tibco\mdm\version\db\sqlserver> cd configure

3. Run the doall.bat file. For example:
C:\tibco\mdm\version\db\sqlserver\configure>doall.bat

The script prompts for the following information:
o |IP address or host name of the SQL server

o the user name and password of an administrator, who can create a database
on SQL server

« the database name that you want to create

o the new user name that you can use in TIBCO MDM
o the password of a new user

« the name of MDM instance

« the description for the MDM instance
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Specify the hostname or ip address of sglserver :
18.97.1088 .64

eqlserver = 1@.97.188 .64

Specify a user who can create a database on sglserver :

admin

Specify the password for above user :

admin

Specify the database name :

sql_7.8.8

Specify the new user to create(this will be used by the TIBCO MDM Serverd :
Jsmith

Specify the password for new user :

Jsmith

"Specify the name for the MDM instance @ "

MDH

;Snﬁecify the Description for the MDM instance := "

"Done. .. "

Creating txnisolation
Creating user script

4. Enter the details. The ddl and seed scripts start running. The scripts create the
sequences, procedures, triggers, tables, and indexes, and inserts seed data into the
tables. The log files are created in the %MQ_HOME%\db\sqlserver\install\logs
folder.

5. Verify whether the following line is displayed in the console:

"Option 1is: isolation level Value: read committed snapshot"

After the doall.bat script is executed successfully, configure your application server
for the newly created SQL database.

6. Alternative approach: To create seed data, run %MQ_
HOME%\db\sqglserver\install\installbasic.bat

You can verify the installed database in SQL Server Management Studio.

Copy SQL Server Rules

After the seed data is created, run copyRulesForSqlServer.bat located in the $MQ_
HOME /bin/migration folder to copy SQL Server-specific rules.

o Note: Ensure that you have specified the MQ_HOME and MQ_COMMON_DIR
environment variables before running the copyRulesForSqlServer.bat file. For
more information about environment variables, see Environment Variables.

SQL Server Installation Verification

Verify whether or not SQL Server is properly installed, configured for TIBCO MDM, and
running successfully.

Type the following sqlcmd statement on the command line:
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sqlcmd -S SQL Server name —d database name -U mdm db user name -P mdm db user password
-q "Select NAME from ENTERPRISE where ID=0"

Ensure that the statement returns TIBCOCIM.

Support for SQL Server Replication

The SQL Server database has a requirement to create a primary key on tables for
replication. Some of the out-of-the-box tables that are provided with TIBCO MDM do not
have a primary key. To support SQL Server replication, CreateAdditionalPk.sql scriptis
provided in the $MQ_HOME /db/sqlserver/utility folder. Run the CreateAdditionalPk.sql
script to create a primary key on the out-of-the-box tables using existing columns.

Limitations
o The script does not handle dynamically created tables.

o The script does not handle tables, which do not have sufficient columns to create a
primary key. For such tables, add an identity column, and use that column as
primary key.

Troubleshooting with SQL Server Database

Resolve the errors that you may come across while configuring the SQL Server database.

Troubleshooting with SQL Server Database

Issue Description Solution

Database The Option is: isolation level Value: To resolve this issue, perform the
Verification  read committed snapshot message is  following steps:

Message not displayed in the console.

1. Navigate to $MQ_
HOME/db/sqlserver/configure.

Issue

2. Open the txnisolation.SQL file
and run the following commands
in Microsoft SQL Server
Management Studio:
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Issue Description Solution

USE [master]

GO

ALTER DATABASE mdmuser SET
ALLOW_SNAPSHOT_ISOLATION ON
ALTER DATABASE mdmuser SET
READ_COMMITTED_SNAPSHOT on
GO

USE [mdmuser]

DBCC useroptions

GO

After you run DBCC user options, the
isolation level is displayed as a read
committed snapshot.

Creating Seed Data Manually for PostgreSQL Database

You can create seed data through manual configuration. This is especially useful if you
want to create the seed data independent of the database installation.

Procedure
1. Navigate to $MQ_HOME\db\postgreSQL\install and run the install.bat or
install.sh script.

2. On the command line, enter the following details:
o PostgreSQL home directory

 IP address or host name and port of the PostgreSQL database. The default
port for PostgreSQL is 5432. Ensure that it is not in use.

« Database name that you want to create
o Administrator credentials are required to create a database on PostgreSQL

o The new user name that you can use in TIBCO MDM, the password of new
user, and schema

« Storage location for the data tablespace, index, data fragments tablespace,
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temporary data tablespace, temporary index tablespace for TIBCO MDM
database

o The name and description for TIBCO MDM instance

The script creates the sequences, tables, indexes, triggers, and views in the
appropriate tablespaces and inserts seed data into the tables.

What to do next
Verify the log file created in the %MQ_HOME%\db\postgreSQL\install\logs folder.

Installing Seed Data Using Database Setup Wizard

The Database Setup Wizard of Configurator makes the database setup process easy and
user-friendly.

The Database Setup Wizard is common for all three databases. However, some fields vary
according to the selected database in the Settings > Database option. The available
database options are Oracle, SQL Server, and Postgres. For more information
aboutselecting the database option, see the Configurator chapter of TIBCO MDMSystem
Administration.

Prerequisites
Before running the Database Setup Wizard, ensure the following:

The database is installed.

o The database client is installed on the local computer.

« If a user has already been created, specify the schema credentials. If the user has
not been created, specify the DBA credentials. For information, see Creating
Database User for Oracle Database.

o TIBCO MDM is installed and the environment variables are created.
« Database SQL scripts are available.

o For Oracle: in $MQ_HOME/db/oracle.

o For SQL Server: in $SMQ_HOME/db/sqlserver.
o For Oracle, the tablespaces are not created.

o The following database JDBC JAR files are copied in the $MQ_
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HOME /configurator/server/1lib folder for seed data creation:
o For Oracle: ojdbc8.jar copy from $ORACLE_HOME/jdbc/1lib

o For SQL Server: mssql-jdbc-7.2.2.jrell.jar ( Microsoft JDBC Driver 7.2 for
SQL Server, Java Development Kit (JDK) 11.0 ) download from Microsoft
Download Center

« For Oracle Database client globalization support, the following JVM arguments have
been added in the $MQ_HOME/configurator/server/bin/setenv.bat file.

© —-Duser.country=en

© -Duser.language=en

Procedure
1. Login to Configurator.

2. Click Tools > Set up Database. is displayed.

3. In the Database Setup Wizard for databasename with the Database Access Mode
page, select one of the following options:

a. Create New MDM Database User: Select this option to create a new database
user.

b. Use an Existing MDM Database User: Select this option to specify details of an
existing user.

To specify details of a new database user or an existing database user, see the
following table:
New and Existing Database User Details

Field Description

Name

Database The IP address or host name of the server where the database is
Host installed.

Database By default, the port specific to each database is displayed. For
Port example,

o For Oracle, the default database port is 1521.
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Field
Name

Database
Name (TNS
Name)

DBA User
Name

DBA User
Password

Test
Connection

New MDM
Database
User Name

New MDM
Database
User

Password

Confirm
MDM
Database

Description

o For SQL Server, the default database port is 1433.

You can change the port value, if required.

The name of the database where TIBCO MDM data should be
installed.

Note: For Oracle RAC, specify the SID of either of the two clusters
of the RAC database.

The user name of the database administrator.

The password of the database administrator.

Click Test Connection to connect to the database and verify if the
connection is successful. If the test connection is not successful,
verify the specified database details.

The new user name used for the connection to the database.

The new password used for the connection to the database.

Reenter the new password for confirmation.
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Field Description
Name

User
Password

Note: Remember the user name and password.

Tablespace The file system directory (absolute path) location where all
Location tablespaces are created. This must be a local directory on the
computer where the database is running. You can specify a custom
location and provide a full path of the directory. The directory
should have ’write permission’ to write a file.

(For Oracle
database)

Notes:

« If you do not specify the tablespace location, by default the
tablespaces are created in the SORACLE_HOME /database
directory.

o It is recommended that the file system in this directory
contains a significant amount of available space. This
directory is assigned by a DBA and should be backed up on a
regular basis. For example: /opt/oradata

Database The SQL Server database location. You can specify a custom

File location and provide a full path of the directory.

Location i . . e
Note: Database File Location should have permission to write files.

(For SQL

Server

database)

c. On the Database Details and Create New MDM Database User screens, click
Next.
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Note:

« If you are not a DBA user or do not have permission to create
tablespace and a new user, you can create a tablespace and
database user using the scripts. For information, see
Configuration of Oracle Database and Configuration of SQL
Server Database.

o For Oracle, if you select the Use an Existing MDM Database
User option, see Creating Database User for Oracle Database
for the details of the existing database user.

o For SQL Server, if you select the Use an Existing MDM
Database User option, see Creating Database User for SQL
Server Database for the details of the existing database user.

4. In the MDM Instance Details page, enter the following details and click Next:

MDM Instance Details

Field Description

Name

MDM Specify the instance name of TIBCO MDM. When you have multiple
Instance instances, and you want to install a database, you can specify a particular
Name instance name. For example, preproduction and postproduction instances.

An instance entry is added in the database table.

MDM Specify the instance description of TIBCO MDM.
Instance
Description

5. In the Storage Profile Details page, select one of the following storage profile
options:

a. Typical Profile: select this option to use the default values. A Typical profile
installs tablespaces for the Oracle database and the database file location for
the SQL Server database.

After you select the Typical storage profile option, the Confirm Storage
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Parameters page is displayed. Confirm the default values and click Install to
install the seed data. See step 6.

b. Custom Profile: select this option to specify the customized values for the
default tablespace.

After you select the Custom storage profile option, the Custom Profile Setup
page is displayed. Specify the values, size, and location for the default
tablespaces.

c. Click Next.

6. In the Confirm Storage Parameters page, confirm the customized values. Click Install
to install the seed data.

7. The MDM Seed Data Summary page displays the success and error report of the
seed data and schema creation.

a. To view the schema and seed data log file, click Open.

o For Oracle, by default, the log files are stored in $MQ_
HOME /db/oracle/install/logs folder.

o Note: You can ignore tablespaces errors. For example,
"ERROR:-ORA-01543: tablespace 'VELODBTEMP' already

exists".

o For SQL Server, by default, the log files are stored in $MQ_
HOME/db/sqlserver/install/logs folder.

8. Click Finish to complete the database setup process.

TIBCO® MDM Installation and Configuration Guide



113 | TIBCO MDM Installation on Application Servers

TIBCO MDM Installation on Application Servers

The standard TIBCO MDM installer copies the file onto disk; however, it does not do much
configuration. You need to perform several configuration changes that are required in the
Application Server.

You can install TIBCO MDM on the following Application Servers:

o JBoss WildFly or JBoss EAP Application Server: Download the executable from
WildFly website and unzip it to the required location.

See the documentation supplied with the WildFly Application Server for any
additional instructions.

To configure JBoss WildFly or JBoss EAP with TIBCO MDM, see Configuring TIBCO
MDM for JBoss WildFly Application Server and Creating Subdirectory Structure.

o WebSphere Application Server: Ensure that WebSphere Application Server is
installed. See the appropriate installation documentation supplied with WebSphere
Application Server for installation instructions.

o WebLogic Application Server: Ensure that WebLogic Application Server is installed.
See the appropriate installation documentation supplied with WebLogic Application
Server for installation instructions.

To improve the performances of these application servers, see "Application Server
Configuration" chapter in TIBCO MDM Performance Tuning.

Prerequisites for Application Servers

Before installing TIBCO MDM on an application server, you need to verify various
prerequisites.

e Ensure that TIBCO MDM is installed.

« Ensure that anyone of the following database that you have installed is up and
running:

o OQOracle

o SQL Server
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o PostgreSQL
« Ensure that Configurator is installed.
o Ensure that all required environment variables are set. See Environment Variables
o Ensure that JMS is up and running.
o Ensure that seed data is created.

o For PostgreSQL database, you cannot create seed data using Database Setup
Wizard in the Configurator. This is a limitation.

Note: Ensure that you have access to the Administrative console to
install and configure TIBCO MDM. You can use the Administrative
console for WebSphere and WebLogic application servers.

e Ensure the Java Versions

Currently, TIBCO MDM requires the Java versions listed as follows. Consult the
readme shipped with your installation of TIBCO MDM for the most up-to-date
software requirements.

o JBoss WildFly Application Server
JRE 11 (Default)
Sun JVM

o Weblogic Application Server
JRE 8
Sun JVM or JRrockit JUM

o WebSphere Application Server
JRE 8
IBM JVM

TIBCO MDM is not certified with Open JDK. However, if you use Open Java and encounter
TIBCO MDM problems that require support, download and point to the Oracle release

(JAVA_HOME). You can then verify that the issue is reproducible before contacting TIBCO
support.
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TIBCO MDM Installation on JBoss WildFly Application
Server

Prerequisite

Follow these instructions to install TIBCO MDM on JBoss WildFly or JBoss EAP Application
Server. Ensure that JBoss support is enabled for TIBCO MDM using the Application
Server Name property in the Configurator Node ID > Application Server > JBOSS.

Directory Structure

The JBoss WildFly Application Server directory structure is different from its previous
versions. Therefore, you should understand its directory structure. Navigate to the
location where you have downloaded the JBoss Application Server WildFly version.

The following table lists and describes each folder included in the wildfly-
version.Final folder:
wildfly-version Directory

Subfolder Description

Name

appclient  Contains configuration files, deployment content, and writable areas used by
the application client container run from this installation.

bin Contains startup scripts and configuration files. It also contains various
bin > command line utilities such as vault, add-user, and Java diagnostic report
client available only for Unix and Windows environments.

Contains a client JAR file for use by non-maven based clients and a readme file.

docs > Contains XML schema definition files.
schema
domain Contains configuration files, deployment content, and writable areas used by

the domain mode processes run from this installation.

modules Contains various modules that are used in the JBoss Application Server. JBoss
Application Server WildFly version is based on a modular class loading
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Subfolder Description
Name

architecture.

standalone Contains configuration files, deployment content, and writable areas used by
the single standalone server run from this installation. For more information,
see Standalone Directory Structure.

welcome- Contains default Welcome Page content.
content
The following two modes are used to run the server:
« Standalone

o Domain

Standalone Directory Structure

In the standalone mode, each JBoss Application Server WildFly version instance is an
independent process similar to the previous JBoss versions, such as 3, 4, 5, 6, or 7.
Standalone Directory Structure

Sub folder Description

Name

configuration Contains configuration files of the standalone server that runs the
installation. This is the single place for configuration modifications of the
standalone server.

data Contains the information written by the server. It can be used while
restarting the server.

deployments Includes end user deployment content for automatic detection.

Note: The server's management API is recommended for installing
deployment content. File-system based deployment scanning capabilities
remain for developer convenience.
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Sub folder Description

Name

Llib > ext Contains JAR libraries referenced by application using the Extension-List
mechanism.

log Contains standalone server log files.

tmp Contains temporary files generated by the server.

tmp > auth

Contains authentication tokens that are used to exchange with local clients.

Creating Subdirectory Structure

For creating a module, you need to create the subdirectory structure.

Note: Create any one of the following directory structure specific to the
database that you have installed:

o For JBoss WildFly, the directory structure is $JB0SS_
HOME\modules\system\layers\base\com.

o For JBoss EAP, the directory structure is $JB0SS_
HOME\modules\system\layers\base\com.

Procedure

1. For Oracle database, create the hierarchical folders in the $JB0SS_
HOME\modules\system\layers\base\com directory as follows:

e oracle > ojdbc8 > main

2. For SQL Server database, create the hierarchical folders in the $JB0SS_
HOME\modules\system\layers\base\com directory as follows:

e microsoft > sqlserver > main

3. For PostgreSQL database, create the hierarchical folders in the $IB0SS_
HOME\modules\system\layers\base\org directory as follows:

o postgresql > main

After creating the subdirectory structure, perform the following steps:
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o Place the module.xml file specific to each database in the subdirectory. For
information about creating a module.xml file for each database, see Module
Creation.

« Place the JAR files specific to each database in the subdirectory. For
information about downloading or copying JAR files for each database, see the
JDBC Related Libraries section in "Third-Party Libraries".

Module Creation

Class loading in JBoss Application Server - WildFly version is different from the previous
versions of the JBoss Application Server.

The following are the major features of class loading in JBoss Application Server - WildFly
version:

« based on the modules and need to define explicit dependencies on other modules.

« deployments in the modules do not have access to classes that are defined in JARs,
unless an explicit dependency on those classes is defined.

« the deployers within the server implicitly add some commonly used module
dependencies to the deployment, such as, the javax.api and sun.jdk. In this way,
the classes become visible to the deployment at runtime.

« for some classes, the modules must be specified explicitly in the MANIFEST.MF file as
dependencies or Class-Path entries. Otherwise, you may see
ClassNotFoundExceptions, NoClassDefFoundErrors, or ClassCastExceptions.

After creating the hierarchical folders as mentioned in the Creating Subdirectory Structure,
create the module.xml file for each database. Define the actual JAR file inside it, which
contains the database driver. For example, if you have installed an Oracle database, create
a module.xml file in the $IBOSS_
HOME\modules\system\layers\base\com\oracle\ojdbc8\main folder. For creating a
module.xml file for each database, see the following samples:

For the Oracle database

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.3" name="com.oracle.ojdbc8">

<resources>
<resource-root path="ojdbc8.jar"/>
<!-- Insert resources here —-->

TIBCO® MDM Installation and Configuration Guide



119 | TIBCO MDM Installation on Application Servers

</resources>
<dependencies>
<module name="javax.api'/>
<module name="javax.transaction.api"/>
</dependencies>
</module>

For the Microsoft SQL Server database

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.3" name="com.microsoft.sqglserver">
<resources>
<resource-root path="mssql-jdbc-7.2.2.jrell.jar"/>
</resources>
<dependencies>
<module name="javax.api"/>
<module name="javax.transaction.api"/>
<module name="javax.xml.bind.api"/>
</dependencies>
</module>

For PostgreSQL database

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.3" name="org.postgresql">

<resources>
<resource-root path="postgresql-42.2.11.jar"/>
</resources>
<dependencies>
<module name="javax.api"/>
<module name="javax.transaction.api"/>
</dependencies>
</module>

The following table describes the elements that are used in the module.xml file.
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Elements and Description of Module.xml File

Element
Name

Module
Name

resource-root
path

Dependencies

Description

It must match with the directory structure that you have created for each
database. For example, the directory structure for Oracle database is $JBOSS_
HOME\modules\system\layers\base\com\oracle\ojdbc8. Therefore, the
module name is com.oracle.ojdbc8.

Specify the driver JAR file name based on the database that you have
installed. The path is relative and default to the main directory. For example,
if you have installed the PostgreSQL database, specify <resource-root
path="postgresql-42.2.11.jar"/>.

Define any dependency. For example, all JDBC data sources are dependent on
the Java JDBC API's. They are defined in the javax.api module, which is
located at modules/system/layers/base/javax/api/main folder.

Configuring TIBCO MDM for JBoss WildFly Application

Server

Some element tags in the standalone.xml file differ in the JBoss WildFly version and
JBoss EAP versions.

o Note: Ensure the correct tagging during configuration.

Procedure

Perform the following actions in the standalone.xml file if you are using JBoss
WildFly Application Server:

1. Enable access to remote server

a. Open the standalone.xml file located in the $JB0OSS_
HOME/standalone/configuration directory.

b. Change the value of an interface attribute from management to public in the
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following property:

<socket-binding name="management-http" interface="public"
port="${jboss.management.http.port:9990}"/>

2. Specify system properties
a. Add <system-properties> element after the <extensions> element.

b. Under <system-properties> element, type the system property name for the
name attribute and its value for the value attribute.

<system-properties>

<property name="MQ_HOME" value="C:/Apps/tibco/mdm/version" />
<property name="MQ_CONFIG_FILE"

value="C: /Apps/tibco/mdm/version/config/ConfigValues.xml" />
<property name="MQ_COMMON_DIR"

value="C: /Apps/tibco/mdm/version/common' />

<property name="MQ_LOG" value="C:/Apps/tibco/mdm/version/log" />
<property name="NODE_ID" value="Memberl"/>

<property name="PATH"

value="C: /Apps/tibco/mdm/bin/ignite/bin";${PATH}" />

o Note: The PATH system property is applicable only for Windows
environments.

<property name="LD_LIBRARY_PATH"
value="C: /Apps/tibco/mdm/bin/ignite/bin:
C/Apps/tibco/mdm/bin/ignite/libs:${ LD_LIBRARY_PATH}"/>

Note: The LD_LIBRARY_PATH system property is applicable only for
non-Windows environments.

<property name="ORACLE_HOME"

value="C: /Apps/Oracle/product/version/dbhome_1"/>

<property name="log4j.ignoreTCL" value="true'"/>

<property name="org.apache.catalina.connector.URI_ENCODING"
value="UTF-8"/>
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<property name="org.apache.catalina.connector.USE_BODY_ENCODING_
FOR_QUERY_STRING" value="true"/>
</system-properties>

Note: The path separator must contain forward slash instead of a
backward slash. For example, for MQ_COMMON_DIR -
C:/Apps/tibco/mdm/version/common.

The following table describes property names and their description:

Environment Variables for JBoss WildFly Application Server

Property Name Description
MQ_HOME Refers to $MQ_HOME of TIBCO MDM.
MQ_CONFIG_FILE Refers to configuration directory

location of TIBCO MDM.

MQ_COMMON_DIR Refers to the common directory
location of TIBCO MDM.

MQ_LOG Refers to the log folder location
specified in $MQ_HOME.

NODE_ID Refers to the node ID.

ORACLE_HOME Refers to the path where Oracle
database is installed.

log4j .ignoreTCL To configure the logging, specify True
value for this property. After you
configure this property, all logs are
displayed in the respective log file.
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Property Name Description

org.apache.catalina.connector.URI_ Refers to the UTF-8 encoding. This
ENCODING needs to be specified to support
multiple languages.

org.apache.catalina.connector.USE_  Specify true. The valid values are true

BODY_ENCODING_FOR_QUERY_STRING or false.
3. Specify max-post-size and max-parameters:

Parameter Description Example

Name

max-post-  For uploading a file either through a

size i <server
web service or the TIBCO MDM Ul, the name="default-
maximum file size limit is 10 MB. If you server">
want to upload a file greater than 10MB, <http-listener
add the max-post-size parameter and name="default"
change the file size. You also need to S?Cke_’t__" .
change the value of the Upload File E;Z?;g%;_http
Size Limit property in the socket="https"
Configurator. enable-http2="true"

. . . . max—-post-
For information about uploading a file size="974247881" />
through the TIBCO MDM Ul, see the <https-listener
section, "Creating Records" in TIBCO name="https" socket-
MDMUser's Guide. binding="https"
security-

realm="ApplicationR
ealm" enable-
http2="true"/>

<host name="default-
host"
alias="1localhost">
<location name="/"
handler="welcome-
content" />
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Parameter Description Example
Name

<filter-ref
name="server-
header" />
<filter-ref name="x-
powered-by-header" />

</host>
</server>
max- The maximum number of parameters <server
parameters  that can be added to the TIBCO MDM name="default—
URL into the browser. Using this value, server">
you can avoid the hash exposure used in <http-listener
the URL. This applies to both query and name="default"
POST data parameters. socket-
binding="http"
By default, the size of the max- redirect-

socket="https"

parameters is 1000. You can change the
enable-http2="true"

value as per your requirement.

max-post-
size="974247881"
Note: For TIBCO MDM Add-on for max—
Global Data Synchronization, the parameters="5000"/>
number of limits might cross due to <https-Tlistener
huge number of attributes. Therefore name="https" socket-
you must set max- binding="https"
parameters="10000". For example, security-

realm="ApplicationR
ealm" enable-
http2="true"/>

<host name="default-
host"
alias="1localhost">
<location name="/"
handler="welcome-
content" />
<filter-ref

<http-Tlistener
name="default" socket-
binding="http" redirect-
socket="https" enable-
http2="true" max-
parameters="10000"/>
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Parameter Description Example
Name

name="server-
header" />
<filter-ref name="x-
powered-by-header" />
</host>

</server>

4. Add the following VM parameters in standalone.conf (Linux) or
standalone.conf.bat (Windows):

--add-exports=java.base/jdk.internal.misc=ALL-UNNAMED
--add-exports=java.base/sun.nio.ch=ALL-UNNAMED
—--add-exports=java.management/com.sun.jmx.mbeanserver=ALL-UNNAMED
—--add-exports=jdk.internal.jvmstat/sun.jvmstat.monitor=ALL-UNNAMED
—--add-exports=java.base/sun.reflect.generics.reflectiveObjects=ALL-
UNNAMED

-—illegal-access=permit
--add-opens jdk.management/com.sun.management.internal=ALL-UNNAMED

For example, in standalone.conf.bat (Windows) set parameters as shown in the
following sample:

"JAVA_OPTS=%JAVA_OPTS% --add-
exports=java.base/jdk.internal.misc=ALL-UNNAMED"
"JAVA_OPTS=%JAVA_OPTS% --add-exports=java.base/sun.nio.ch=ALL-
UNNAMED"

"JAVA_OPTS=%JAVA_OPTS% --add-
exports=java.management/com.sun.jmx.mbeanserver=ALL-UNNAMED"
"JAVA_OPTS=%JAVA_OPTS% --add-
exports=jdk.internal.jvmstat/sun.jvmstat.monitor=ALL-UNNAMED"
"JAVA_OPTS=%JAVA_OPTS% --add-
exports=java.base/sun.reflect.generics.reflectiveObjects=ALL-UNNAMED"
"JAVA_OPTS=%JAVA_OPTS% --illegal-access=permit"
"JAVA_OPTS=%JAVA_OPTS% --add-opens
jdk.management/com.sun.management.internal=ALL-UNNAMED"

5. Create data sources

a. Under <datasources> element, add <DataSource> element with attributes such
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as:

e jndi-name="java:jboss/eCMDataSource"

e pool-name="MDMDataSource"

a. Enable data source
o Specify true for the enabled attribute

a. Under <drivers> element add JDBC driver specific to each database.

e For the Oracle database:

<driver>oracle.ojdbc.driver.OracleDriver</driver>

o For the SQL Server database:

<driver>com.microsoft.sqlserver.jdbc.SQLServerDriver</driver>

o For the PostgreSQL database:

<driver module="org.postgresql.jdbc.driver"
name="PostgresqlDriver">

<driver-class>org.postgresql.Driver</driver-class>
</driver>

a. Specify connection settings:
o Connection URL-Type any one of the following URLs:
For the Oracle database: jdbc:oracle:thin:@localhost:1521:dbinstance_name

For the SQL Server database:
jdbc:sqlserver://localhost:1433;databaseName=value

For the PostgreSQL database: jdbc:postgresql://localhost:5432/dbinstance_
name

e User Name and Password

Specify credentials for the Username and Password attributes.

a. Configure Transaction Isolation

o Specify the TRANSACTION_READ_COMMITTED value for <transaction-isolation>
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attribute.

a. Specify pool size
By default, 0 pool size is displayed.
o Specify 10 for Min Pool Size: <min-pool-size>10</min-pool-size>

o Specify 150 for Max Pool Size: <max-pool-size>150</max-pool-size>

a. Specify transaction timeout

« Specify the transaction timeout in the <blocking-timeout-millis> element.
This element indicates the maximum time in milliseconds to block a transaction
while waiting for a connection and before displaying an exception. This blocks
only while waiting for a permit for a connection, and does not display an
exception if creating a new connection that takes an inordinately long time. The
default is 36000 milliseconds.

For sample data sources, see Sample Data Sources.

6. Change deployment timeout

By default, the deployment timeout is displayed as 60 seconds. For slower machines,
TIBCO recommends to increase the deployment timeout:

a. Under <subsystem xmlns="urn:jboss:domain:deployment-
scanner:2.0">element, add the deployment-timeout attribute and its value.
For example,

<deployment-scanner path="deployments" relative-
to="jboss.server.base.dir" scan-interval="5000" runtime-failure-
causes-—
rollback="${jboss.deployment.scanner.rollback.on.failure:false}"
deployment-timeout="5000"/>

7. Specify default timeout

To deploy huge metadata from TIBCO MDM Studio to TIBCO MDM, you need to add
the default timeout attribute under the transaction element.

a. Under <subsystem xmlns="urn:jboss:domain:transactions:5.0"> element,
add the following tag:
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<coordinator-environment default-timeout="1800000"/>

8. Change HTTP Port

This step is optional. By default, the HTTP port is 8080. If required, you can change
it.

a. Under the <socket-binding-group> element, change the value of the port
attribute for http port.

o Note: Alternatively, you can also change the HTTP port using the following
parameter: standalone.bat -Djboss.socket.binding.port-offset=new _
port_number. For example, if the current HTTP port is 8080 and you want
to change it to 8180, type standalone.bat -Djboss.socket.binding.port-
offset=100;in the command prompt and press Enter. The HTTP port
number is changed to 8180.

9. Configuration for EJB
o Passing Values by Reference

While invoking the remote method of EJB, JBoss WildFly Application Server
WildFly passes default values using the Passed By Value method instead of the
Pass By Reference method. Therefore, to disable the Passed By Value method,
add the following property in the standalone.xml file.

a. For JBoss EAP, navigate to <subsystem xmlns="urn:jboss:domain:ejb3:6.0">

section, and add the following line at the end of the section: <in-vm-remote-
interface-invocation pass-by-value="false"/>

b. For JBoss WildFly, navigate to <subsystem
xmlns="urn:jboss:domain:ejb3:5.0"> section, and add the following line at

the end of the section: <in-vm-remote-interface-invocation pass-by-
value="false" />

e Define New Pool and Increase EJB Pool Size

When multiple users execute concurrent requests, multiple instances of each
bean are used concurrently. Each bean has a limited number of instances in the
bean-instance pool, available for use. If all the beans are in use, subsequent
requests have to wait for a bean to be released by the previous thread, and
then release back into the pool. This wait is for a specific time, that is, five
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10.

minutes in TIBCO MDM. If the bean is not released within five minutes, an
Instance-Acquisition-TimeOut error is displayed and the request remains
incomplete.

To avoid such errors, increase the EJB pool size to a large number (500 or
1000). On the JBoss WildFly Application Server, the default pool size is 20,
defined in the standalone.xml file. Changing the default pool size may affect all
beans in all deployed applications. Therefore, you need to define a new pool.

a. Navigate to the <subsystem xmlns="urn:jboss:domain:ejb3:5.0"> (for JBoss
WildFly) or <subsystem xmlns="urn:jboss:domain:ejb3:6.0"> (for JBoss EAP)
section, and define the following new pool and specify its pool size:

<pools>

<bean-instance-pools>

<strict-max-pool name="mdm-pool" max-pool-size="500" -instance-
acquisition-timeout="5" instance-acquisition-timeout-
unit="MINUTES" />

</bean-instance-pools>

</pools>

Defining TIBCO module

In some cases, additional external modules need to be created to configure out-of-
the-box functionality.

a. Navigate to the $IJBOSS_HOME/modules/system/layers/base/com folder and
create the following hierarchical folders: tibco/mdm/main

b. Create a module.xml file in the $JB0OSS_
HOME /modules/system/layers/base/com/tibco/mdm/main folder and add the
following snippets:

<module xmlns="urn:jboss:module:1.3" name="com.tibco.mdm">

<resources>
<resource-root path="tibjms.jar"/>
<!-- Insert resources here —-->
</resources>
<dependencies>
<!-- Insert dependencies here -->

<module name="javax.api"/>
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<module name="javax.jms.api"/>
</dependencies>
</module>

c. Save the module.xml file.

11. Adding TIBCO Module to Global Modules List
o Note: Adding TIBCO module to the Global modules list is a must.

a. Open the standalone.xml file located at $JB0OSS_
HOME /standalone/configuration directory.

b. Modify the existing <subsystem xmlns="urn:jboss:domain:ee:4.0"/> section
per database as follows:

o For the Oracle and PostgreSQL databases:

<subsystem xmlns="urn:jboss:domain:ee:4.0">
<global-modules>
<module name="com.tibco.mdm" slot="main"/>
</global-modules>
</subsystem>

o For the Microsoft SQL Server database, you also need to add the Microsoft SQL
driver module to the global Modules list. For example,

<subsystem xmlns="urn:jboss:domain:ee:4.0">
<global-modules>
<module name="com.tibco.mdm" slot="main"/>
<module name="com.microsoft.sqlserver"
slot="main"/>
</global-modules>
</subsystem>

12. Specifying EMS configuration

a. Copy the tibjms.jar file from $EMS_HOME/lib and place it in the following
folders:

$JBOSS_HOME /modules/system/layers/base/com/tibco/mdm/main and SMQ_
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h.

HOME /1ib/external

For JBoss EAP, rename the jboss-jms-api_2.0_spec-1.0.2.Final-redhat-
1.jar file to jboss-jms-api_2.0_spec-1.0.2.Final-redhat-1.jar.org located
in the $JBOSS_HOME /modules/system/layers/base/javax/jms/api/main
folder.

For JBoss WildFly, rename the jboss-jms-api_2.0_spec-2.0.0.Final.jar file
to jboss-jms-api_2.0_spec-2.0.0.Final.jar.org located in the $JB0OSS_
HOME /modules/system/layers/base/javax/jms/api/main folder.

Copy the jms-2.0.jar file from $EMS_HOME/lib to the $JBOSS_
HOME /modules/system/layers/base/javax/jms/api/main folder.

Open the module.xml file from the $JB0OSS_
HOME /modules/system/layers/base/javax/jms/api/main folder.

For JBoss EAP, replace the path value from jboss-jms-api_2.0_spec-
1.0.2.Final-redhat-1.jar to jms-2.0.jar.

For JBoss WildFly, replace the path value from jboss-jms-api_2.0_spec-
2.0.0.Final.jar to jms-2.0.jar.

Restart the JBoss WildFly application server or JBoss EAP application server.

13. Specifying HTTP session timeout

The JBoss WildFly application server provides the default HTTP session timeout of
30 minutes. However, the JBoss Application Server does not support modification of
the default value.

As per your business requirement, if you want to override the default HTTP session
timeout value for TIBCO MDM, add the following entry in the application web.xm1l file
or the jboss-web.xml file:

<web-app>

<session-config>

<!-— HTTP Session timeout, in minutes -->
<session-timeout>40</session-timeout>
</session-config>

</web-app>

Both the files are available in the ECM.ear > EML.war > WEB-INF directory.
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Sample Data Sources

You can create data sources for Oracle, SQL Server, and PostgreSQL databases. See the
sample data sources while configuring TIBCO MDM with JBoss WildFly application server.
The sample data sources are available in the standalone.xml file.

Sample data source for the Oracle database

<datasources>

<datasource jndi-name="java:jboss/eCMDataSource" pool-name="MDMDATAsource" jta="true" enabled="true" use-

ccm="true">

<connection-url>jdbc:oracle:thin:@localhost:1521:orcl</connection-url>
<driver>OracleDriver</driver>
<transaction-isolation>TRANSACTION_READ_COMMITTED</transaction-isolation>
<pool>
<min-pool-size>10</min-pool-size>
<max-pool-size>150</max-pool-size>
</pool>

<security>
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<user-name>mdmuser</user-name>

<password>mdmpassword</password>

</security>

<validation>

<valid-connection-checker class-

name="org.jboss.jca.adapters.jdbc.extensions.oracle.OracleValidConnectionChecker"></valid-connection-checker>

<stale-connection-checker class-

name="org.jboss.jca.adapters.jdbc.extensions.oracle.OracleStaleConnectionChecker"></stale-connection-checker>

<exception-sorter class-name="org.jboss.jca.adapters.jdbc.extensions.oracle.OracleExceptionSorter'></exception-

sorter>

</validation>

<timeout>

<blocking-timeout-millis>72000</blocking-timeout-millis>

</timeout>

</datasource>

<drivers>

<driver name="OracleDriver' module="com.oracle.ojdbc8">
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<driver-class>oracle.jdbc.OracleDriver</driver-class>

</driver>

</drivers>

</datasources>

o Note: To establish the connection validator work with JBoss WildFly and Oracle,
you must modify the module.xml file to add com.oracle.ojdbc8 in the
dependencies list. The file is located at $JBOSS_

HOME

\modules\system\layers\base\org\jboss\ironjacamar\jdbcadapters\main.

Sample data source for the SQL Server database

<datasources>
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<datasource jndi-name="java:jboss/eCMDataSource" pool-name="MDMDATAsource" jta="true" enabled="true" use-
ccm="true">

<connection-url>jdbc:sqlserver://localhost:1433;databaseName=velodb</connection-url>

<driver>SQLServerDriver</driver>

<transaction-isolation>TRANSACTION_READ_COMMITTED</transaction-isolation>

<pool>

<min-pool-size>10</min-pool-size>

<max-pool-size>150</max-pool-size>

</pool>

<security>

<user-name>mdmuser</user-name>

<password>mdmpassword</password>

</security>

<validation>

<valid-connection-checker class-
name="org.jboss.jca.adapters.jdbc.extensions.mssql. MSSQLValidConnectionChecker"></valid-connection-checker>

</validation>

<timeout>
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<blocking-timeout-millis>72000</blocking-timeout-millis>

</timeout>

</datasource>

<drivers>

<drivername="SQLServerDriver" module="com.microsoft.sqlserver">

<driver-class>com.microsoft.sqlserver.jdbc.SQLServerDriver</driver-class>

</driver>

</drivers>

</datasources>
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Sample data source for the PostgreSQL database

<datasources>

<datasource jndi-name="java:jboss/eCMDataSource" pool-name="MDMDATAsource" jta="true" enabled="true" use-
ccm="true">

<connection-url>jdbc:postgresql://localhost:5432/velodb</connection-ur>
<driver>Postgresq|Driver</driver> <transaction-isolation>TRANSACTION_READ_COMMITTED</transaction-isolation>
<pool>
<min-pool-size>10</min-pool-size>
<max-pool-size>150</max-pool-size>
</pool>
<security>
<user-name>mdmuser</user-name>
<password>mdmpassword</password>

</security>
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<validation>

<valid-connection-checker class-
name="org.jboss.jca.adapters.jdbc.extensions.postgres.PostgreSQLValidConnectionChecker'>

</valid-connection-checker>

<exception-sorter class-name="org.jboss.jca.adapters.jdbc.extensions.postgres.Postgre SQLExceptionSorter">

</exception-sorter>

</validation>

<timeout>

<blocking-timeout-millis>72000</blocking-timeout-millis>

</timeout>

</datasource>

<drivers>

<driver name="PostgresqIDriver" module="org.postgresql">

<driver-class>org.postgresql.Driver</driver-class>

</driver>
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Enabling Remote JMX Monitoring on JBoss WildFly Application
Server

Perform the following steps for remote JMX monitoring using Java VisualVM for JBoss
WildFly application server.

Procedure
1. Create Management User Credentials

While connecting to JavaVisualVM, you need to mention the management user
credentials. Therefore, first create the management user credentials.

a. Navigate to$IBOSS_HOME/bin directory and run add-user.bat or add-user.sh
file. The following two options are displayed in the command prompt.

B CWindowshsystem32homd.exe

What tupe of user do you wish to add?
i > Management User {(mgmt—users.propertiesd
bh» Application User C(application—users.properties)

Cars _

b. Type a. You need to enter Realm credentials.
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B Cihiindowshsystern32hemd, exe

lhat type of user do you wish to add?

a? Management User <{mgmt—users.properties)

bh» Application User <{application—users.propertiesd
{ar: a

Enter the details of the new user to add.
Realm (ManagementRealm> = _

Do not enter any values. Leave it blank.

c. Press Enter. You need to enter user credentials.

Note: User name and password must be different, else an error is
displayed.

d. Type the user name, password, and confirm password.

B ChWindowshsysterm32hemd.exe

ithat type of user do you wish to add?

a) Management User {(mgmt—users.properties)

h} Application User <application—users.properties?
Ca’: a

Enter the details of the new user to add.
Healm (ManagementRealm)> :

Uzername (admin} : admin

Pazsword :

Re—enter Password :

The username ’'admin’ is easy to guess

Are you sure you want to add user ‘admin’ vessno? _

e. Type yes to proceed with the entered user credentials.
Management user is successfully created.
2. Modify the standalone.xml file

a. Navigate to $JBOSS_HOME/standalone/configuration directory and open the
standalone.xml file.

b. Modify the standalone.xml file as follows:

<subsystem xmlns="urn:jboss:domain:jmx:1.3">
<show-model value="true"/>
<remoting-connector use-management-endpoint="true"/>
</subsystem>

c. Save the standalone.xml file.
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3. Start JBoss WildFly application server
a. On the command line, run the script that includes environment variables.
b. Navigate to $JBOSS_HOME/bin.

c. Enter the following command:

./standalone.sh -Djboss.bind.address.management=/P address

4. Start Java VisualVM

a. Navigate to $IBOSS_HOME/bin/client directory and copy jboss-cli-client.jar
and place it to the $JAVA_HOME/1ib directory.

Ensure that JAVA_HOME refers to the location from where you want to run Java
VisualVM.

b. On the command line, type $JAVA_HOME /b-in.

c. Enter the following command:

jvisualvm —--cp:a $JAVA_HOME\lib\jboss-cli-client.jar

The JavaVisualVM window is displayed with the Local and Remote options.
5. Add JMX Connection

a. For the Remote option, double-click or right-click to add the host name. After
adding the host name, you need to add the JMX connection. Type the
following URL in the Connection field:

service:jmx:remoting-jmx://IPAddress:9999
For example, service:jmx:remoting-jmx://10.97.108.72:9999.
In this case, 9999 is the JMX port for the TIBCO MDM Server on 10.97.108.72.

b. Specify the user credentials that you have created in stepl.

c. Click Connect.

If the JMX connection is successful, the connection URL link is displayed
following the host name.

Email Configuration

Configure email for the JBoss WildFly version.
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Specify the following parameters in the standalone.xml file under the <socket-binding-
group> section:

<socket-binding-group name="standard-sockets" default-interface="public" port-offset="${jboss.socket.binding.port-
offset:0}">

<outbound-socket-binding name="mail-smtp">
<remote-destination host="smtphostIP" port="25"/>
</outbound-socket-binding>

</socket-binding-group>

o Note:

e The value of the host attribute refers to the SMTP server.

« The values specified in the Configurator for the SMTP Host and SMTP Port
properties are not used. Rest email properties are used. For information
about the email properties, see TIBCO MDM System Administration.

Configuring JBoss WildFly for Globalization Support

If you have JBoss WildFly application server and Microsoft SQL Server combination, you
need to configure the standalone.bat file for Globalization support.

For information about Globalization support, see the section, "Globalization Support" in
TIBCO MDM System Administration.

Procedure
1. Navigate to $JBOSS_HOME /bin directory.

o For Windows: open the standalone.bat file.

o For Linux: open the standalone.sh file.

2. Add the following snippet to the beginning of the file:

For Windows:
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set "JAVA_OPTS=%JAVA_OPTS% -Dfile.encoding=UTF-8"
For Linux:

JAVA_OPTS="$JAVA_OPTS -Dfile.encoding=UTF-8"

3. Save the updated file.

4. Restart the server.

Encrypting Password for Data Source

To encrypt the password for data source on JBoss WildFly application server, update the
standalone.xml file.

Procedure
1. Add SecureldentityLoginModule and Security Domain

a. Go to $JBOSS_HOME/standalone/configuration directory and open the
standalone.xml file.

b. Under <security-domains> element, add the EncryptedPassword security-
domain and SecureldentityLoginModule along with username and password
module options. For example,

<security-domains>

<security-domain name="EncryptedPassword">

<authentication>

<login-module code="org.picketbox.datasource.security.SecureldentityLoginModule" flag="required">

<module-option name="usemame" value="@MDM.DB.USER@"/>
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<module-option name="password" value="@MDM.DB.PASSWORD.ENTCRYPT@"/>

<module-option
name="managedConnectionFactoryName" value="jboss.jca:service=LocalTxCM,name=dataSource-1-
PoolName,dataSource-2-PoolName"/>

</login-module>
</authentication>
</security-domain>

</security-domains>

c. Under the <datasources> element, remove the following existing <user-name>
and <password> from the <security> element because you have already added
<user-name> and <password> as module options in the previous step:

<datasources>
<datasource ... >
<security>
<user-name>mdmuser</user-name>
<password>mdmpassword</password>
</security>
</datasource>

</datasources>

d. Under the <datasources> element, add the EncryptedPassword security-
domain, such as:

<datasources>
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<datasource ... >
<security>
<security-domain>EncryptedPassword</security-domain>

</security>
</datasource>
</datasources>

e. Save the updated standalone.xml file.

2. Encrypt Password
a. On the command line, type $JBOSS_HOME.

b. Enter the following command:

java -cp modules\org\picketbox\main\picketbox-

version. final.jar;modules\org\jboss\logging\main\jboss-logging-
version.GA.jar
org.picketbox.datasource.security.SecureldentitylLoginModule

password

Note: Verify the versions of the picketbox and logging JAR files in
the $3B0SS_HOME directory and specify them in the command
accordingly.

The command returns the encrypted password. You can use the returned
password in your security domain.

Removal of jaxrs Entries for JBoss WildFly Application Server

The JBoss WildFly Application Server version provides RESTEasy framework to build
RESTful web services and Java applications. It is implemented based on the JAX-RS
specification. It conflicts with other RESTful frameworks, which are compliant with the
JAX-RS specification.

Remove the jaxrs entries from the standalone.xml file located in the $JB0OSS_
HOME /standalone/configuration directory.
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Before modifying the file, back up the existing standalone.xml file, and then remove the
following lines:

<extension module="org.jboss.as.jaxrs"/>
<subsystem xmlns="urn:jboss:domain:jaxrs:1.0"/>

Enabling SSL on JBoss WildFly Application Server
Enable and verify SSL on JBoss WildFly Application Server.

By default, JBoss WildFly application server uses 8443 port for the HTTPS protocol. Type
the following URL into your browser: https://IPaddress:8443/eml/Login.

By default, the application realm is mentioned in the standalone.xml file located in the
$JBOSS_HOME /standalone/configuration directory. The application.keystore is auto
generated on the first use with a self-signed certificate for localhost. However, generating
the self-signed certificates are discouraged because they result in browser warnings on
internal sites.

o Note: It is always good practice to create a custom application realm. For
creating a custom application realm on JBoss WildFly application server, see
WildFly documentation.

Deploying Custom Pages

For JBoss WildFly application server, by default the MQ_CUSTOMFORMS_HOME system property
points to MQ_HOME. However, if you create custom pages other than the default UIBuilder
pages and you want to deploy those custom pages in a cluster environment, then you
must use a common location. By using the common location, you do not have to deploy
custom pages multiple times. To use a common location, configure the standalone.xml
file.

Procedure
1. Go to $IBOSS_HOME/standalone/configuration directory and open the
standalone.xml file.

2. To deploy custom pages to a common folder in the cluster environment, add the
following system property:
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<system-properties><system-properties>
<property name="MQ_CUSTOMFORMS_HOME" value="MQ_COMMON_DIR" />

o Note: The configuration properties vary according to your application
server. For deploying the custom pages in the cluster environment on
WebLogic Application Server, see Configuring TIBCO MDM for WebLogic
Application Server and for deploying the custom pages in the cluster
environment on WebSphere Application Server, see Configuring TIBCO
MDM for WebSphere Application Server.

3. In the non-cluster environment, add the location and path of the MDMCustomu-i-
content file:

<location name="/eml/components" handler="MDMCustomui-content"/>

<file name="MDMCustomui-content" path="${MQ_
HOME} /dynservices/customui" follow-symlink="true"/>

4. In the cluster environment, copy $MQ_HOME /dynservices folder to the $MQ_
CUSTOMFORMS_HOME folder.

<file name="MDMCustomui-content" path="${MQ_CUSTOMFORMS_
HOME} /dynservices/customui" follow-symlink="true"/>

5. Save the standalone.xml file.
6. Copy the existing custom page artifacts to the new location.

cp —avr /home/apps/MDM_

Installations/MDM

versionJBOSSEAPSQL /mdm/version/dynservices/customui/home/apps/MDM_
Installations/MDMversionJBOSSEAPSQL_COMMON/dynservices

7. Restart the server.

What to do next
Log in to TIBCO MDM and check the pages.
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Deploying TIBCO MDM on JBoss WildFly Application Server

You need to deploy TIBCO MDM on JBoss WildFly Application Server.

Procedure
1. Copy the ECM.ear file from $MQ_HOME to the $JBOSS_HOME/standalone/deployments
directory.

2. To improve the performance of TIBCO MDM, add the following JVM parameter while
starting the JBoss WildFly Application Server:

Dorg.apache.xml.dtm.DTMManager="org.apache.xml.dtm.ref.DTMManagerDef
ault"

If the output does not contain any error or exception messages, you are ready to use
the JBoss.

o Note: When the log4j service of TIBCO MDM initializes, it overrides the
JBoss rootLogger property and starts writing server logs in the elink.log
file. As a workaround, you can comment out the rootLogger property in
the $MQ_HOME/config/ConfigValues.xml file:

<ConfValue description="The root logging level for the MDM
server." name="Root logging Level for MDM Server"
propname="1log4j.rootLogger" sinceVersion="7.0"
visibility="All"> <ConfString default="DEBUG"
value="DEBUG"/> </ConfValue>

It is recommended that you keep this property to change the root logging
level for TIBCO MDM.

Starting JBoss WildFly Application Server

After you configure TIBCO MDM with JBoss WildFly Application Server, you can start the
JBoss WildFly Application Server.

Procedure
1. On the command line, type $JB0SS_HOME/bin.
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2. Enter the following command:
e For local host: standalone.bat or ./standalone.sh

e For remote server: standalone.bat -b 0.0.0.0 or ./standalone.sh -b
0.0.0.0

Note: To access the TIBCO MDM instance remotely, you need to
provide -b 0.0.0.0 in addition.

The JBoss WildFly Application Server starts.

Troubleshooting with JBoss WildFly Application Server

You may come across some exceptions on JBoss WildFly Application Server.

Troubleshooting with JBoss Application Server

Issue Description Solution

Error occurs on TIBCO MDM is installed with the Windows,  TIBCO MDM supports JDK 11

the console for JBoss Wildfly application server, and version. Ensure that the PATH
the unsupported  Oracle database with the inbuilt Java variable does not point to
Java versions version. another Java version.

The JBoss WildFly application server
started successfully, however, the error
messages are displayed on the console for
the unsupported Java versions.

Configuring TIBCO MDM for WebSphere Application
Server

Log in to the Administrative console of WebSphere Application Server to configure the
properties.

Configure the following properties in the Configurator:
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Configurator Properties for WebSphere Application Server
Property Value

Name

JNDI By default, the value is iiop://localhost:2809. As per your application profile, you

Naming need to change the host IP address and port number. For the port number, see

Service BOOTSTRAP ADDRESS specified in the WebSphere Application Server. Login to the

URL Administrative console of the WebSphere Application Server console and expand
Application Servers > server name > Ports.

Security By default, a SUN security provider is defined. For WebSphere Application Server,
Provider  you need to change it to IBM.

Type

o Note: For clustered setup, it is recommended that you:
« Increase the poolsize per server to 100.

« Increase the transaction timeout of the application server to 36000.

Procedure
1. Creating a Profile on WebSphere Application Server

a. Create a profile other than the default using the profile creation wizard.

b. Start the Administration Server.
o Go to the $WAS_HOME/profiles/profilename/bin directory.

o Enter the following command: ./startServer.sh serverl
2. Log in to the Administrative console of WebSphere Application Server.
3. Specify Servers Details

a. In the left panel, expand Servers > Server Types and click WebSphere >
application servers. The Application servers panel is displayed on the right.

b. Under Preferences, click servername. The Configuration tab is displayed.
4. For Transaction Service Details:

a. Under Container Settings, expand Container Services and click the
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Transaction Service link. The Configuration tab for the Transaction Service is
displayed.

b. Under General Properties, enter the following values:

Transaction Service General Properties

Field / Drop-down List Name Values

Total transaction lifetime timeout 36000

Client inactivity timeout 7200
Maximum transaction timeout 0

Heuristic retry limit 0

Heuristic retry wait 0

Heuristic completion direction ROLLBACK

c. Click OK. A message is displayed with the Save and Review options.

d.

Click the Save link to save changes to the master configuration.

5. For ORB Service Details:

a.

b.
C.

d.

Under Container Settings, expand Container Services and click the ORB
service link. The Configuration tab is displayed.

Under General Properties, check the Pass by reference check box.
Click OK. A message is displayed with the Save and Review options.

Click the Save link to save changes to the master configuration.

6. For Server Infrastructure Details:

a.

Under Server Infrastructure, expand Java and Process Management and click
the Process definition link. The Configuration tab is displayed.

Under Additional Properties, click the Java Virtual Machine link. The
Configuration tab is displayed.

In the Initial heap size and Maximum heap size fields, enter the heap size to
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1024 as the minimum value for both the fields.
d. In the Generic JVM arguments field, enter the following JVM arguments:

e. For readability, each entry is listed on a separate line. However, you need to
enter these arguments in a single line, separated by a single space.

-DLANG=en_US.UTF-8

-DNODE_ID=${NODE_ID}
-Dc'lient.encoding.override=UTF-8
-DMQ_HOME=${MQ_HOME}

-DMQ_LOG=${MQ_LOG}
-DMQ_CONFIG_FILE=${MQ_HOME}/config/ConfigValues.xml
-DMQ_COMMON_DIR=${MQ_COMMON_DIR}

~DPATH=${PATH}

-DOS=<0S>

-DDISPLAY=:1.0
Djavax.xml.transform.TransformerFactory=org.apache.xalan.proces
sor.

TransformerFactoryImpl

Djavax.xml.parsers.DocumentBuilderFactory=org.apache.xerces.jax

p.
DocumentBuilderFactoryImpl

o Note:

o For the Oracle database, enter -DORACLE_HOME=${ORACLE_
HOME}.

o To improve the performance of TIBCO MDM, enter the

following JVM parameter when starting the application server:
—-Dorg.apache.xml.dtm.DTMManager=
"org.apache.xml.dtm.ref.DTMManagerDefault"

e To deploy TIBCO MDM custom pages to a common folder in

the cluster environment, set the following parameter:
-DMQ_CUSTOMFORMS_HOME=MQ_COMMON_DIR

f. To monitor the JVM application server, enter the following JVM arguments:
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-Dcom.sun.management.jmxremote
-Dcom.sun.management.jmxremote.authenticate=false
—-Dcom.sun.management.jmxremote.ssl=false
-Dcom.sun.management.jmxremote.port=9999
-Djavax.management.builder.initial=

The value of Djavax.management.builder.initial argument must be empty.
g. Click OK. A message is displayed with the Save and Review options.
h. Click the Save link to save changes to the master configuration.

7. For Port Details: if multiple servers and clusters are involved while installing TIBCO
MDM on the WebSphere Application Server, you need to configure and allocate
multiple ports to the application.

a. Under Communications, expand Ports. A list of ports is displayed.

b. Verify the value of the wc_defaulthost port. The WebSphere Application Server
runs on this default port.

c. Ensure that the port is defined as a domain name system (DNS) alias in the
default_host Virtual Host definition.

o Note: The DNS alias by which the virtual host is known is defined
through Environment > Virtual Hosts > default_host > Host Aliases.
The Virtual host for the Web modules that are contained in
application is specified through Applications > WebSphere
Enterprise Applications > ECM > Virtual hosts.

8. Specify Environment Variables

a. In the left panel, expand Environment and click WebSphere variables > . The
WebSphere Variables panel is displayed on the right.

b. In the Scope drop-down list, select Node=<nodelD>,Server=serverl.
c. Under Preferences, click New. The Configuration tab is displayed.

d. Under General Properties, type a system variable name in the Name field and
its value in the Value field. The Description field is optional.

Add the following environment variable for the custom pages deployment:
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MQ_CUSTOMFORMS_HOME=MQ_COMMON_DIR

e. Click OK. The variable is listed in the table.

Similarly, create other Environmental Variables. The following table displays a
list of all other added environment variables.

rseLAY

/home/apps/1BM/WebSphera/Appserver/java/s.0

LD LIBRARY PATH LI i ¥ DM bi b: Y /home/apps/ pr 19.0.0/client_1/lib

WASORA_COMMON

MO_CONFIG FILE /home/apps/MDM_Installations/MDM  WASORA/mdm/ /config/ConfigValues xml

WASORA_COMMON

1Q_HOME fMome/apps/MDM_installations/MOM  WASORA/mGTY/'

Mo Lo

MODE 1B Memberd

ORACLE HOME fhome/apps/app/apps/ product/18.0.0/client_1

ORACIE JDEC_ DRIVER PATH | /ome/apps/app/apps/product;19.0.0/cliant_1,/jbeAlib

DM WASORA/mdm/ /bin/as/2.3/bin:/home/apps/app/apps/product/19.0.0/client_1/bin:/usr,

SERVER 10G ROOT ${LOG_ROOT}/server1

9. Configuring Database Drivers and Data Source
a. Specify JDBC Details

i. In the left panel, expand Resources > JDBC, and then click JDBC
providers. The JDBC providers panel is displayed on the right.

ii. In the Scope drop-down list, select Node=<nodelD>, Server=serverl.

iii. Under Preferences, click New. The Create a new JDBC Provider window
is displayed.
« In the Database type drop-down list, select Oracle. The Provider type is
populated with Oracle JDBC Driver.

« In the Implementation type drop-down list, select Connection pool data
source. The Name and Description fields are populated with Oracle JDBC
Driver.

i. Click Next. The Enter database class path information window is
displayed.

ii. If you have selected the Oracle database option in the last step, type the
location of the ojdbcs. jar file. If you are using Oracle Database 19.3,
copy ojdbc8.jar in SORACLE_HOME/19c/1ib.

iii. Click Next. The Summary window is displayed. Review the information.
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iv. Click Finish. The Oracle JDBC Driver is listed under Preferences and a

message is displayed with the Save and Review options.

v. Click the Save link to save changes to the master configuration.

b. Specify Security Details

Vi.

In the left panel, expand Security and click Global security. The Global
security panel is displayed on the right.

i. Under Authentication, expand Java Authentication and Authorization

Service and click the J2C authentication data link.

Under Preferences, click New. The General Properties window is
displayed.

In the Alias, User ID, and Password fields, type the database alias name,
its user ID, and password respectively. The Description field is optional.

Click Apply, and then click OK. The database Alias is listed under
Preferences and a message is displayed with the Save and Review
options.

Click the Save link to save changes to the master configuration.

c. Specify Data Source Details

vi.

In the left panel, expand Resources > JDBC, and then click Data sources.
The data source panel is displayed on the right.

i. In the Scope drop-down list, select Node=<nodelD>, Server=serverl.

i. Under Preferences, click New. The Create a data source window is

displayed.
Enter the Data source name and JNDI name.
Click Next. The Select JDBC provider window is displayed.
Select either of the following two options:
« Create a new JDBC provider

o Select an existing JDBC provider: After you select this option, the
existing JDBC providers are displayed in the drop-down list. You
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can select it from the list.

vii. Click Next. The Enter database specific properties for the data source
window is displayed.

In the Value field, enter the database connection URL. For example,
for Oracle database: jdbc:oracle:thin:@ machinename or
ipaddress:portnumber: INSTANCENAME.

In the Data store helper class name drop-down list, select the
appropriate data store helper class name. For example, Oraclellg
data store helper.

viii. Click Next. The Setup security aliases window is displayed.

In the Component-managed authentication alias drop-down list,
select the alias.

In the Mapping-configuration alias drop-down list, select
DefaultPrincipleMapping.

In the Container-managed authentication alias drop-down list,
select alias.

ix. Click Next. The Summary window is displayed. Review the information.

x. Click Finish. The data source is listed in the Preferences section and a
message is displayed with the Save and Review options.

xi. Click the Save link to save changes to the master configuration.

o Note: You must save the data source name before testing its

connection, else an error message is displayed.

xii. Under Preferences, select the Data Source name and click Test
Connection to test the connection. A Connection Successful message is
displayed.
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Note: Navigate to Data sources > DataSourceName >
Connection pool properties to set the Maximum connections
to 50 and the connection timeout to 7200.

Deploying TIBCO MDM on WebSphere Application Server

After configuring TIBCO MDM with WebSphere Application Server, deploy TIBCO MDM.

Procedure
1. In the left panel, expand Applications and click New Application. The New
Application panel is displayed on the right.
2. Under Install a New Application, click the New Enterprise Application link. The
Preparing for the application installation window is displayed.
3. Under Path to the new application, click Browse. The Choose File to Upload window
is displayed.
4. Browse to the path of the ECM.ear file located in $MQ_HOME. Click Next.
Note: If you have a ECM.ear file located at the remote location, you can
select the file path using the Remote file system option.
5. Under How do you want to install the application?, select the Detailed - Show all

10.
11.

installation options and parameters option, and then click Next. The Application
Security Warnings are displayed.

Click Continue. The Install New Application window is displayed with the Select
installation options window.

Click Next. The Map modules to servers window is displayed. Verify that Cluster and
servers are properly selected.

Click Next. The Provide JSP reloading options for Web modules window is
displayed.

Click Next. The Map shared libraries window is displayed.
Click Next. The Map shared library relationships window is displayed.

Click Next. The Initialize parameters for servlets window is displayed.
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12.

13.
14.
15.
16.

17.
18.
19.
20.
21.

Click Next. The Provide JNDI names for beans window is displayed. Verify that all
JNDI names are pre-populated.

Click Next. The Map virtual hosts for Web modules window is displayed.
Click Next. The Map context roots for Web modules window is displayed.
Click Next. The Map JASPI provider window is displayed.

Click Next. The Ensure all unprotected 2.x methods have the correct level of
protection window is displayed with installation options summary.

Click Next. The Metadata for modules window is displayed.
Click Next. The Display module build Ids window is displayed.
Click Next. The Summary window is displayed.

Click Finish.

After installing, click Save.

After a successful startup, a confirmation message is displayed in the log file located
at SWAS_HOME/logs.

Note: You can also verify if the application is installed successfully using
the following URL: http://hostname:port_number/eml/Login, For example:
http://localhost:9081/eml/Login

Setting Class Loader Policy

After deploying TIBCO MDM on Websphere Application Server, set the class loader policy.

Procedure

1.

In the left panel, expand Servers > Server Types and click WebSphere application
servers.

The Application servers panel is displayed on the right.

Under Preferences, click servername.

For example, serverl. The Configuration tab is displayed.
Under Applications, click the Installed applications link.

Under Preferences, click the application name. For example, ECM.
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5. Under Detail Properties, click the Class loading and update detection link.

The Configuration tab is displayed.

6. Under Class Loader order, select the Classes loaded with local class loader first
(parent last) option.

7. Under WAR class loader policy, ensure that the Class loader for each WAR file in
application option is selected.

8. Click Apply, and then click OK.

The class loader policy settings are saved a message is displayed with the Save and
Review options.

9. Click the Save link to save changes to the master configuration.

Specifying MIME Types

After setting the class loader policy to parent last, configure the MIME types.

Procedure
1. In the left panel, expand Environment and click Virtual Hosts. The Virtual Hosts
panel is displayed on the right.

2. Under Preferences, click the virtual host link where ECM is installed. For example,
default_host. The Configuration tab is displayed.

3. Under Additional Properties, click the MIME Types link. A list of MIME types is
displayed.

4. Under Preferences, click the New button. The Configuration tab is displayed.

5. Under General Properties,
o In the MIME Type field, enter application/xml.

o In the Extensions field, enter xslt.
6. Click the OK button. A message is displayed with the Save and Review options.

7. Click the Save link to save changes to the master configuration.

Setting Up Security

Specify Security related settings.
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Perform the following tasks:
o Enabling Cookies
o Enabling URL Rewriting
o Setting Up SSL for WebSphere Application Server

Enabling Cookies

TIBCO MDM uses a cookie to keep track of menus selected by the user. The business
sensitive information stored in the cookies should be kept confidential and sent only over
a secure link. Make cookies secure by requiring them to be transmitted only over secure
links and to the appropriate location.

Procedure
1. In the left panel, expand Servers > Server Types and click WebSphere application
servers. The Application servers panel is displayed on the right.

2. Under Preferences, click servername. The Configuration tab is displayed.

3. Under Container Settings, expand Web Container Settings and click the Web
container link. The Configuration tab is displayed.

4. Under Additional Properties, click the Session management link. The Configuration
tab is displayed.

5. Under General Properties, click the Enable cookies check box. The Configuration tab
for Cookies is displayed.

6. For the JSESSIONID cookie property, enter the domain and path in the Cookie
domain and Cookie path fields for which session tracking cookie should be sent.

7. Click the Restrict cookies to HTTPS sessions check box to restrict session cookies to
HTTPS sessions.

8. Click the OK button. A message is displayed with the Save and Review options.

9. Click the Save link to save changes to the master configuration.

Enabling URL Rewriting

You need to enable URL rewriting to send web service requests with JessionID and if the
installation does not support cookies.
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o Note: TIBCO MDM recommends that cookies are enabled.

Procedure

1.

In the left panel, expand Servers > Server Types and click WebSphere application
servers. The Application servers panel is displayed on the right.

Under Preferences, click servername. The Configuration tab is displayed.

Under Container Settings, click the Session management link. The Configuration tab
is displayed.

Under General Properties,
o Select the Enable cookies and Enable URL rewriting check boxes.
Click the OK button. A message is displayed with the Save and Review options.

Click the Save link to save changes to the master configuration.

Setting Up SSL for WebSphere Application Server

SSL needs to be set up to access the application through a browser over the HTTPS
protocol.

Procedure

1.

Enable Transport Chains

a. In the left panel, expand Servers > Server Types and click WebSphere
application servers. The Application servers panel is displayed on the right.

b. Under Preferences, click servername. For example, serverl. The Configuration
tab is displayed.

c. Under Container Settings, expand Web Container Settings and click the Web
container transport chains link. The following page displays the various ports
on your server and also provides information on whether SSL is enabled. If
SSL is not enabled, you can enable it.
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Application servers wE

Application servers > server 1 > Web container transport chains

Use this page to view and manage = transport chain. Transport chains represent network protocol stacks that are operating vithin a client or
eeeeee

New|| Delete
ElleE

Selact| Name & Enabled Host 0 Port & SSL Enabled

You can administer the following resources:

D HttpQueuelnboundDefault Enabled = 9081 Disabled

HttpQueuslnboundDefaultSecure | Enabled = G444 Enabled

WCInboundAdmin Enabled * 3061 Disabled

WCInboundAdminSecure Enabled * 3044 Enabled

WCInboundDefault Enzbled = 9081 Disabled

N &E @

D WCInboundDefaultSecure Enzbled = G444 Enabled

Total 6

d. Click New. The Create New Transport Chain window displays Select a transport
chain template page.

o In the Transport chain name field, enter the transport chain name. For
example, MDMTransportChain2.

e In the Transport chain template drop-down list, select WebContainer
(templates/chains|webcontainer-chains.xml#Chain_1). For SSL, select
WebContainer-Secure(templates/chains|webcontainer-chains.xml#Chain_2).

a. Click Next. The Create New Transport Chain window displays Select a port
page.

o In the Port name field, enter the port name. For example,
MDMTransportChain2.

o In the Host field, enter the host. For example, *.

e In the Port field, enter the port number. For example, 9082. Use any unused
port number.

a. Click Next. The Create New Transport Chain window displays Confirm new
transport chain creation page.

b. Under Summary of Actions, a summary of the selections is displayed. Review
the information.

c. Click Finish. The SSL Enabled column for the newly created TransportChain
displays Enabled for the specified port and a message is displayed with the
Save and Review options.
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d.

Click the Save link to save changes to the master configuration.

2. Specify Host Configuration

a.

C.
d.

e.

a.
b.

C.

In the left panel, expand Environment and click Virtual Hosts. The Virtual Hosts
panel is displayed on the right.

Under Preferences, click the virtual host link where ECM is installed. For
example, default_host. The Configuration tab is displayed.

Under Additional Properties, click the Host Aliases link.
Under Preferences, click New.

Under General Properties,

In the Host Name field, enter *.

In the Port field, enter 9082 as port number or any other unused port number.

Click OK. A message is displayed with the Save and Review options.
Click the Save link to save changes to the master configuration.

Restart the server. Browse the application using the https protocol over the
listening port.

3. Certificates (only applies if using GDSN software edition)

To communicate with 1SYNC securely, you may need to download their certificates
and insert them into your trusted certificate store if they are not present already.

a.

Open the web browser and type the secure URL of the server. For example,
https://item.preprod.1lworldsync.com.

If your computer does not have the certificates in its keystore, a security alert
is displayed. This alert warns you that the certificate is not verified and allows
you to view the certificate. Click View Certificate to view the certificate. The
Certificate window is displayed.

Click on the Certification Path tab. Each certificate listed must be copied to a
file.

o Select the Details tab.

« Click Copy to File. The Certificate Export Wizard opens and guides you
through the steps for copying certificates, certificate trust lists, and
certification revocation lists from a certification store to your disk.
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e Choose the Base-64 encoded X.509 (.CER) format and click Next.
o Provide a filename and click Next.
o Click Finish. The certificate is exported to the file.

d. Import the certificates into the trusted certificate store of the Java virtual
machine. The default Java virtual machine is located at <Websphere install
location>/AppServer/java, and the corresponding trusted certificate store is at
<websphere install location>/AppServer/java/jre/lib/security/cacaerts.

e. Use the keytool utility in jre/bin/keytool to insert all the certificates. For
example:

$keytool -import -alias 1lsync -file ./1lsync.cer -keystore
../lib/security/cacerts -trustcacerts

The standard password for the cacerts store is changeit. After you confirm that
you trust the certificate, the following message is displayed:

Certificate was added to keystore.

f. Repeat this procedure for all certificates.

For more information, see IBM Knowledge Center documentation.
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Troubleshooting with WebSphere Application Server

Resolve the errors that you may come across while working with the WebSphere Application Server.

Troubleshooting with WebSphere Application Server

Issue

Error Creating
Catalogs and
Data Sources
After Installation

Login Screen Not
Visible and Logs
Show “Naming
service not
available” Error

Cannot Log In
After Installation

Enabling Memory
Allocation Trace

Description

Error during catalog creation through the Ul.

Catalog attributes not defined.

Error during data source creation through the Ul.

Data source -1 could not be loaded.

The Naming service not available error is displayed in the log
file and the Login page is not visible.

You have the login page and your seed data is good but you
cannot log in.

Memory allocation tracing may be requested by TIBCO
Customer Support for analysis of certain problems.

Solution

Using the WebSphere Administrative Console, select Servers > Application Servers > serverl > Container Services > ORB
Service, then select the Pass by Reference check box.

Background Information: If these errors are seen while creating data sources and catalogs, the WebSphere configuration may
be incorrect. In WebSphere, the ORB Service should have the Pass by Reference check box selected.

You can also check this value by viewing the WebSphere configuration server.xml file for your application server. Look at the
following XML element and check if the noLocalCopies attribute is set to true:

SWAS_HOME/profiles/<profile name>/config/cells/<cell name>/nodes/<node
name>/servers/serverl/server.xml<services xmi:type="orb:0bjectRequestBroker" xmi:id="ObjectRequestBroker_
<id>" enable="true" requestTimeout="180" requestRetriesCount="1" requestRetriesDelay="0"
connectionCacheMaximum="240" connectionCacheMinimum="100" commTraceEnabled="false"
locateRequestTimeout="180" forceTunnel="never" nolLocalCopies="true'">

This usually happens when a wrong IIOP port number is specified in the Configurator. When WebSphere starts, in the
SystemOut.log, you should see the following output:

[7/27/04 15:28:28:451 PDT] 7b04ccdl HttpTransport A SRVEQ1l71I: Transport http is listening on port
9,083.
[7/27/04 15:28:28:503 PDT] 7b04ccdl RMIConnectorC A ADMCO026I: RMI Connector available at port 2810

In this example, the 2810 port number should be used for the JNDI Naming Service URL property in the Configurator (Application
Server > WEBSPHERE).

This means your security provider is invalid. You can fix this by changing your security provider class name in the Configurator.
The default security provider is SUN. If you are using WebSphere Application Server, select IBM as the security provider.

Set up the tracing as follows:
Environment > WebSphere Variables. Select the server.

Create the following environment entries:

IBM_MALLOCTRACE - set value as 1
MALLOC_TRACE - set value to
SWAS_HOME /profiles/<profilename>/logs/serverl/mtrace.log

TIBCO® MDM Installation and Configuration Guide



166 | TIBCO MDM Installation on Application Servers

Issue Description

Enabling Garbage If you are experiencing memory usage issues, TIBCO Customer
Collection Data Support may request for collection of garbage collection
Logging statistics.

Failed Reflecting The IWAV0002E Failed reflecting values warning is displayed
Values Error when TIBCO MDM is installed on WebSphere Application
Server.

Incorrect Startup ~ When TIBCO MDM is deployed on the WebSphere Application

Message Error Server, if for some reason the TIBCO MDM application does
not start up because of initialization errors, the WebSphere
Application Server Ul still shows the application status as
Started.

The TIBCO MDM The TIBCO MDM server failed to start and showed the
server failed to following error message: java.lang.NoClassDefFoundError:
start javax.jms.JMSContext exception

An exception on The WebAppNotLoadedException occurs on the WebSphere
the WebSphere Application Server startup

Application Server

startup

Solution
Substitute the absolute directory name for $WAS_HOME.

To enable garbage collection data collection, change the JVM settings as follows:

Servers > Application Server > <servername> > Server Infrastructure > Java and Process Management > Process Definition >

Java Virtual Machine.Select the Verbose garbage collection check box against it.

The garbage collection data is stored in

SWAS_HOME /profiles/<profilename>/logs/serverl/native_stderr.log

Ignore this warning. For additional information, see the following site:

http://publib.boulder.ibm.com/infocenter/wchelp/v6romo0/index.jsp?topic=/com.ibm.commerce.wcportal.doc/refs/rpo_

configerror.htm

None. If the user in such a scenario hits the TIBCO MDM login page URL, initialization errors may be listed on that page.

1. Navigate to SEMS_HOME/lib directory.

Copy the jms-2.0.jar file.

Navigate to $MQ_HOME/ECM.ear and place the jms-2.0.jar file.

Navigate to $MQ_HOME/ECM.ear/EML.war /META-INF directory.

Open the MANIFEST.MF file and append the <space> jms-2.0.jar file name.
Save the MANIFEST.MF file.

Deploy the updated ECM. ear file in the WebSphere application server.

© N o 0~ W N

Restart the WebSphere application server.

After deploying TIBCO MDM on Websphere Application Server, ensure that the Class loader for each WAR file in application
option is selected by the class loader policy. For information, see the "Setting Class Loader Policy" section in TIBCO

MDMinstallation and Configuration.
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Configuring TIBCO MDM for WebLogic Application

Server

Using the Configuration wizard, create a WebLogic domain.

Prerequisites

Configure the following properties in the Configurator:

Configurator Properties for WebLogic Application Server

Property
Name

Application
Server
Name

JNDI
Naming
Service
URL

Encryption
Provider

JNDI
Context

Location

Node ID >
Application
Server

Node ID >
Application
Server >
WebLogic

InitialConfig
> Security
Provider >
SUN

Node ID >

Value

WebLogic

t3://localhost: 7001

The default value is
sun.security.provider.Sun. This value
typically does not need to be
changed.

The default value is

Description

The name of the
application server. If the
value is WebLogic, it
refers to the WebLogic
application server.

The Uniform Resource
Locator (URL) used by
the WebLogic
application server to
expose the J2EE Naming
service. This value is has
already been defined in
the application server
configuration.

Refers to the name of the
Java class, which is the
default security
encryption on the SUN
Java Virtual Machine.
This value is sufficient.

The Java class that
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Property Location Value Description
Name
Factory Application  weblogic.jndi.WLInitialContextFactory initiates a connection to
Server > .This value typically does not need to  the naming service of the
WebLogic be changed. application server.
Procedure

1. Configure the Server
a. Start the WebLogic application server.

b. Verify that an instance of WebLogic is running by logging into the admin
console (use the user name and password you provided during domain
creation)

2. Set up Timeout Seconds
a. Go to Domain > Configuration > JTA tab.
b. Set the Timeout Seconds to 36000.
c. Click Save.

3. Enable the Archived Real Path to dynamically deploy the resource files of a
customized page that is built using Ul Builder and to improve the page loading
performance.

a. Go to Domain > Configuration > Web Application.
b. Select the Archived Real Path Enabled check box.
c. Click Save.

4. Set up JDBC Drivers for Oracle - WebLogic

a. In the left pane, expand Services > > Data Sources. The Summary of JDBC
Data Sources page is displayed.

b. In the Data Sources section, click the New button to create a new data source.
The following three options are displayed: Generic Data Source, GridLink Data
Source, and Multi Data Source.

c. Select the Generic Data Source option.
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d.

m.

In the Name field, specify a name for the JDBC Data Source.
o Note: The name and JNDI name should be eCMDataSource.

Select Database Type as Oracle.
Click Next. The Create a New JDBC Data Source page is displayed.

Select Oracle’s Driver (Thin) for Service Connections; Versions: Any from the
Database Driver drop-down list.

Click Next. Click Next on the following page.

Create a New JDBC Data Source
Back| |Next ‘ Finish ‘Cam:el

Transaction Options
“fou have selected non-XA JDBC driver o create database connection in your new data source.

Does this data source support global transactions? f yes, please choose the transaction protocol for this data source.
¥/ Supports Global Transactions
Select this option if you want to enable non-XA JDBC connections from the data source to participate in global transactions using the Logging Last Resource (LLR) transaction optimization. Recommended in place of Emulate Two-Phase Commit
Logging Last Resource
Select this option if you want to enable non-XA JDBC connections from the data source to emulate participation in global transactions using JTA. Select this option only if yaur application can tolerate heuristic conditions.
Emulate Two-Phase Commit
Select this option if you want to enable non-XA JDBC connections from the data source to participate in global transactions using the one-phase commit ransaction processing. With this option, no other resources can participate in the global transaction

@ One-Phase Commit

Back| |Next ‘ Finish ‘Cancel

Enter the details in the Database Name, Host Name, Port, Database User
Name, Password and Confirm Password fields. Note that the Database Name =
SID.

Click Next.
Click Test Configuration.

Click Next. You are prompted to select targets to deploy your new JDBC data
source.

Select the Server and click Finish.

5. Configure the Connection Pool

a.

In the left pane, click Services > > Data Sources > > eCMDataSource.
The Settings for eCMDataSource page is displayed.

Click the Connection pool tab.

Expand Advanced at the bottom of the page.
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d. Select the Test Connections on Reserve check box.
e. Specify 7200 in the Inactive Connection Timeout field.

f. Specify 10 in the Maximum Waiting for Connection field.
o Note: Maximum Capacity for connection settings is 100.

g. Select the Ignore In-Use Connections and Remove Infected Connections
Enabled check boxes.

h. Click Save. The connection pool configuration for the eCMDataSource is saved.

i. Copy the following files from %TIBEMSDIR%\1ib to %BEA_HOME%\user_
projects\domains\domain name\1lib and $MQ_HOME/lib/external

tibjms.jar

6. Modify the startWeblLogic.cmd or startWebLogic.sh file.
a. Ensure that the WebLogic Application Server is running.

b. Edit the startWebLogic.sh or startWeblLogic.cmd file located under $BEA_
HOME /user_projects/domains/domain_name/bin to add the following lines in
the # START WEBLOGIC section:

o Note: If you are using Windows operating system, replace $ with
%stext% in the following example:

java ${JAVA_VM} S{MEM_ARGS} ${JAVA_OPTIONS}
-Dweblogic.Name=${SERVER_NAME}
-Dweblogic.management.username=${WLS_USER}
-Dweblogic.management.password=${WLS_PW}
-Dweblogic.ProductionModeEnabled=${STARTMODE}
-DMQ_HOME=${MQ_HOME}
-DMQ_CONFIG_FILE="${MQ_HOME}/config/ConfigValues.xml"
-DMQ_COMMON_DIR=${MQ_COMMON_DIR}
-DORACLE_HOME=${ORACLE_HOME}
-DNODE_ID=Memberl

-DMQ_LOG=${MQ_LOG}
~-DTNS_ADMIN=${ORACLE_HOME}/network/admin
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-DPATH=${MQ_HOME}/bin:S${WL_HOME}/server/bin:${WL_

HOME} /common/bin:${ORACLE_HOME}/bin: /usr/bin
-Djava.security.policy="${WL_HOME}/server/lib/weblogic.policy"
weblogic.Server

o Note:

« To deploy the Configurator in WebLogic, set the following
parameter: -Dcatalina.home=${MQ_LOG}

« To deploy the TIBCO MDM custom pages to a common folder

in the cluster environment, set the following parameter: set
MQ_CUSTOMFORMS_HOME= MQ_COMMON_DIR

» Add the following environment variable in the WebLogic
startup section:-DMQ_CUSTOMFORMS_HOME=MQ_COMMON_DIR

a. Optional: To improve the TIBCO MDM performance, add the following JVM
parameter while starting the application server:

Dorg.apache.xml.dtm.DTMManager="org.apache.xml.dtm.ref.DTMManag
erDefault"

b. To monitor application server JVM, add the following JVM arguments:

-Dcom.sun.management.jmxremote.authenticate=false
-Dcom.sun.management.jmxremote.ssl=false
-Dcom.sun.management.jmxremote.port=9999

c. Set up TIBEMSDIR=path environment variable for EMS installation. For example:
set TIBEMSDIR=C:\Tibco\emsversion\ems\version

d. The CLASSPATH set in the WebLogic startup script must include the location of
the JAR files. Include the following JAR files in the CLASSPATH variable.

e Windows:

%TIBEMSDIR%\lib\tibjms.jar ;%¥TIBEMSDIR%\lib\tibjmsapps.jar ;%TIBEM
SDIR%\lib\tibrvjms.jar ;%TIBEMSDIR%\lib\tibjmsadmin.jar ;%MQ_
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HOME%\ Lib\external\xbean.jar ;%MQ_HOME%\lib\external\log4j-
1.2.17.jar;%MQ_HOME%\lib\external\commons-logging-1.2.jar ;%MQ_
HOME%\ lib\external\gwt-user.jar%MQ_HOME¥%\lib\external\dom4j-
1.6.1.jar;%MQ_HOME%\lib\external\hibernate\hibernate3.jar ;%MQ_
HOME%\ lib\external\javassist-3.12.0.GA.jar ;%MQ_

HOME%\ Llib\external\slf4j-api-1.7.16.jar ;%MQ_

HOME%\ Lib\external\stickyConfiguration.jar

o UNIX:

STIBEMSDIR/lib/tibjms.jar:STIBEMSDIR/lib/tibjmsapps.jar:$TIBEMSD
IR/lib/tibrvjms.jar:$STIBEMSDIR/lib/tibjmsadmin.jar:SMQ_
HOME/lib/external/xbean.jar:
$MQ_HOME/lib/external/log4j-1.2.17.jar:$MQ_
HOME/lib/external/commons-logging-1.2.jar:$MQ_
HOME/lib/external/gwt-user.jar$MQ_HOME/lib/external/dom4j-
1.6.1.jar:SMQ_HOME/lib/external/hibernate/hibernate3.jar:$MQ_
HOME/lib/external/javassist-3.12.0.GA.jar:$MQ_
HOME/lib/external/slf4j-api-1.7.16.jar:$MQ_
HOME/lib/external/stickyConfiguration.jar:$CLASSPATH

Deploying TIBCO MDM on WebLogic Application Server

After configuring TIBCO MDM with WebLogic Application Server, deploy TIBCO MDM.

Procedure

1

N 0 AW

Type the following command:

$ ./ startWeblLogic.sh or startWeblLogic.cmd located under $BEA_HOME/user_
projects/domains/domain_name/bin

Launch the WebLogic Server Console (for example: http://localhost:7001/console)
Log in to the Console.

In the left pane, click Deployments.

Click Install under Deployments on the Control tab.

Browse to the location of the ECM.ear file.

Select ECM.ear and click Next.
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8. Choose targeting style as Install this deployment as an application.
9. Click Next.
10. Click Finish.

A success message is displayed.

o Note:

« Ensure that you click Activate Changes on the left to activate all
your changes (not applicable in case of WebLogic 10.3). Under
Deployments, select the application and click Start and select
Servicing all requests option.

« You can also verify if the application is installed successfully using
the following URL: http://IP address:7001/eml/Login. The port for
the WebLogic Application Server is 7001.

Setting Up SSL for WebLogic Application Server

SSL needs to be setup to access the application through a browser over the HTTPS
protocol.

Procedure
1. Login to the WebLogic Server Console.

Go to Environment > Servers > server name from the navigation tree in the left pane.
Select the General tab.

Select the SSL Listen Port Enabled check box.

o A W BN

Specify the port number (SSL Listen Port) where the SSL port will be listening. The
default port number is 7002.

6. Clear the Listen Port Enabled check box (to disable the HTTP protocol).

7. Select the Keystores and SSL tabs and ensure that you are using the default
settings.

8. Log out of the console and restart the server.
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Result

You also need to change the JNDI Provider URL to Https://localhost:port using the
Configurator. For more information, see Oracle documentation.

Troubleshooting with WebLogic Application Server

Resolve the errors that you may come across while working with the WebLogic Application

Server.

Troubleshooting with WebLogic Application Server

Issue

Login Page
is Not
Shown
After
Installation

404 Page
Not Found

Garbage
Collection
Data is Not
Available
for Analysis

Description

The Login Page is
not shown and
error.log shows an
error.

You get the 404
Page Not Found
error when using
the Apache 2.0
Plug-in for the
WebLogic Server.

If you are
experiencing
performance
issues, TIBCO
Customer Support
may request for
garbage collection
statistics.

Solution

Check for the JDBC driver. It should be
oracle.jdbc.driver.OracleDriver.

Specify $AS_HOME/bin and $AS_HOME/lib in the
classpath.

Check PathTrim property within weblogic.conf. It has to
be null, otherwise it will trim the /eml part from the URL.

Check the httpd.conf file for the <IfModule mod_
weblogic.c> section. The path given within the include
statement for weblogic.conf is relative to the Apache20
directory.

To enable garbage collection data collection, change the
JVM settings as follows:

Servers > Application Server > serverl > Process
Definition > Java Virtual Machine.Select the Verbose
garbage collection check box against it.

The garbage collection data is stored in $WAS_
HOME /profiles/<profilename>/logs/serverl/native_
stderr.log

TIBCO® MDM Installation and Configuration Guide



175 | Configuration of Web Servers

Configuration of Web Servers

You can choose to use Microsoft IIS, Apache, or IBM HTTP web server.

For instructions on how to setup other web servers, see the documentation provided by
web server vendors.

Configuring IBM HTTP Web Server with WebSphere

Install the web server, if not already present. You can configure IBM HTTP server for
WebSphere Application Server.

For WebSphere Application Server, the plug-in file is at SWAS_HOME /config/cells/plugin-
cfg.xml.

Procedure
1. Copy the plugin file (plugin-cfg.xml) to any location on the computer where the web
server is installed and specify its path in the httpd.conf file with an
entry:<wWebSpherePluginConfig /path/plugin-cfg.xml. You need read write
permissions to modify this configuration file.

2. Configure access for the web server to the plugin library specified by LoadModule
ibm_app_server_http_module.

For details about configuring web servers, see the WebSphere Information Center
online documentation.
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Note: If for security reasons, you need to prevent server information
(such as, Web Server and Application Server versions) from being
transmitted in the header file, perform the following steps:

a. Edit the httpd.conf file in the Web Server conf directory. For
example,

In the /opt/IBMHttpServer/conf/httpd.conf file add the following
line:

ServerTokens Prod

b. Restart the web server and application server.

Configuring Apache Web Server Plug-in with WebLogic

You can configure Apache plug-in configuration for WebLogic Application Server.

Procedure
1. Copy the mod_wl_version.so file to the SAPACHE_HOME /modules folder.

2. Modify the httpd.conf file located in the SAPACHE_HOME/conf directory. You need
read write permission to modify this configuration file.

a. Search for Dynamic Shared Object (DSO) Support within Httpd.conf and
append the listing with:

LoadModule weblogic_module modules/mod_wl_version.so

b. Search for Bring in additional module-specific configurations within
Httpd.conf and add the following lines:

<IfModule mod_weblogic.c>
Include conf/weblogic.conf
</IfModule>

c. Search for server-info within httpd.conf and add:
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<Location /eml>
SetHandler weblogic-handler</Location>
3. Create a weblogic.conf file in the SAPACHE_HOME/conf directory.

4. Add the following properties to the weblogic.conf file. Maintain a single space
between a property name and property value:

WebLogicHost weblogic-host-name
WebLogicPort weblogic-port
PathTrim null

Testing Apache Web Server Plug-in

After you configure Apache plug-in for WebLogic Application Server, you can test for
verification purposes.

Procedure
1. Start the WebLogic application server.

2. Start the Apache web server.

3. Enter the URL as http://apache.server.com/em|/Home

The login page is displayed.
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Apache Ignite

Apache Ignite is a high-performance, integrated and distributed in-memory platform for
computing and transacting on large-scale data sets in real-time.

The performance of TIBCO MDM highly depends on the distributed cache. Apache Ignite
meets various cache requirements of TIBCO MDM and can be used as the caching option.

Apache Ignite as a collection of independent, well-integrated, in-memory components
improves the performance and scalability of an application. TIBCO MDM uses core caching
data-grid module of Apache Ignite with advanced indexing and SQL capability.

For more information about Apache Ignite, see Apache Ignite documentation.

Enable Apache Ignite for TIBCO MDM

Enable the usage of Apache Ignite as distributed cache for TIBCO MDM using the following
steps:

« Select Ignite for the Cache Type (com.tibco.cim.cache.type) property in the
Configurator. Other optional configuration properties are listed in the Configuration
Properties of Apache Ignite section.

o Specify JVM parameters listed in the JVM Arguments for Apache Ignite section.

o Use IgniteMember.xml to configure the cache server topology. The default
configuration restricts the single node topology. For more details about configuring
the multinode topology, see Configuring Cache and Cluster Topology for Apache
Ignite.
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Configuration Properties of Apache Ignite

The following table lists the properties of Apache Ignite specified in the Configurator:

Property Name
Cache Type ( com.tibco.cim.cache.type)

Ignite members configuration
(com.tibco.mdm.ignite.config.filename)

Ignite Log Logging Level Default
(log4j.logger.org.apache.ignite)

Ignite Log File Name Default
(log4j . appender . ignitelogdefault.File)

Ignite Log Maximum File Size Default

(log4j .appender.ignitelogdefault.MaxFileSize)

Ignite Log File Backup Count Default

(Log4j .appender.ignitelogdefault.MaxBackupIndex)

Ignite Log Layout Pattern Default (

log4j.appender.ignitelogdefault.layout.ConversionPattern

)

Ignite Log Appender (log4j.appender.ignitelogdefault)

Ignite Log Entry Layout
(Llog4j .appender.ignitelogdefault. layout)

Ignite Log Appender Encoding

(Log4]j .appender.ignitelogdefault.encoding)

Ignite Log Logging Level Threshold Default

(Llog4j .appender.ignitelogdefault.Threshold)

Location

Cluster level (InitialConfig > Optimization)
Cluster level (InitialConfig > Optimization)
Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)
Node level (Memberl > Logging > Default

Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Node level (Memberl > Logging > Default
Ignite Log)

Value
The default value is Ignite.

The default value is IgniteMember.xml.

The default value is INFO,ignitelogdefault.

The default value is ${MQ_LOG}/ignite.log.

The default value is 5MB.

The default value is 40.

The default value is %d,[%t],%m%n.

The default value is
org.apache.log4j.RollingFileAppender.

The default value is
org.apache.log4j.PatternLayout.

The default value is UTF-8.

The valid values are FATAL, ERROR, WARN,
INFO, and DEBUG. The default value is INFO.

Description
Type of cache used in TIBCO MDM.

Apache Ignite cache cluster configuration file

name, relative to $MQ_CONFIG

Logging level for the ignite log

Path and name of the log file

Maximum size of the ignite log file

Number of the ignite log backup files

Pattern of an entry in the ignite log file

Appender used for the ignite log

Layout of the ignite log entries

Encoding used for the appender of the ignite

log

Logging level threshold for ignite logging
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JVM Arguments for Apache Ignite

Specify the JVM parameters of the application server that is used to deploy TIBCO MDM.

JVM Value

Arguments

IGNITE_ 100

ATOMIC_

CACHE_

DELETE_

HISTORY_

SIZE

IGNITE_ The valid

UPDATE_ values are

NOTIFIER
true or
false. The
default
value is
true.

Description

Apache Ignite per cache delete history queue size. This queue
handles the case where the same key is being inserted and
deleted at the same time. For TIBCO MDM, 100 size is sufficient. If
you do not set this parameter, the Out-Of-Memory error message
is shown at the server startup.

When Apache Ignite is initialized, the new version check is
automatically done, System.out. You can disable this version
notification by setting the IGNITE_UPDATE_NOTIFIER property to
false.

Configuring Cache and Cluster Topology for Apache Ignite

By default, the cluster topology configuration is specified in the IgniteMember.xml file

located at $MQ_HOME/config.

o Cache configuration: The cache configuration is defined in the CacheConfig.xml file.
By default, TIBCO MDM configures all caches to ATOMIC, OFF-HEAP, and SWAP

disabled.

o Cluster topology configuration: TIBCO MDM supports the following two cluster
topologies. You can configure both of them with Apache Ignite.

Note: By default, IgniteMember.xml configuration restricts a single node cache
topology by using the localHost=127.0.0.1 property. To configure multinode
distributed cache, remove the localHost property.
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Procedure
1. Navigate to the $MQ_HOME/config folder.

2. Open the IgniteMember.xml file.

The following table explains various properties defined in the IgniteMember.xml file.

Property Name Description Default
Value

Cache Configuration

clientMode Defines the role of a false
node. For centralized
cache server
architecture, Apache
Ignite can be started as
a standalone process
and TIBCO MDM
connects to Apache
Ignite cluster as a
client node. To run
TIBCO MDM in client
mode, set clientMode
to true. Client node
cannot hold data in the

caches.
peerClassLoadingEnab |f false
led peerClassLoadingEna

bled is set to true, you
do not have to
manually deploy your
Java code on each
node in the grid and re-
deploy it each time it
changes. For
performance reasons,
the property is set to
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Property Name Description Default
Value
false.
gridName Defines a name to MDMNODE

Apache Ignite instance.
It helps when multiple
instances needed
within same JVM.

localHost Gets system-wide local ~ 127.0.0.1
address or host for all
components of Apache
Ignite to bind to. If
defined, it overrides all
default local bind
settings within Apache
Ignite or any of its SPIs.
If null, then Apache
Ignite tries to use the
local wildcard address.
That means all services
are available on all
network interfaces of
the host machine.

Note: For cluster
setup, you need to
remove this
property.

metricsLogFrequency Metrics print frequency 60000 (every minute)
in Millisecond. The zero
value indicates that no
print is required. If the
value is greater than
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Property Name

Cluster Topology
Configuration

ipFinder

localAddress

localPort

Description

zero and the log is not
quiet, then statistics
are printed with INFO
level once a period.

IP finder that shares
information about the
IP addresses of nodes.
Nodes can discover
each other by using
DiscoverySpi. Apache
Ignite provides
TcpDiscoverySpi as a
default implementation
of DiscoverySpi that
uses TCP/IP for node
discovery. You can
configure
DiscoverySpi for
multicast and Static IP
based node discovery.

Sets the local host IP
address that
DiscoverySpi uses

Port the DiscoverySpi
listens to

Default
Value

The default value is
TcpDiscoveryMulticastIpFinde

r.

You can specify the static IP
based discovery implementation.

If not provided, by default a first
found non-loopback address is
used. If there is no non-loopback

address available, then
java.net.InetAddress.getloca

1Host () is used.

47500
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Property Name

localPortRange

heartbeatFrequency

maxMissedHeartbeats

reconnectCount

networkTimeout

socketTimeout

Description

Local port range. Local
node tries to bind on
the first available port
starting from local port
until local port plus
local port range

Delay in milliseconds
between heartbeat
issuing of heartbeat
messages. SPI sends
messages in
configurable time
interval to other nodes
to notify them about its
state.

Number of heartbeat
requests that could be
missed before local
node initiates status
check.

Number of times node
tries to (re)establish
connection to another
node.

Sets maximum network
timeout in milliseconds
to use for network
operations.

Sets socket operations

Default
Value

100

2000

5000

2000
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Property Name

ackTimeout

joinTimeout

threadPriority

Description

timeout. This timeout
limits the connection
time and write-to-
socket time.

Sets timeout for
receiving
acknowledgment for
sent message. If
acknowledgment is not
received within this
timeout, sending is
considered as failed
and SPI tries to repeat
message sending.

Sets join timeout. If
non-shared IP finder is
used and node fails to
connect to any address
from IP finder, node
keeps trying to join
within this timeout. If
all addresses are still
unresponsive, an
exception is thrown
and the node startup
fails. The zero (0) value
indicates that wait
forever.

Thread priority for
threads started by SPI.

Default
Value

2000
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Property Name Description Default
Value
Statistics print 0

statisticsPrintFrequ
ency

frequency in
milliseconds. The zero
(0) value indicates that
no print is required. If
the value is greater
than zero (0) and the
log is not quiet, then
statistics are printed
with INFO level once a
period. This might be
helpful for tracing the
topology problems.

Example: Multicast based Discovery

TcpDiscoveryMulticastIpFinder uses multicast to discover other nodes with the same
multicastGroup in the grid and is the default IP finder.

<bean class="org.apache.ignite.configuration.IgniteConfiguration">

<property name="discoverySpi'">
<bean class="org.apache.ignite.spi.discovery.tcp.TcpDiscoverySpi'">
<property name="ipFinder'">
<bean
class="org.apache.ignite.spi.discovery.tcp.ipfinder.multicast.TcpDiscover
yMulticastIpFinder">
<property name="multicastGroup" value="228.10.10.157"/>
</bean>
</property>
</bean>
</property>
</bean>

Example: Static IP based Discovery

For cases when multicast is disabled, use TcpDiscoveryVmIpFinder with pre-configured
list of IP addresses.
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<bean class="org.apache.ignite.configuration.IgniteConfiguration">

<property name="discoverySpi'">
<bean class="org.apache.ignite.spi.discovery.tcp.TcpDiscoverySpi'">
<property name="dipFinder">
<bean
class="org.apache.ignite.spi.discovery.tcp.ipfinder.vm.TcpDiscoveryVmIpFi
nder'">
<property name="addresses">
<list>
<I-=
Explicitly specifying address of a local node to let it start and
operate normally even if there is no more nodes in the cluster.You can
also optionally specify an individual port or port range.
-=>
<value>1.2.3.4</value>

K==
IP Address and optional port range of a remote node. You
can also optionally specify an dindividual port and don't set the port
range at all.
-=>
<value>1.2.3.5:47500..47509</value>
</list>
</property>
</bean>
</property>
</bean>
</property>
</bean>

Example: Multicast and Static IP based Discovery

You can use both, multicast and static IP based discovery together. In this case, in addition
to addresses received through multicast, if any, TcpDiscoveryMulticastIpFinder can also
work with a pre-configured list of static IP addresses, similar to static IP based discovery.

<bean class="org.apache.ignite.configuration.IgniteConfiguration">

<property name="discoverySpi'">
<bean class="org.apache.ignite.spi.discovery.tcp.TcpDiscoverySpi'">
<property name="1ipFinder">
<bean
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class="org.apache.ignite.spi.discovery.tcp.ipfinder.multicast.TcpDiscover
yMulticastIpFinder">
<property name="multicastGroup" value="228.10.10.157"/>

<!-- 1list of static IP addresses—->
<property name="addresses">
<list>

<value>1.2.3.4</value>

K==
IP Address and optional port range.
You can also optionally specify an individual port.
-->
<value>1.2.3.5:47500..47509</value>
</list>
</property>
</bean>
</property>
</bean>
</property>
</bean>

Monitor Apache Ignite

When TIBCO MDM starts, Apache Ignite is initialized. You can monitor it on the application
server console. It also shows the current snapshot of cache topology.

[14:21:46]
[14:21:46] / _/ ___/ |/ [/ _/- __| __/

[14:21:46] _/ // (7 7 /17 1]/

[14:21:46] /___/\___/_/|1_/___/ /_] [___/

[14:21:46]

[14:21:46] ver. 1.9.0#20170302-shal:a8169d0a

[14:21:46] 2017 Copyright(C) Apache Software Foundation

[14:21:46]

[14:21:46] Ignite documentation: http://ignite.apache.org

[14:21:46]

[14:21:46] Quiet mode.

[14:21:46] N-— To see **xFULL*x console log here add -DIGNITE_QUIET=false
or "-v" to 1ignite.{sh|bat}

[14:21:46]

[14:21:46] 0S: Windows Server 2008 R2 6.1 amde4

[14:21:46] VM information: Java(TM) SE Runtime Environment 1.8.0_112-bl5
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Oracle Corporation Java HotSpot(TM) 64-Bit Server VM 25.112-bl5
[14:21:46] Configured plugins:

[14:21:46] A—— None

[14:21:46]

[14:21:46] Message queue limit is set to 0 which may lead to potential
OOMEs when running cache operations in FULL_ASYNC or PRIMARY_SYNC modes
due to message queues growth on sender and receiver sides.

[14:21:46] Security status [authentication=off, tls/ssl=off]

[14:22:09] Performance suggestions for grid 'MDMNODE' (fix if possible)
[14:22:09] To disable, set -DIGNITE_PERFORMANCE_SUGGESTIONS_DISABLED=true
[14:22:09] N-- Enable Gl Garbage Collector (add '-XX:+UseG1lGC' to JVM
options)

[14:22:09] N—- Set max direct memory size if getting 'OOME: Direct
buffer memory' (add '-XX:MaxDirectMemorySize=<size>[g|G|m|M|k|K]' to JVM
options)

[14:22:09] N-- Disable processing of calls to System.gc() (add '-
XX:+DisableExplicitGC' to JVM options)

[14:22:09] See this page for more performance suggestions:
https://apacheignite.readme.io/docs/jvm-and-system-tuning

[14:22:09]

[14:22:09] To start Console Management & Monitoring run -ignitevisorcmd.
{sh|bat}

[14:22:09]

[14:22:09] Ignite node started OK (id=5da32f64, grid=MDMNODE)
[14:22:09] Topology snapshot [ver=1, servers=1, clients=0, CPUs=2,
heap=2.0GB]

You can monitor Apache Ignite by using the following ways:

o JMX: JMX cache MBean of TIBCO MDM can be used to monitor various cache metrics
and operations. Additionally, Apache Ignite has its own JMX, the default port is
49112. By default, Apache Ignite based statistics for each cache are disabled for
performance reasons.

e Using Visor Command Line Interface: Apache Ignite provides a command line
interface called Visor for monitoring.

o Logging: TIBCO MDM generates a separate file for the Apache Ignite log.

o REST API: Apache Ignite supports REST API and the same has been integrated with
TIBCO MDM. It can be used to perform different operations, such as, read or write
cache (from or to), execute tasks, get various metrics, and so on.
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Logging

A new log configuration category, the Default Ignite Logis added in Configuration
Properties of Apache Ignite. A separate rolling log file, ignite.log has been configured
with the default logging level to INFO.

By default, the following information is displayed at the INFO level:

« lIgnite initialization log: shows the version of Apache Ignite, all different cache
initialization, and cluster and topology change with the nodes add and remove. To
know the topology, see the following line, which is displayed in the log at the TIBCO
MDM startup:

Topology snapshot [ver=1l, servers=1, clients=0, CPUs=8, heap=2.0GB]

o Periodic node metric with metricsLogFrequency: monitor node load with CPU and
memory utilization metrics

« Periodic topology metric with ipFinder and statisticsPrintFrequency:
monitor any change in topology

Using Visor Command Line Interface

Apache Ignite supports scriptable command line monitoring capability, which is called
Visor. By using Visor, you can get statistics about nodes, caches, and tasks in the grid and
view the details about the topology showing various metrics and node configuration
properties. Additionally, you can start and stop the remote nodes.

Procedure
1. On the command line, type $MQ_HOME/bin/ignite/bin/ignitevisorcmd.sh or %MQ_
HOME%\bin\ignite\bin\ignitevisorcmd.bat.

The command line interface is started and IGNITE_HOME is automatically set to $MQ_
HOME/bin/ignite.

2. To connect Visor to the grid, type visor> open -cpath=sMQ_
HOME/config/IgniteMember.xml

The IgniteMember.xml file is the cluster topology configuration file used with TIBCO
MDM.
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3. Type help cmd or ? cmd to retrieve a complete list of commands.

For the commonly used commands, see Visor Commands.

Visor Commands

Visor CommandsThe following are commonly used commands available in Visor:

Command
ack
alert
cache
close
config
deploy
disco
events
gc
help
kill

log
mclear
mget

mlist

Description

Acknowledges arguments on all remote nodes
Alerts for user-defined events

Prints cache statistics, clears cache, and prints a list of all entries from cache
Disconnects Visor console from the grid

Prints node configuration

Copies file or folder to remote host

Prints topology change log

Print events from a node

Runs GC on remote nodes

Prints Visor console help

Kills or restarts node

Starts or stops grid-wide events logging
Clears Visor console memory variables

Gets Visor console memory variables

Prints Visor console memory variables
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Command Description

node Prints node statistics

open Connects Visor console to the grid

ping Pings node

quit Quits from Visor console

start Starts or restarts nodes on remote hosts
status Prints Visor console status

tasks Prints tasks execution statistics

top Prints current topology

vvm Opens VisualVM for nodes in topology

Tracing and Controlling the Cache

When the application is configured to run in the debug mode, the cache subsystem
generates a large number of debug messages. This causes the logs to fill up quickly.
Suppress the debug messages generated from the cache subsystem.

Procedure
1. Log in to the Configurator.

2. Select Node ID > System Debugging.

3. Search for the Cache Debug Mode property to enable or disable the cache tracing.
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Configuration and Setup For Member1 - System Debugging

Add New Property Q |i|
5 ] Pt Since
roperty alue escription Version
Cache Debug Mode false This property enables a detailed trace fo be 82

generated for Cache. Used for debugging
caching issues. This value should only be
enabled if requested by TIBCO support

Database Debug Mode frue This property enables a frace fo be generated for 9.0
database interactions. Used for debugging of

Security Check Debug Mode false This property enables a detailed frace to be 82
generated for security check. Used for

Login Information Collection for - Ul false This property enables a detailed information 83

about active users and login attempts to be

By default, the value is false, which indicates that debug messages are not
generated. To enable the cache tracing, specify the true value.

Memory Calculation for Cache

When calculating memory for cache consider the following scenarios:
o Memory available for Local and Near caches = heap storage Assume, it is A.

o Memory available for Near and Distributed caches = Memory - heap storage Assume,
itis B.

In these scenarios, the memory assigned to any cache is calculated as follows:

o If the Limit is specified, the ListSize is ignored. Limit is the whole number and
a percent. The minimum value is 1 and the maximum value is 99. However, a
fraction is also supported with a single digit. The minimum value is 0.1 and the
maximum value is 99.9.

[(Limit/100) * B]/ObjectSize = Capacity
In this case, the capacity is a number of objects available in a cache.

o If the Limit and ListSize are not specified, the memory for Local cache is set to
default 100 value. For Distributed cache, no default value is set.

1. Capacity = List Size, if specified.

2. For the Distributed cache, if ListSize is not specified,
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Count all distributed caches, which do not have ListSize or Limit. For example,
N

Assign memory to all those caches, which have ListSize or Limit. For example,
C

Remaining memory = B - C= D

Available memory for one cache = E = D/N
Capacity = E/ObjectSize.
o Memory consumed by each cache = capacity * ObjectSize.

If the ListSize is specified as -1 and the Limit is not specified, this indicates the unlimited
cache. Such caches are excluded from the memory computation and they have no limit.

If the object sizes are not correct, the actual memory allocation may be different from the
total assigned memory allocation.

o Note: It is recommended to:
« Allocate 20% more than the actual memory.

o If the allocated heap size within the range tolerance of 5MB, a
warning is displayed. However, if the tolerance exceeds, an error is
displayed.

o If the distributed cache size exceeds the tolerance of 20MB, a
warning is displayed. However, if the tolerance exceeds, an error is
displayed.

To rectify the error that occurs when the allocated memory exceeds
the specified memory, fix the allocation. If it does not resolve the
error, specify the true value for Cache Memory Check property in the
Configurator. By default, the value is false.

o Specify the ratio between ProductKey to Record as 1: 3.3 and ProductKey
to RecordMaxModVersion as 1:2.3.

o Set unlimited size for RECORD, RECORDMAXMODVERSION, and
PRODUCTKEY for large installations.
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View Memory Allocation

To view the memory allocation, verify the startup log in the elink.log file.
o Memory Allocation Count

The following log indicates the Server configuration. You can identify the allocated
memory count.

2013-01-24 10:37:34,839 [MSC service thread 1-10] DEBUG
com.tibco.mdm.infrastructure.cache.as.CacheConfigParser - Server
configuration: {Name=Dev configuration, CharSet=true, Memory=512,
ReplicationCount=0, HeapStorage=50, OverHead=1.3,

o Total Memory Allocation

The following example indicates whether or not all of the heap storage memory is used.

2013-01-24 10:37:34,891 [MSC service thread 1-10] INFO
com.tibco.mdm.infrastructure.cache.as.CacheSizeUtility - Distributed and
near caches: Available Memory (MB) = 462.0 Allocated Memory (MB)
=462.8532301477959

To know whether allocated memory is sufficient or not, check the hit ratios in the Cache
MBeans using JConsole. For more information aboutCache MBeans, see Appendix B TIBCO
MDM Management Using JMX in TIBCO MDM System Administration guide.

Object Size Calculation for Cache

Calculate the object size for cache with this method.
The ObjectSize is calculated as follows:

o If <CharSet> is single byte, check if the <SingleByteObjectSize> is specified. If not
specified, the default 100 value is considered.

o If <CharSet> is multibyte, check if <MultiByteObjectSize> is specified. If not
specified, the default 200 value is considered.

o For distributed caches, ObjectSize = ObjectSize * overhead factor

A sum of all percent limits for Distributed and Near caches must be 100 or a sum of
all percent limits for Local and Near caches must be 100 or less.
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Repository Spaces for Sharing Cached Data

Use Repository Spaces to share the cached data with external applications. TIBCO MDM
caches the record data in the distributed cache.

Using Repository Spaces, you can:
o Cache records as a table and not as a BLOB.

o Cache relationship attribute records.

« Create a repository space for each repository. For more information, see Repository
Spaces - An Overview.

« Maintain data in the cache even if the record is updated.

Repository Spaces - An Overview

The repository space is the information of a repository stored in Apache Ignite. A
repository space is created when TIBCO MDM starts. However, the space is created after

the repository is confirmed.

All existing repositories are searched, and the spaces are created. The repository space is
optimized for a cluster so that every member of the cluster does not attempt to create the

space.
The following list describes the relationship between the repository and its space:

« If you delete a repository, the space is not deleted. It remains as is until the TIBCO
MDM server restarts.

« If you add an attribute in the repository, a new column is created in the space
according to the data type of the attribute and database column name. The default
value of the column is null. The records that were created before adding the
attribute contain null value in the column.

« If you delete an attribute from the repository, the attribute is not deleted from the
space. It maintains null value for the incoming records. However, after restarting
TIBCO MDM, the deleted attribute is not created in the space.

o As each record is stored in its own repository space, object type= RECORD_
RepositorylD is mapped to the repository space. The mapping is performed as
RECORD_Repository Table name.
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Repository Spaces Configuration

By default, false is specified for the Enable repository spaces property in the Configurator
(Initial Config > Optimization). Specifying false does not create the repository spaces.
Select true to enable caching of the records in repository spaces.

Warning: If you enable the repository spaces, the list size of the cache might not
be sufficient and an error is displayed at the server start-up. To avoid the error,
specify the ListSize = -1 in the CacheConfig.xml file.

When you perform record operations in TIBCO MDM, specify true for the Cache Debug
Mode property in the Configurator. You can confirm whether the data is retrieved through
the cache or through the database, and verify the logs. For more information, see Tracing
and Controlling the Cache.
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Multivalue and Category Specific Attributes

For each multi-value and category specific attributes, individual fields are created in repository spaces with their database column name.

o The multi-value attribute field is created as the string data type and its values are stored as a delimiter separated string.

« The category specific attribute field is created with the same type that is stored in the database.

The following configuration properties for multi-value and category specific attributes are created in the Configurator:

Configuration Properties for Multi-value and Category Specific Attributes

Property Name propname Description Value
Indicates the average number of values to be specified in a Any valid integer.
Average number of values 1in a com.tibco.cim.cache.multivalue.avaerage.values.perattr . ! . verag . ! vatu . P I_I ! y vatid integ
single multivalue attribute ibute single multi-value attribute when repository space is The default value is 2
enabled. )
o . . . e . . Refers to the category specific attribute size to be used for Any valid integer.
category specific attribute com.tibco.cim.cache.categoryspecific.attribute.size it - lculati The size i ified i
size (bytes) repository space size calculation. The size is specified in .
bytes. The default value is 10.
Refers to the multi-value qualifier specified in multi-value Any valid qualifier.

Cache multivalue qualifier com.tibco.cim.cache.multivalue.qualifier ] )
attribute values that is used for cache. .
The default is &quot;. It
signifies the double quotation

marks.

The existing Delimiter used while reading multi value data property is used while reading multi-values in Apache Ignite. The default value is !#.
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Object Size Calculation for Repository Spaces

An object refers to the row of a record included in the space. You can calculate the object
size of the repository space. Each repository space has a different object size based on its
attributes. Therefore, the object size calculation for each repository space is different.

For example, to calculate the object size of 10,000 records included in the Customer
repository. The object size of a record is calculated as follows:

Object Size = (Sum of all catalog attributes (excluding multivalue and
category specific attribute) data types lengths * (2 Or 3)) + (All
multivalue attributes size) + (All category specific attributes size)

To calculate the object size for a repository space, use the following formulas:

Object Size Calculation for Repository Spaces

Formula Usage
Sum of all repository attributes (excluding multivalue and category specific Retrieves
attribute) data types lengths = (attributel data type Length *2) + (attribute 2 single byte
data type length*2) + .........(attribute n length *2)] object size.
Sum of repository attributes’ data types length = [(attributel data type Length Retrieves
*3) + (attribute 2 data type length*3) + (attribute n length *3) multibyte
object size.

Note: If the attribute data type is String, Attribute length is multiplied by 2 or 3
bytes. Else, the attribute size is considered as its data type size. For example, for
the Integer data type it is considered as 4 bytes.

To calculate the actual object size, 1/3rd of the calculated object size is considered and
ROWOVERHEAD is added.

Actual object size of a repository = Object Size/3 + ROWOVERHEAD

The value of ROWOVERHEAD is configured in the <ServerConfig> section of the
CacheConfig.xml file. It is the sum of System Attributes Overhead, Apache Ignite overhead,
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and Reference keys overhead. For more information, see RowOverHead Attribute
Configuration.

ObjectSize Calculation for Multi-value and Category Specific
Attributes

Use these queries to calculate the ObjectSize of the multi-value and category specific
attributes.

Object Size Calculation for Multi-value and Category Specific Attributes

Query Usage

Retrieves multi-value attribute size. For

The string length of maximum
example,

value of the multi-value database
column type * Single Byte or
Multi Byte object size x average
number of entries in a multi-
value attributes

e If a column contains the Integer data
type, its maximum value is
2,147,483,647. The integers are
converted into string. Therefore, these

. are considered as 10 characters, and

In this way, eventually its size is considered as 10.

o If Single byte: Total size of multi-value
attribute = length of data type * 2 *

average number of values

« If a column contains the String data
type, its size is considered as Length of
the String defined in the database.

o If Multibyte byte: Total size of multi-
value attribute = length of data type * 3
* average number of values

For each category specific attribute, the size Retrieves category specific attribute size.
that is configured in the Configurator is used

for calculation. For information about the

property, see Configuration Properties for

Multi-value and Category Specific Attributes.

Total ObjectSize = Object Size calculated from Database for repository
space + the size of all multi-value attributes columns + category
specific attributes’ size
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RowOverHead Attribute Configuration

The RowOverHead attribute is added to the <ServerConfig> section of the
CacheConfig.xml file.

This is an additional overhead. The RowOverHead attribute is added to calculate the actual
object size of a repository. Each repository space record contains the RowOverHead. It is
the sum of the system attributes overhead, Apache Ignite overhead, and all reference keys
overhead.

Example

<ServerConfig>
<Name>Standard configuration</Name>
<CacheServerCount>1</CacheServerCount>
<CharSet>singlebyte</CharSet>
<Memory>2048</Memory>
<HeapStorage>300</HeapStorage>
<OverHead>1.3</0OverHead>
<ReplicationCount>0</ReplicationCount>
<RowOverHead>2170</RowOverHead>

</ServerConfig>

Configuring Custom Repository

You can manually configure a repository in the CacheConfig.xml file. The repository space
is created for the configured repository, and the configuration parameters are retrieved
from the CacheConfig.xml file instead from the RECORD cache.

For example, to configure the customer repository in the CacheConfig.xml file:

Procedure
1. Locate the table name for the Customer repository in the database.

2. Add the RECORD prefix to the repository table name and configure the repository in

the CacheConfig.xml file as follows:

<Cache>
<Name>RECORD_SCUSTOMER_TABLE_NAME</Name> <!-Mandatory -- >
<Description>This is a custom defined repository
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space</Description> <!-Optional -- >
<Type>distributed</Type> <!-Mandatory -- >
<SingleByteObjectSize></SingleByteObjectSize> <!-Mandatory -- >
<MultiByteObjectSize></MultiByteObjectSize> <!-Mandatory -- >

<ReplicationCount></ReplicationCount> <!-Optional -- >
<Limit></Limit> <!-Optional -- >
<ExpirationTime></ExpirationTime> <!-Optional -- >
<EvictionPolicy></EvictionPolicy> <!-Optional -- >
<LockWaitTime></LockWaitTime> <!-Optional -- >
<LockExpirationTime></LockExpirationTime> <!-Optional -- >
</Cache>

3. Save the CacheConfig.xml file.

Validation Errors for Repository Spaces

When you deploy repository metadata in TIBCO MDM Studio, the repository space is
validated for its table name. The validation error messages are displayed in the Repository
Model Validation dialog box.

« If a repository space exists with the specified table name, the following validation
error is displayed:

CACHE-7561: Repository space '$SREPOSITORY_SPACE_NAME' already exists.
Specify the unique name.

« If the table name contains special characters or an invalid name, the following
validation error is displayed:

CACHE-7562: Invalid repository space name 'SREPOSITORY_SPACE_NAME'.

Perspective Space

To support the perspective cache, the PERSPECTIVE cache object is defined in the
CacheConfig.xml file.

See the following sample:

<Cache>
<Name>PERSPECTIVE</Name>
<Description>This space maintains Perspective data</Description>
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<Type>distributed</Type>
<ReplicationCount>0</ReplicationCount>
<SingleByteObjectSize>240</SingleByteObjectSize>
<MultiByteObjectSize>320</MultiByteObjectSize>
<ListSize>50</ListSize>

</Cache>

By default, perspective uses the hibernate technology to interact with the database.
However, if you want to use JDBC related libraries, change the value to false of the
com.tibco.mdm.perspective.hibernate.enable property in the Configurator.

Cache Operation on Perspective

« Whenever a perspective is deployed, it is added or updated in cache.

« If a perspective is deleted, its entry is removed from cache except the mod version
entry.

« If a repository is deleted, perspective is removed from cache.
« If a perspetive is modified, the perspective cached is also updated.
Whenever a perspective is created, the following entries are made in cache:

PERSPECTIVE__PERSPECTIVEID

e PERSPECTIVE__PERSPECTIVEID__MODVERSION
e PERSPECTIVE__CATALOGID__NAME
e PERSPECTIVE__ REL__ PERSPECTIVEID__MODVERSION

e PERSPECTIVE__ATTR__PERSPECTIVEID__MODVERSION__CATALOGID__
RELATIONSHIPDEFINITIONID__DIRECTION

Perspective Cache Keys

Perspective is stored in cache with the following keys:

TIBCO® MDM Installation and Configuration Guide



204 | Apache Ignite

Cache Key

Description

Note: All cache key names start with a prefix PERSPECTIVE__

PERSPECTIVE_ID

CATALOG_ID__PERSPECTIVE_ID

CATALOG_ID

PERSPECTIVE_ID__MODVERSION

REL__PERSPECTIVE_ID__
MODVERSION

ATTR__PERSPECTIVE_ID__
MODVERSION__CATALOG_ID__
RELATIONSHIPDEFINITIONID_
_DIRECTION

Cache Configuration

Stores perspective information by perspective ID. It
contains only perspective information, no information
about relationships and attributes.

Stores perspective information by combination of catalog
ID and perspective name. It contains only perspective
information, no information about relationships and
attributes.

All perspectives which are associated with this catalog. It
contains only perspective information, no information
about relationships and attributes.

Stores perspective information for specified modversion.
No information about relationships and attributes.

Stores all relationships, which are defined in perspective
with the provided modversion.

Stores all attributes, which are defined in perspective
with the provided modversion for the specified repository
and selected relationship definition.

The CacheConfig.xml file includes the cache configuration. The file is available in the $MQ_

HOME /config folder.

The following table describes the Cache attributes listed in the CacheConfig.xml file:
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Cache Configuration Parameters

Cache Attributes
Server Config

CacheServerCount

CharSet

Memory

HeapStorage

OverHead

Descriptions

Defines the number of configured cache servers. However, this number
is only for the information purpose.

Defines the objectsize configuration to be used. The available
charsets are singlebyte and multibyte.

If the language that is used in the application contains multi byte
characters, specify the multibyte value. For example, multi byte
characters are used in French, Japanese, Korean, and so on.

Defines the total memory assigned to the cache servers. This includes
the heap storage. The memory allocated for all near and distributed
caches is (Memory - HeapStorage).

Memory must be more than heap size. A warning is issued if memory is
specified less than 64m or Memory - Heapstorage is less than 64m. By
default, memory is set to 512m.

The memory required by external cache servers relies on configuration
specified in the CacheConfig.xml file. If the memory is 2048 KB and
the heapsize is 512 KB, the memory used by each cache server is as
follows: (Memory - HeapStorage) 2048 - 512= 1536 KB. To allocate more
memory, you must start more cache servers.

You can preload entire repositories into memory at start up. This takes
a while to start. However, after the memory is loaded, it provides
significant performance gains. Do not use multivalue attributes that
are not stored in the shared tables because preloading such large data
takes significantly longer.

Defines the memory allocated for near and local caches. Min heap
must be minimum 32m, by default, it is 128m. A warning is issued if a

heap is specified more than 512m.

Defines the additional overhead added to objectsize. By default, the
overhead factor is 1.5.
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Cache Attributes

ReplicationCount

Cachelist

Name

Description

Type

ReplicationCount

SingleByteObjectSize

MultiByteObjectSize

Descriptions
Allows you to keep the data multiple times (typically, duplicating it) so
that no single server failure can lead to data loss.
The values are 0 and 1. By default, it is set to 0.
o If you select 0, keep one copy of the data.

« If you select 1, keep two copies of data records on physically
different machines.

Defines the name of the cache server. For example, RECORD. It allows
you to keep a track of the cache configurations.

Defines the description of the cache. For example, The description for
RECORD is 3-4 entries per record.

Defines the type of cache servers. The available cache server types are
local, distributed, and near.

Specify limit or list size for near caches to avoid mismatch between
capacity in heap and in distributed storage.

For distributed caches, if no limit or list size is specified, remaining
memory is distributed evenly after memory is assigned to all other
caches. The remaining memory must be minimum 32.

Allows you to keep the data multiple times (typically, duplicating it) so
that no single server failure can lead to data loss.

The values are 0 and 1. By default, it is set to 0.

o If you select 0, keep one copy of the data.

o If you select 1, keep two copies of data records on physically
different machines.

Defines the single byte objectsize for the cache server.

Defines the multi byte objectsize for the cache server.

TIBCO® MDM Installation and Configuration Guide



207 | Apache Ignite

Cache Attributes Descriptions

Limit Defines the limit in which the memory is divided among all cache
types, such as, Local, Distributed, and Near.

o If the Limit is specified, list size is ignored.

o If limit and list size are not specified for Local and Near caches,
the list size is defaulted as 100.

o Itis always recommended to specify limit or list size for Near
caches to avoid mismatch between the capacity in heap and in
distributed storage.

ListSize Defines the list size of the cache. Use the ListSize to specify the exact
capacity. Similarly, specify the Limit if you want the cache to get
memory as it grows.

o To specify the unlimited cache size for the Distributed cache
type, remove the <Limit> attribute and specify ListSize = -1.

o For Near and Local cache types, the unlimited cache size is not
supported.

EvictionPolicy Defines eviction policy for a cache. The eviction policies are Least
Recently Used (LRU) and None. By default, the eviction policy is set at
LRU.

o If a capacity (number of objects in a cache) is specified, you
must specify an eviction policy.

e For local caches, eviction = LRU is always applied and you
cannot specify any other eviction policy.

o For distributed cache, LRU or NONE must be specified.
o If you want to keep the caches permanently, do not set LRU.

o If Limit is specified and EvictionPolicy is not specified, LRU is
applied to those caches.

o If EvictionPolicy (LRU) is set, the least recently used records are
deleted and new records are inserted.

o If EvictionPolicy (LRU) is not set, and the Capacity crosses its
limit, the cache does not allow the insertion of a record and the
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Cache Attributes Descriptions

new record insertion fails.

Note: It is recommended that unless instructed by Support, you
should not change the default EvictionPolicy defined in the
CacheConfig.xml file.

LockWaitTime Defines the value while waiting for the lock to clear. An application
can lock an entry so that the entry cannot be modified (but can still be
read) until the lock is explicitly removed. By default, it is set to -1,
which means the lock never waits.

LockExpirationTime  This property defines the value while the lock for an entry expires. By
default, it is set to -1, which means the lock never expires.

Cache Configuration Example

The sample shows an example of Cache attributes specified in the CacheConfig.xml file.

<CacheConfig>
<ServerConfig>
<CacheServerCount>1</CacheServerCount>
<CharSet>singlebyte</CharSet>
<Memory>512</Memory>
<HeapStorage>128</HeapStorage>
<OverHead>1.5</0OverHead>
<ReplicationCount>0</ReplicationCount>
</ServerConfig>
<CachelList>
<Cache>
<Name>WORKFLOWEXPR</Name>
<Type>local</Type>
<ReplicationCount></ReplicationCount>
<SingleByteObjectSize></SingleByteObjectSize>
<MultiByteObjectSize></MultiByteObjectSize>
<Limit></Limit>
</Cache>
<Cache>
<Name>RECORD</Name>
<Type>distributed</Type>
<ReplicationCount></ReplicationCount>
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<SingleByteObjectSize>1320</SingleByteObjectSize>
<MultiByteObjectSize>1920</MultiByteObjectSize>
<Limit>24.0</Limit>
</Cache>
</CachelList>
</CacheConfig>

You can switch the cache configurations for different environments, such as, large and
development. For a large number of repositories or large data, use the
CacheConfig.large.xml file. For the development environment, use CacheConfig.dev.xml
file. The files are located in $MQ_HOME. As per your requirement, rename the file to
CacheConfig.xml.

Cache Computation

As the application ages and whenever more data is added, you may observe that the cache
is incorrectly sized. Memory calculation of cache is also quite complex in TIBCO MDM.
Using the auto compute option of the cache, auto cache calculation is suppressed
depending on the capacities of caches.

By default, TIBCO MDM adds different types of overhead and factors in capacity
calculation, however, the approximate capacity can be calculated using the following
generic formula:

Capacity = Total number of objects exist in the database * number of
entries maintained in cache per record

For example, ENTERPRISE cache object, assume five enterprises are available in the
database and tibco MDM maintains two entries in cache per enterprise, the capacity for
the ENTERPRISE cache object is 5%2 = 10.

By default, the Cache Calculation Suppression (
com.tibco.mdm.cache.autocompute.disable) property is set to false. If you change the
value to true, the cache calculation is suppressed.

Cache Description
Name

Enterprise  Counts the number of enterprises, and derives capacity of the following caches:
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Cache Description
Name

e ENTERPRISE, ORGANIZATION, HTTP, CONFIGDEFINITION,
CONFIGDEFINITIONLIST, RULEENGINE, and RULEENGINEATTRIBUTEINFO
Member Counts the number of users and derives the capacity of the following caches:

e MEMBER, MEMBERORG, WORKITEM, WORKITEMLOCK, WORKITEMPREFERENCES,
and WORKITEMSUMMARY

e CONFIGURATIONDOCUMENT, MASSUPDATE, MATCHEROUTPUT,
RULEBASERESULTS, and PRODUCT

e PRODUCT, RECORDBUNDLE, SEARCHCRITERION, SECURITYPERMISSIONS,
andLOCALSUBCATALOG

Repository  Counts the number of repositories and derives the capacity of the following
caches:

e CATALOG, SECUREDATTRIBUTEGROUP, ASSOCSCHEMES, CATALOGFORMATS,
CATALOGEDITIONVALUE, and CATALOGEDITION

e CATALOGINPUTMAP,OUTPUTMAPLIST, RELATEDMAPS, CLASSIFICATIONCODE,
and CLASSIFICATIONCODEATTRIBUTE

o CATALOGDECLARATION, RULEBASE, RELATIONSHIPMETADATA, and PRELOAD_
STATUS

Event Assumes the minimum events to be stored to 2000 and derives the capacity of the
following caches:

e EVENT, EVENTDETAIL, PROCESS, MLXMLDOC, PROCESSSTATE, and
PROCESSLOG

e RECORDCOLLECTION, RECORDKEYLIST, and RECORDITEM

PoolSize Inquires the pool size of the workflow receiver and configures the following
caches:

e WORKITEMDOC and COMPUTEDSUMMARY

e LOCAL except LOCALSUBCATALOG

After the cache size is calculated and when the caches are being created, the cache size
configured through the CacheConfig.xml file is compared, and the higher value is used.
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Thus, the total memory allocation to the cache can be higher than what is configured
through CacheConfig.xml. To avoid startup issues, when cache capacities are auto
computed, the excess memory check is suppressed and the server allocates more memory
than configured. To verify cache computation, the following message is generated in
debug log:

“Autocompute enabled, excess memory allocation allowed.”

o Note: RECORD cache are not included in the auto computation.

Securing Connection among Nodes Using SSL

By using the SSL socket communication, you can secure connection among all nodes of
Apache Ignite.

Procedure
1. Navigate to $MQ_HOME/config and open the IgniteMember.xml file.

a. Set sslContextFactory: by default, Apache Ignite provides a default SSL
context factory, org.apache.ignite.ssl.SslContextFactory, which uses a
configured keystore to initialize SSL context.

<property name="sslContextFactory">
<bean class="org.apache.ignite.ssl.SslContextFactory">
<property name="keyStoreFilePath"
value="keystore/keystore.jks" />
<property name="keyStorePassword" value="123456"/>
<property name="trustStoreFilePath"
value="keystore/truststore.ts"/>
<property name="trustStorePassword" value='"123456"/>
</bean>
</property>

b. Disable Certificate Validation: in some cases, you must disable certificate
validation of the client side. For example, when connecting to a server with
self-signed certificate

Set a disabled trust manager to sslContextFactory
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<property name="sslContextFactory">
<bean class="org.apache.ignite.ssl.SslContextFactory">
<property name="keyStoreFilePath"
value="keystore/keystore.jks" />
<property name="keyStorePassword" value="123456"/>
<property name="trustManagers'">
<bean class="org.apache.ignite.ssl.SslContextFactory"
factory-method="getDisabledTrustManager"/>
</property>
</bean>
</property>

c. Set Protocol: By using Apache Ignite, you can configure different types of
encryption. The following algorithms are supported
http://docs.oracle.com/javase/7/docs/technotes/guides/security/StandardNam
es.html#SSLContext and can be set by using the setProtocol method. The TLS
encryption is the default.

<property name="sslContextFactory">
<bean class="org.apache.ignite.ssl.SslContextFactory">
<property name="setProtocol" value="SSL"/>

</bean>
</property>

2. Save the IgniteMember.xml file.

Remember: If security is configured, the logs contain communication encrypted=on.

INFO: Security status [authentication=off, communication
encrypted=on]

The server console shows the following:

INFO: Security status [authentication=off, tls/ssl=on]

3. Generate keyStore using the following command:

keytool -genkey -alias ignite —keystore keystore.jks -keyalg RSA

4. Generate trustStore using the following two commands:
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keytool -export -file dignite.cert -keystore keystore.jks -alias
ignite

keytool -import -v -trustcacerts -file ignite.cert -keystore
truststore.ts -alias tdgnite

For more information, see Apache Ignite documentation.

Starting Apache Ignite As External Cache Server

You can start Apache Ignite as an external cache server in case of client-server
configuration or centralized cache server topology.

Before you begin
o Ensure that the ECMClasses.jar file located in $MQ_HOME/1ib/mq is in the class path
when starting the external Apache Ignite cache server. By default, ignite.bat or
ignite.sh handles this scenario by referring to the $MQ_HOME environment variable.

o If $MQ_HOME is not set, then copy ECMClasses.jar from the TIBCO MDM installation
directory to the $MQ_HOME/bin/ignite/libs directory.

Procedure

1. Clone the IgniteMember.xml configuration file in the $MQ_HOME/config folder as
IgniteServer.xml

2. Update the IgniteServer.xml and IgniteMember.xml files as follows:

IgniteServer.xml IgniteMember.xml

Set Apache Ignite as server by using the Set TIBCO MDM as client by using the

following properties: following property:
e <property name="clientMode" <property name="clientMode"
value="false"/> value="true"/>
e <prop
key="totalSize'">2048</prop> to
<prop
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IgniteServer.xml IgniteMember.xml

key="totalSize">4096</prop>

The following steps are common for both the files:

a.

Comment the following property: <property name="localHost"
value="IPAddress"/>

Uncomment the following property: <bean
class="org.apache.ignite.spi.discovery.tcp.ipfinder.vm.TcpDiscovery
VmIpFinder">

Comment the following properties:

<bean
class="org.apache.ignite.spi.discovery.tcp.ipfinder.multicast.
TcpDiscoveryMulticastIpFinder

<property name="multicastGroup" value="IPAddress"/>

. Specify the IP addresses in the following property on which Apache Ignite server

and TIBCO MDM client are running:

<property name="addresses'">

<list>

<!--= In a distributed environment, replace it with an actual
host IP address. ——>

<value>IPAddress on which Apache Ignite server 1is
running:48500. .48520</value>

<value>IPAddress on which TIBCO MDM client 1is
running:48500. .48520</value>

</list>

</property>

3. Navigate to $MQ_HOME/bin/ignite/bin and start the Apache Ignite server by running
the following command in the command prompt:

ignite.bat complete path of IgniteServer.xml

For example,

ignite.bat SMQ _HOME/config/igniteServer.xml
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4. Start TIBCO MDM with Apache Ignite as a client or server by changing the
clientMode value to true or false respectively.

What to do next
Verify if Apache Ignite has started as an external server and TIBCO MDM as its client:

o Check the TIBCO MDM server console. For example: The following message is

displayed:

Servers =1 and clients = 1.
Topology snapshot [ver=2, locNode=383fd8dd, servers=1, clients=1,
state=ACTIVE, CPUs=8, offheap=4.0GB, heap=3.0GB]

o Check the Apache Ignite Server console. For example: The following message is
displayed:

Topology snapshot [ver=1, locNode=6c4bd160, servers=1, clients=0,
state=ACTIVE, CPUs=4, offheap=2.0GB, heap=1.0GB]
Topology snapshot [ver=2, locNode=6c4bd160, servers=1, clients=1,
state=ACTIVE, CPUs=8, offheap=4.0GB, heap=3.0GB]

« Navigate to $MQ_HOME/bin/ignite/bin and run the following command to verify from
Visor: ignitevisorcmd.bat -cfg= complete path of IgniteServer.xml

e Run the following commands:

° status output

© cache output

Configuration of Golden Record Cache and Cluster
Topology with Apache Ignite

You can enable the golden record cache using the FastCache enable property in the
Configurator. For information about configuration properties of golden record cache, see
the section, "Configuration Properties of Golden Record Cache" in TIBCO MDM System
Administration.

To configure golden record cache and cluster topology with Apache Ignite, use the
FastCacheIgniteMember.xml file, which is located at $MQ_HOME/config. The configuration is
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similar to the one specified in the IgniteMember.xml file. For information, see Configuring
Cache and Cluster Topology for Apache Ignite.

Golden record cache with Apache Ignite has few limitations. For information, see
Limitations.

Bundle Caching

In large bundle scenarios, that is, in cases more than thousands of records per bundle,
the loading of a bundle can take a long time and puts a large stress on the database. The
bundle is loaded in steps for each parent and immediate child in the overall bundle, which
leads to many queries against the database. By using bundle caching, the full bundles are
loaded into the cache and can be retrieved from the cache instead of the database for the
next use of the bundle.

How Bundle Caching Works

A bundle is the connected set of records based on a root record, where each of the
dependent nodes is discovered in depth, the first traversal of the record space. The root
record defines the bundle identity. Along with the root record, the following parameters
are part of the cached bundle:

o Bundle depth
« Relationship definitions to be traversed

« Relationship definition depth

Bundle Caching is currently only implemented in a limited fashion. You can use the bundle
caching for the following record operations:

« Modify record through web service: when you modify a record in the bundle, the
bundle cache is searched for all bundles containing the updated record, and each of
these bundles from the cache is updated with the new record.

« Validate record through web service

o Query record through web service: when you query a record through web service,
the bundle is added to the cache.

« If you Query record with perspective as the context parameter, perspective related
bundle is added to the Bundle Cache.

All these use cases require repeated usage of the bundle to see the performance gains.
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Bundle Cache Space

To load the golden record bundles as cache in Apache Ignite, a distributed object BUNDLE
is defined in the CacheConfig.xml file.

See the following sample:

<Cache>
<Name>BUNDLE</Name>
<Description>This space contains global record bundles a
cache</Description>
<Type>distributed</Type>
<ReplicationCount>0</ReplicationCount>
<SingleByteObjectSize>3000</SingleByteObjectSize>
<MultiByteObjectSize>4500</MultiByteObjectSize>
<ListSize>500</ListSize>
</Cache>

The BUNDLE space contains the following fields:

Field Name Apache Description
Ignite
Data
Type
z_id String Refers to the bundle ID. This is a primary key.
DATE Datetime Indicates the bundle creation date, using which you can evict

bundles out of the cache based on the staleness

RKEYLIST String Refers to the record key list that contains the record IDs
concatenated with a separator ‘_’

BUNDLESTRUCT String Contains hints about the graph structure of the bundle
RELATIONSHIPDEF  String Encodes a list of relationships. The list is an encoded form of
the IDs in the relationshipMetalnfo field in the

Recordbundle cache.

ALLRELATIONS Blob Serializes the map object (relationships per relationship
definition) so that the allRelationship field inside the
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Field Name Apache Description
Ignite
Data
Type

Recordbundle cache can be reestablished upon record bundle
access from cache.

rkeyidx String Indicates an index on the record key list for a quick search on
the field.

Configuration Properties for Bundle Caching

Configuration Property for Bundle Caching

The following table lists the property of Bundle Caching specified in the Configurator:

Property Name Location Value Description

Enable Record Bundle Caching Cluster Level True or False. The Enables

(com.tibco.mdm.bundlecache) (InitialConfig > default value is bundle
Optimization) False. caching.

Support for Record Bundle Cache

To support the record bundle caching with Apache Ignite, update the BUNDLE cache
configuration in the CacheConfig.xml file (located at $MQ_HOME/config).

Append the following index to the BUNDLE object:

<Indexes>
<Index>
<Name>INDXRKEYLIST</Name>
<Type>HASH</Type>
<Columns>
<Column>RKEYLIST</Column>
</Columns>
</Index>
</Indexes>

After adding the index, the sample BUNDLE object in the CacheConfig.xml file is updated as
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follows:

<Cache>
<Name>BUNDLE</Name>
<Description>This space contains global record bundles as
cache</Description>
<Type>distributed</Type>
<ReplicationCount>0</ReplicationCount>
<SingleByteObjectSize>3000</SingleByteObjectSize>
<MultiByteObjectSize>4500</MultiByteObjectSize>
<ListSize>500</ListSize>
<Indexes>
<Index>
<Name>INDXRKEYLIST</Name>
<Type>HASH</Type>
<Columns>
<Column>RKEYLIST</Column>
</Columns>
</Index>
</Indexes>
</Cache>

Apache Ignite Durable Memory

Apache Ignite provides a page-based (durable) memory architecture that is split into pages
of fixed size. The pages are stored in managed off-heap regions in RAM (outside of Java
heap).

Memory Configuration

By default, Apache Ignite nodes consume up to 2GB of the RAM available locally. You can
change the size of the default memory by using the totalSize property in the
IgniteMember.xml file. Specify the memory size in MB. For example,

<property name="properties'">
<util:properties>

<!-- Size in MB -->

<prop key="totalSize">2048</prop>
</util:properties>

</property>
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Data Region

A data region is a logical expandable area. Durable memory includes one or more data
regions that can vary in size and eviction policies, be persisted on disk. By default, the
Apache Ignite node creates the Default region that allocates 10% memory of total memory.
The TIBCO MDM Ignite node creates the following custom types of region:

o Core: Allocates 30% memory of total memory
« Evictable: Allocates 25% memory of total memory
« NonEvictable: Allocates 25% memory of total memory

« Expirable: Allocates 10% memory of total memory
The following diagram represents the structure of Apache Ignite durable memory

structure in TIBCO MDM:

Apache Ignite
Total Memory

Memory Ty emory | [ Ernory [ ernory
Reaion 1 Renifn 2 Re;liun 3 Regilun 4 Region 5

Default Evictable ManEvicable Core ET t
[30%) | 1 20%:) | {20%) | {210% ) | 105}
I_ ______ Data Regions — — — — — — |
Limitations

The following features are not supported with Apache Ignite:
o Repository Spaces - An Overview
o Bundle Caching
o Configuration of Golden Record Cache and Cluster Topology with Apache Ignite

o Dynamic index creation, modification and deletion are not supported using
REST services. You can create indexes on the server startup for a particular
object type and the column name in the FastCache_CacheConfig.xml file.
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For cache and index configuration of golden record cache, see the section,
"Cache Index using FastCache_CacheConfig.xml" in TIBCO MDM System
Administration.

Troubleshooting with Apache Ignite

If you encounter an error while working with Apache Ignite, you might resolve some of the
common issues by completing the troubleshooting procedures.

Issue Solution

Multi-node cache o Ensure that you have correct configuration for discovery for
cluster does not discoverySpi. That means, ensure that correct and all
connect. required IP addresses and ports are defined.

o Default configuration has restricted node discovery to loop-
back address. To enable the discovery of remote nodes,
remove the property <property name="1localHost"
value="127.0.0.1"/> from the IgniteMember.xml file.

Command line interface  Supply the configuration file while running the CLI tool. Ensure to
does not connect or use the same IgniteMember.xml configuration file, which is used to
does not show all start TIBCO MDM.

nodes in topology.
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Apache Spark

Apache Spark is a high-performance engine for large-scale data processing. Use Apache
Spark in TIBCO MDM to process huge data loads. Apache Spark improves the big data
import performance of TIBCO MDM as it scales well across the nodes and recovers well
from failures.

o For information about Apache Spark, see Apache Spark documentation.

o For information about using the big data import feature, see the "Importing of
Records Using Big Data Import" section in TIBCO MDM User's Guide.

Platform Limitations for Apache Spark

The following table lists the supported and unsupported platform combination.

Supported Platform Combination

Apache Spark works with the following platform combinations:

Operating System Application Server Database

Linux JBoss WildFly Oracle

Linux JBoss EAP Oracle

Linux JBoss WildFly Microsoft SQL Server
Linux JBoss WildFly PostgreSQL

Note: For the supported platforms, Apache Spark works with the Apache Ignite
cache.

Unsupported Platform Combination
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Apache Spark does not work with the following platform combinations:

Operating System Application Server Database
Linux WebSphere Oracle
Linux WebLogic Oracle

Note: Windows operating system with any application server and database is not
supported.

Setting up Apache Spark

For the Big Data Import feature of TIBCO MDM, you must download and configure Apache
Spark. Apache Spark cluster includes a single master and any number of worker nodes.
For high and efficient performance, configure four or five worker nodes.

Before you begin
o For the recommended platform, see Platform Limitations for Apache Spark.

e Share the $MQ_HOME, $MQ_COMMON_DIR, and MQ_CONFIG_FILE directories across all
worker nodes (from TIBCO MDM host machine to Apache Spark master and worker
machines).

For information about sharing the directory in the cluster environment, see
Clustering Set Up.

Procedure
1. Add Entries in the Hosts File (master and worker)

a. On the Apache Spark master machine, navigate to /etc.

b. In the hosts file, specify names of the servers individually for all three nodes.

Consider a scenario where you have three servers: one for the master node,
and two others for the worker node. In other words, these are three Linux
machines where Apache Spark is already installed.
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sparkl: master node
spark2: worker node
spark3: worker node

Repeat the step a and b for all worker node machines.

Note: Ensure that all the servers can ping each other by name and
an IP address.

2. Generate Key

a. Create public and private keys using ssh-key-gen.

You need the key to access worker nodes without a password. If you have
generated the key, you can seamlessly copy the key to the worker node
machines without password.

3. Setup SSH Passwordless Login

a. On the command line, enter the following command to copy the key to the
worker node machines:

ssh-keygen

ssh-copy-id -i ./.ssh/id_rsa.pub sparkl

ssh-copy-id -i ./.ssh/id_rsa.pub spark2

ssh-copy-id -i ./.ssh/id_rsa.pub spark3
4. Check Login to Worker Nodes using SSH Keys

a. Enter the following command from the master node and verify if the worker
nodes are accessible.

ssh 10.XXX.XXX.XXX (an IP address of the worker node)

You can now log in to the worker node machine without being prompted for a
password.

5. Install Spark

a. To download Apache spark, navigate to the Apache Spark website.
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b. In the Archived Releases section, click Spark Release archives.
c. From the version list, click the spark-2.4.5 version.

d. Download spark-2.4.5-bin-hadoop2.7.tgz and extract its contents to the
/home/username folder.

6. Set up Apache Spark Cluster
a. If the slaves file does not exist, copy slaves.template to the slaves directory.

b. Navigate to $SPARK_HOME/conf and list the following slave or worker nodes in
the slaves file:

e sparkl
e spark2

e spark3

7. Configure Spark Master

a. If the spark-env.sh file does not exist, copy spark-env.sh.template to spark-
env.sh.

b. Navigate to $SPARK_HOME/conf and open the spark-env.sh file.

c. Add the IP address and port number of the SPARK_MASTER node and instance
number of the SPARK_WORKER node:

SPARK_MASTER_IP=10.XXX.XXX.XXX (an IP address of the master
node)

SPARK_MASTER_PORT=7077

SPARK_WORKER_INSTANCES=1

d. Set MQ_LOG in the spark-env.sh file.
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o Note: Before setting the MQ_LOG parameter, ensure that MQ_CONFIG_
FILE is shared to Apache Spark master node machine and has full
permissions. If Apache Spark cluster and TIBCO MDM are installed
on different machines, share $MQ_HOME. For this, you must share
$MQ_HOME from TIBCO MDM host machine to Apache Spark master
and worker machines.

e. Set JAVA_HOME in the spark-env.sh file. For example,

export JAVA_HOME=/home/apps/JAVA8/jdkl.8.0_112
export PATH=$PATH:$JAVA_HOME/bin

o Note: Alternatively, you can use AdoptOpenJDK 8.

f. Copy $SPARK_HOME folder (that is, spark-version-bin-hadoop2.7) from
/home/username/ to all the other worker node machines.

8. Start Apache Spark Cluster

a. On the master node, run start-all.sh from/home/username/spark-
version/sbin.

The master and worker nodes start.

b. Optional: Navigate to $SPARK_HOME/sbin folder and run the following command
to stop Apache Spark: stop-all.sh

9. Check Whether Services Have Been Started

a. Run the Jps command from any path to list the processes (master and
subordinate).

Running 3PS from the master machine shows master node processes and slave
machines shows worker nodes processes.

username@TIBCO MDM master machine name cd $SPARK_HOME/sbin
[username@TIBCO MDM master machine name sbin]# jps

5495 Master

5607 Jps
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username@TIBCO MDM worker machine name cd $SPARK_HOME/sbin
[username@TIBCO MDM worker machine name sbin]# jps

1234 Worker

5678 Jps

Apache Spark is set up.

What to do next

1. To verify if Apache Spark setup works correctly, run the samples provided in the
$SPARK_HOME /examples/src/main/scala/org/apache/spark/examples directory.

2. Access the Apache Spark master, worker, and application Ul to know about
configured worker nodes, cluster resources, and spark jobs.

Setting up Hadoop Distributed File System

Apache Spark is compatible with Hadoop data. You can run it in Hadoop clusters through
YARN or Apache Spark's standalone mode, and it can process data in Hadoop Distributed
File System (HDFS). HDFS is highly fault tolerant and efficient in parallel data processing.
HDFS takes in data, breaks the information into separate blocks, and distributes them to
different nodes in a cluster.

For more information aboutHDFS, see HDFS documentation.

Before you begin
Create hdfs/namenode and hdfs/datanode directories at the home/username.

For example, home/username /hadoop/hdfs/namenode and
home/username /hadoop/hdfs/datanode.

Procedure

1. Download Apache Hadoop 2.7.3 version from
https://hadoop.apache.org/releases.html and extract its contents to the
/home/username folder.

2. Navigate to $HADOOP_HOME /etc/hadoop and modify the hdfs-site.xml file to set the
path for namenode and datanode.
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<configuration>

<property>

<name>dfs.namenode.name.dir</name>
<value>/home/username/hadoop/hdfs/namenode</value>
</property>
<property>
<name>dfs.datanode.data.dir</name>
<va'lue>/home/username/hadoop/hdfs/datanode</value>
</property>

</configuration>

3. Modify the core-site.xml file to specify the HDFS host name and port.

<configuration>
<property>
<name>fs.default.name</name>
<value>hdfs: //hostname</value>
</property>
</configuration>

4. Modify the Hadoop-env.sh file to set JAVA_HOME.

5. Navigate to $HADOOP_HOME/sbin directory and run start-dfs.sh.
The HDFS setup is completed and the HDFS processes are started.

Optional: If you want to stop Apache Hadoop, run stop-dfs.sh.

What to do next
« To verify if HDFS is running correctly, run the JPS command from any path. The

following processes with ID are displayed:

[username@TIBCO MDM master machine name sbin]# jps
5607 Jps

4634 DataNode

4842 SecondaryNameNode

5132 NodeManager

4527 NameNode

5023 ResourceManager

« Configure TIBCO MDM with Apache Spark. For information, see the "Configuration
Properties for Apache Spark" and "Required JAR Files for Apache Spark" sections in
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TIBCO MDM User's Guide.
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Clustering Set Up

TIBCO MDM is designed for deployment in a cluster for the purpose of load balancing and
redundancy. Multiple components of the application can be run as multiple instances in
the cluster. You can deploy TIBCO MDM in a cluster environment.

Clustering Architecture and Components

Certain components of TIBCO MDM can be run as multiple instances to share the load,
and can provide redundancy, whereas other components must be run as one instance.

The following diagram depicts the clustering architecture of TIBCO MDM.

Clustering Architecture

Load Balancer

z

Weab Server — Wiab Servar

|
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‘\\ = ‘ —‘ ’,
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\\ Messaging /,
" Servers '
| AS2 Gateway
Clustering Components
Clustering Description
Component
Load To deploy clustered web servers, use a load balancer. A load balancer equally
Balancer distributes HTTP requests from the browser and web service requests to the
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Clustering
Component

Web Server

Application
Server

Description

cluster members. This guide does not describe how to set up the load balancer.
Consult the appropriate vendor documentation.

Clustering of web servers is optional, and if not used, a load balancer is not
required.

Web Servers receive HTTP requests and forward them to the application server.
As mentioned earlier, you need a load balancer to cluster web servers.

A single web server can be set up to load balance the HTTP requests to multiple
application servers without any load balancer.

You can install one or more instances of the TIBCO MDM application on one
computer running an application server, or install an instance of the TIBCO
MDM application each running in an application server running on a different
machine.

For clustering, multiple application servers must be deployed for load
balancing and to provide redundancy. All application servers in the cluster
must have the same JVM version and have compatible JVMs ensure that:

o Each application server has an independent JNDI registry.

e Each server has a unique port assigned for JNDI registry in the
Configurator.

o Each application server has its own logging setup, with separate logging
configuration, and a setup where the log files are located in a directory
on a local file system.

« The configuration is centrally stored, where each application server
instance pulls its configuration information from the central cluster
configuration instance. The cluster configuration instance is referred to in
the MQ_CONFIG_FILE environment variable and typically points to a file
named ConfigValues.xml. Each application instance can pull the
relevant configuration information out of the centrally configured
configuration by identifying itself through its unique node ID.

o The Node ID (or NODE_ID environment variable) is set uniquely for each
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Clustering
Component

Database
Server

Messaging
Server

Description

application server instance and matches the member name in the
Configurator.

For cluster configuration with JBoss, see JBoss documentation.

A Database server persists and queries the TIBCO MDM data. All the application
servers in the cluster must be connected to one active database instance.

If you need to cluster the Oracle database using RAC, contact Customer
Support.

If the application server (for example, WebSphere) supports transparent failover
between active and standby database servers, the TIBCO MDM is able to
connect to the standby database server. Any industry standard database
clustering technology can be used to cluster databases. In the case of a
database failover and restart, application servers are able to reconnect to the
database without requiring a restart.

A Messaging server is used for internal application server synchronization
purposes as well as external communication with backend systems.

All application servers should be connected to at least one active messaging
server (for example, TIBCO EMS). The messaging servers themselves may be

clustered. To configure clustering, see the relevant document for messaging

servers.

Multiple standby messaging servers may be configured using the messaging
configuration inside the ConfigValues.xml configuration instance. When the
primary messaging server fails, all open connections to the server are
transparently routed to the standby server. During the reconnection phase to
the standby server, the TIBCO MDM server can encounter errors. However,
typically the rollover operation to the standby server executes quickly.

If the messaging server goes down, the application servers can be configured to
attempt reconnection to the messaging server for a certain configurable
interval. After that time frame, the application server must be restarted.

Note: It is possible to configure the application in such a way that different
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Clustering Description

Component

instances can use a segregated, dedicated JMS server. This configuration may
be used to create prioritized processing zones. Consult Customer Support for
additional information.

If WebSphere MQ is used as the messaging server, the number of JMS sessions
that can be created needs to be increased. This can be done by adding the
following CHANNELS section to the gm.ini file that exists for Queue Manager
used by the cluster (for example, on Linux or UNIX machines, gm.ini might exist
in the /var/mgm/gmgrs/<QMgrName> directory).

CHANNELS:MaxChannels=400(or later, depending on the number of channels)

File Stores File Stores are described in detail as follows:

o The MQ_COMMON_DIR directory is shared by all application servers. Ensure

that all servers are set up to point to the same location: MQ_COMMON_DIR.
The location can be mapped to a different logical directory name for
each server.

For example, one application server can mount MQ_COMMON_DIR to
/home/mdm/common, and another one can mount MQ_COMMON_DIR to
/export/vsamin/commondir. In addition, a Communicator running on its
own machine can mount MQ_COMMON_DIR to /mdm6/commondir,
provided all of them point to the same physical file store.

The MQ_HOME directory can be set up in any one of the following ways:

o Each application server has its own MQ_HOME and it is not shared
with other application servers.

o MQ_HOME is shared for all application servers. This will typically
involve a single install image for TIBCO MDM, which is shared
throughout the cluster machines through a remote file system.

The MQ_CONFIG_FILE file represents the central configuration store for
the entire cluster, containing the configuration for every instance. In
order to set up the logging configuration for each cluster member, define
the cluster in the Configurator, and define for each member the relevant
logging configuration in Member > Logging. Also, define the MQ_LOG
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Clustering Description
Component

environment variable in the application server startup script so that it
points to a directory in a local file system

Note: You can configure the message recovery system to write failed messages
to a local file system or a network file system. For more details, see TIBCO MDM
System Administration.

Concurrent Process Synchronization in a Clustered
Environment

TIBCO MDM has two timer tasks (MgRevivify and FileWatcher) which repeat execution after
a specified interval. There can be contention issues when multiple task threads run
concurrently in the cluster.

To ensure that such issues do not occur, TIBCO MDM implements a locking mechanism by
which when one timer task is running, other tasks either skip the processing or do not
work on the same file (as in the case of FileWatcher).

Prerequisites

Each application instance must have a unique Node ID. A Node ID is a logical name for the
server instance.

It is recommended to use the hostname_serverinstancenumber naming convention for the
NODE_ID. For example, on the lightning machine the server instance is 1. In this case, the
NODE_ID is lightning_1.

o For server instance 1, NODE_ID=lightning_1
o For server instance 2, NODE_ID=lightning_2

Specify NODE_ID in the standalone.xml file under <system-properties> element. The file is
located in the $JBOSS_HOME\standalone\configuration directory. For example,
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<system-properties>
<property name="NODE_ID" value="Memberl'"/>
</system-properties>

Note: It is important that each server instance has a different Node ID value and
that the Node ID value matches the name in the server instance in the
Configurator.

Locking Mechanism

The locking mechanism implementation process is explained in this topic.

Procedure
1. When a timer task starts processing, it tries to acquire a lock.

2. If it finds a lock file, it skips processing.

3. If a lock file is not found, a lock file is created and the Node ID information of the
server is added to the lock file. The lock files are created in the following directories:

o MqgRevivify: $MQ_HOME /Work/MgRevivify.lock

o FileWatcher: Location can be specified in the Filewatcher.xml file.

Note: If multiple files are being processed (using FileWatcher),
ensure the lock file is enabled in the filewatcher.xml file (enabled
by default).

The lock file contains the local host information so that the host JVM that
created it can be identified. It contains the application Node ID and host
identifier. This needs to be done so that only the owner can purge the file later.

4. After the task is completed, the lock file is deleted.
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Example FileWatcher

FileWatcher scans a file and sends it for processing. After the file is processed, the file is
moved to the done folder. If more than one FileWatcher threads attempt to process the
file, concurrency issues may occur.

To prevent concurrency issues:

« Before FileWatcher picks up a file for processing, a lock is placed on the parent
directory. This way, only one FileWatcher can pick up files from one directory. The
FileWatcher locking synchronizes access to a directory for multiple FileWatcher
threads.

« After the file is processed, the file lock is released.

o When the FileWatcher thread starts, it checks for any abandoned lock files for the
available datasets. For example, lock files may have been left abandoned, as in the
following cases:

o The executing thread creates a lock file for a file.

o The application terminates before the thread has completed processing.

Deletion of Abandoned Lock Files

When a thread dies before a lock is released, it could result in abandoned lock files.
Purging such lock files is necessary. In a clustered setup, only the cluster member server
that created the lock can purge it later.

The Node ID information added to the lock file when it was created is used when purging
the abandoned locks during server startup time.

The server checks for an existing lock file. If the lock file exists, the server opens it, reads
the Node ID information, and determines whether it is the same instance on the same host
who created the lock file. If they are same, the server assumes that the lock was
abandoned and deletes the lock file.

Note: The abandoned lock can only be removed when the correct server comes
back up again. During the cluster member downtime other cluster members
cannot perform the scheduled task.

The lock files created can be deleted manually from the following directories:
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o Revivifier: $MQ_HOME /Work/MgRevivify.lock

o FileWatcher: Location specified in the FileWatcher.xml file.

Fault Tolerant Messaging Using EMS

You can set up the fault tolerant of the TIBCO MDM messaging system for a single server
or cluster using the TIBCO EMS messaging software. The EMS fault tolerant setup consists
of a primary EMS server and a standby or backup server.

The two servers share the data store (typically on the file system) containing client
information and the messages information. Initially, the primary server is active and the
backup server monitors the primary server. When the primary server (or the host machine
of that server) fails, the backup server will detect this and will become active. The
messaging client (TIBCO MDM) also detects that failure and will transparently reconnect to
the now active backup server.

Both the TIBCO MDM cluster and the EMS messaging software must be configured for this
deployment scenario.

EMS Server Setup

See the "Configuring Fault-Tolerant Servers" section from the TIBCO EMS User’s Guide for
details.

The configuration of the two EMS servers as a fault tolerant cluster involves configuring
both message server configuration files (for example: EMS-
Configuration/tibco/cfgmgmt/ems/data/tibemsd.conf). Both server names (property called
server) must be equal since they represent the same server. The configuration entry for
fault tolerance involve the properties starting with ft_*. The most important one is ft_
active, which will point to the network address of the other message server.

The other values (ft_heartbeat, ft_activation, ft_reconnect_timeout) can be left at default
values. During setup, the primary server should be started first and then the backup
server. The backup server should print a message similar to Server is in standby mode for
tcp://myhost:7222.

TIBCO MDM Setup

The EMS Cluster must be registered with TIBCO MDM. This is achieved by having multiple
entries separated by a comma in the Cluster Server List property for both the Bus (Topic)
and Queue setup.
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In addition to the primary EMS server (LocalhostServer), you need to add the second
server (Server2) to the Cluster Server List configuration value, which serves as a backup
server. You must define the Server2 Server Connection String and Server2 Server
encoding properties using Add New Property. Both must be string values.

Also, check the Failed Connection Refresh Flag and Failed Connection Replace
Optimization flags properties set as true.

Each TIBCO MDM server will retry several times to reconnect to the backup server in case
of a failure. Choose 6 connection retry attempts (Failed Connection Retry Count) and
10000 ms (or 10 seconds) time delay between attempts. These values work well with the
default EMS cluster setup. The delay should not be less than 10s. Choose the same value
for ft_activation in the EMS cluster setup. Also, the total time the TIBCO MDM Server
attempts to reconnect to the backup server (6 * 10seconds = 60 seconds) will not be useful
if it exceeds the ft_reconnect_timeout (by default 60 seconds).

Copy the EMS-Configuration\tibco\cfgmgmt\ems\data folder and rename the file, for
example, rename it to data_secondary, and use it for the secondary server.

The same procedure must be repeated for the TIBCO EMS Queue setup at InitialConfig >
Queue Setup > Cluster > TIBCO EMS.

Queue and Topic Setup

For Queue and Topic Setup, see the "Configuring Queues and Topics" section of T/BCO
MDM System Administration.

Testing Clustered Installation

For clustered installation, first test the application installation, test the application for load
balancing, and test the application and cache server for failover.

Procedure
1. Testing the Application Installation

a. Login to TIBCO MDM.
b. Create an enterprise.

c. Create a repository in the specified enterprise.

o

. Upload data into the repository.
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2. Testing the application for load balancing
a. Verify that clones are working individually.

b. Start the web browser and verify the following URLs:

http://NodeB:<port#>/eml/Home
http://NodeC:<port#>/eml/Home
http://NodeB/eml/Home

(The IBM HTTP Server was installed on this node.)
e You can now check the load balancing for the TIBCO MDM cluster.

a. Access TIBCO MDM using the http://NodeB/eml/Home URL from different
browsers and with different user accounts.

b. Observe the details regarding which server receives the request and how both
servers are loaded by viewing the http_plugin.log file located on Node B.

3. Testing the Application for Failover Without Session

a. Access TIBCO MDM from two different browsers by entering the

http://NodeB/eml/Home URL. Both the servers, for example, TIBCO MDM1 and
TIBCO MDM2 serve one request each.

b. On the first browser (assuming this request is being served by TIBCO MDM1),
click Add record for master catalog. Enter the product ID, short description,
and other information. Stop the TIBCO MDM1 server from the Deployment
Manager and then click Save. TIBCO MDM2 server’s Login page is displayed.

c. Enter your user ID and password to continue working with TIBCO MDM.

<UriGroup Name="default_host_veloselcluster_URIs">

<Uri AffinityCookie="JSESSIONID"
AffinityURLIdentifier="jsessionid" Name="/eml/x" />

<Uri AffinityCookie="JSESSIONID"
AffinityURLIdentifier="jsessionid" Name="/emlservlet/x" />
</UriGroup>

4. Testing Failover of Cache Server

a. Set up the Cache server on an external box. For more information about the
Cache server, see Apache Ignite.
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b. Ensure the Cache server parameters are set in the application server startup
scripts.

c. Add the activity to the list of sleep activities and set the sleep time. You can do
this using the Failover Setup category in the Configurator.

d. Add a record through the Ul to initiate a workflow.

e. While the activity is sleeping, shut down the cache server that is running on
the external box.

f. The Elink log shows a Cache server related error.

g. The Elink log also shows that the activity is retrying according to the
parameters configured in the Configurator.

h. Bring up the Cache server while the activity is retrying. The workflow should be
executed successfully.
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Support for Language Pack

TIBCO MDM supports the following languages for translation:
o French
e German
o Japanese
o Latin Spanish

o Simplified Chinese
The language packs are available at the TIBCO eDelivery site under the product, TIBCO
MDM. A language pack is a JAR file, which contains translations of the TIBCO MDM GUI in a
specific language. The JAR file contains all Java based resource bundles. The language
pack file naming convention is TIB_cim-1p_releaseversion_languagepack-locale.jar.
For example, the Simplified Chinese language pack for the TIBCO MDM release consists of
a JAR file named TIB_cim-1p_releaseversion_languagepack-zh-CN.jar.

Download the JAR file of the language pack that you want to install. You can install the
language pack using the Configurator. For installation, see Installing Language Pack.

Installing Language Pack

Before you begin
« Download the JAR file of the language pack that you want to install.

o Ensure that the following environment variables are properly set:
o SMQ_HOME: The TIBCO MDM install location.
o SJAVA_HOME: JDK 7 or later.
o SMQ_COMMON_DIR: The TIBCO MDM Common directory.

Procedure

1. Login to Configurator.

2. Navigate to Tools > Language Pack Installer.

TIBCO® MDM Installation and Configuration Guide


https://edelivery.tibco.com/

242 | Support for Language Pack

The Install or Uninstall Language Pack window is displayed. By default, the Install
option is selected.

|
Install or Uninstall Language Pack

@® Install © Uninstall

Select Language Pack @ Browse

Finish Cancel

3. Click Browse and select the JAR file location of the language pack.

The selected language pack name is displayed on the Install or Uninstall Language
Pack window.
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|
Install or Uninstall Language Pack

@® Install < Uninstall

SelectLanguage Pack @ Browse | TIB_mdm-Ip_8.4.0v03_languagepack-zh_C

N_jar ( 281.10 kB )

Finish Cancel

4. Click Finish.

The Language pack installed successfully message is displayed.

o The content of the JAR file is copied to the SMQ_COMMON_
DIR/Work/resources/tiblp.jar file.

o The language code entry is made in the $SMQ_COMMON_
DIR/Work/languagePack/prop/lang.properties file.

Note: If you have installed JBoss WildFly Application Server, create the
JBoss module as mentioned in Module Creation, and then perform the
following tasks:

o Copy the tiblp.jar file from SMQ_COMMON_DIR /Work/resources into
the $JBOSS_
HOME /modules/system/layers/base/com/tibco/mdm/maindirectory.

o Open the module.xml file and add the following entry in the
<resources> tag:

<resource-root path="tiblp.jar"/>
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What to do next
Restart the application server manually, where TIBCO MDM is deployed.

Uninstalling Language Pack

Before you begin
Stop the application server.

Procedure
1. Login to Configurator.

2. Navigate to Tools > Language Pack Installer.

The Install or Uninstall Language Pack window is displayed.

3. Select the Uninstall option.
The installed languages are displayed in the Select Language Pack drop-down list.

B Bl
Install or Uninstall Language Pack

) Install @ Unlinstall

SelectLanguage Pack @ ' Chinese (Chi ,'

Finish Cancel

4. Select the language that you want to uninstall.

5. Click Finish.
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The Language pack uninstalled successfully message is displayed.

« The property files of the selected language pack are deleted from the sMQ_
COMMON_DIR /Work/resources/tiblp.jar file.

o The language code entry is removed from the $MQ_COMMON_
DIR/Work/languagePack/prop/lang.properties file, thatis, tiblp.jar is
regenerated without deleting the resource bundles.

Note: For JBoss WildFly Application Server, copy the newly generated
tiblp.jar to $JBOSS_

HOME /modules/system/layers/base/com/tibco/mdm/main folder.

What to do next
Restart the application server manually, where TIBCO MDM is deployed.
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GDSN Overview

Global Data Synchronization Network (GDSN) functionality is provided through a GDSN
plugin component.

Most of the functionality between MDM and GDSN is common. The GDSN plug-in provides
incremental functionality specific to GDSN. This plugin includes GDSN specific workflows,
maps, rulebases and so on. GDSN specific screens and functionality will not be available
with MDM edition.

You can use the following features of the GDSN Plugin:

CIM to CIM Synchronization
Creation of Enterprises of type Integration Hub, Retailer
Default catalog formats and user accounts for a trading partner

GDSN related Data (such as output maps and catalog formats specific to 1Sync and
AS2)

Incremental Resource Bundles

o Note: When the GDSN plugin is installed, resource bundles are not switched

automatically. This is to enable the MDM installation to continue using the
terminology even if the GDSN plug-in is installed. You can switch the language
bundle through the Software Edition property.

Installing the GDSN Component

As per your requirement, you can install the GDSN plugin over the main MDM version of
TIBCO MDM.

Procedure

1.

2.

Extract the archive the product was delivered in.

Run the TIBCO Universallnstaller application. This starts up the Universal Installer
through which you can install TIBCO MDM GDSN Plugin.
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After a short delay while the installer initializes, the Welcome dialog is displayed.
Review the information in the Welcome dialog and click Next.

3. The License Agreement dialog is displayed. Review the terms of the license
agreement and, if you agree to them, click I accept the terms of the license
agreement. Then click Next to continue with the installation.

The Installation Type dialog is displayed. By default, Typical will be installed.
4. Click Next. The Environment Type dialog is displayed.

A TIBCO installation environment is used for software installations and consists of a
Name and Directory. Products installed into different installation environments do
not share components; therefore you can keep product installations completely
isolated from each other.

Note: Since the GDSN component is an add-on component to MDM,
ensure that you provide the MDM environment here. If you provide a
different path, an error is displayed.

5. Click Next. A list of the components that will be installed, the location where they
will be installed, and the total size is displayed.

6. Click Install for installation to proceed. The progress and the final results are
displayed.

7. Click Finish to exit the wizard.

GDSN Configuration Merging

After installing the GDSN plugin (over the MDM version), you need to merge the
configuration. This is automatically done when you run the migration wizard, and this is
the preferred way to migrate configuration.

o Note: You can only migrate MDM - MDM and GDSN - GDSN through the
migration tool.

Utility to Merge GDSN Configuration

If you need to merge configuration manually, use these utilities:

TIBCO® MDM Installation and Configuration Guide



248 | GDSN Overview

$MQ_HOME /datapool/bin/gdsnxmlPropMergeUtil.sh $MQ_
HOME /datapool/bin/gdsnxmlPropMergeUtil.bat

Usage

<gdsnxmlPropMergeUtil> -GDSN -prop <MDM XML configuration file> -xmlin
<GDSN configuration XML file> -xmlout <Output configuration XML file>

GDSN Specific Properties

The configuration properties are specific to GDSN.

GDSN Specific Configuration Properties

Property Configuration
Outline

Software Edition- Basic

>Application Usage

Profile

Software Edition- Advanced

>Common Menus
Configuration

Integration Setup - All
External->Connector

Rulebase

Rule Base- Advanced

>Synchronization Format
Specific Attributes File

Rule Base->Send Message Advanced

Screen Rulebase File

Rule Base->Work Item Advanced
Description Rulebase File

Description

Defines whether the application is used for data
synchronization (GDSN) or master data
management (MDM)

The configuration file location for common
menus (navigation bar).

The rulebase to identify the protocol (for
example, VELOSEL).

Name of the Rulebase file used to customize
format specific attributes on the synchronization
profile View/Edit page.

The name of the rulebase file used to customize
record attribute display on the SendMessage

page.

The name of the rulebase file to customize work
item messages.
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GDSN Predefined Components

For GDSN, a set of predefined components such as maps, rulebases, workflows, and
templates are shipped with the application.

All these components are present in relevant folders under $mMQ_
HOME /datapool/common/standard

For details, see Standard Predefined Components.
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About TIBCO MDM Studio

TIBCO MDM Studio is a separate application, using which you can graphically design
processes and repositories and later import in TIBCO MDM.

TIBCO MDM Studio comprises the following four components:

o Process Designer

Processes once designed in the Process Designer, can be deployed directly in TIBCO
MDM, without the need to manually export your process and import it into TIBCO
MDM.

Additionally, you can also import existing TIBCO MDM processes for modification
and subsequent re-export. This is particularly useful for customers with existing
processes which need to be modified or tweaked.

TIBCO MDM currently supports processes defined as XML. TIBCO MDM Studio
generates XPDL files that get converted to XML when you export. The XPDL is
validated before being translated into native TIBCO MDM workflow format.

e Repository Designer

The Repository Designer is based on TIBCO Business Studio and acts as an 'add on'
component to Business Studio. The Repository Designer adds a visual element to
designing repositories and makes the process quicker and more intuitive.

o Rulebase Designer

The Rulebase Designer provides a graphical user interface for designing rules. The
Rulebase Designer can be used to define rules from scratch or to edit existing TIBCO
MDM rules.

o Ul Builder

TIBCO MDM Ul Builder is a new tool that has a cleaner, simpler, and more flexible Ul
in TIBCO MDM. TIBCO MDM Ul Builder allows you to quickly, easily, and uniformly
develop custom Uls by using simple drag and drop methods.

For more details, see TIBCO MDM Studio Process Designer User's Guide, TIBCO MDM Studio
Repository Designer, TIBCO MDM Studio Rulebase Designer, and TIBCO MDM Studio Ul Builder
documentation.
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Configuration of TIBCO BusinessConnect™ and TIBCO
BusinessWorks™

You can configure BusinessConnect™ for sending documents to and receiving documents
from different data pools.

See the appropriate documentation if you wish to use any other AS2 Gateway.
BusinessConnect™ 5.x supports JMS, however the TIBCO BusinessWorks plugin for
BusinessConnect™ 5.x is still required.

Prerequisites

o BusinessConnect™ 5.3.0 must be installed on the system. See the TIBCO Business
Connect documentation for details.

« A database must be installed. BusinessConnect 5.x supports Oracle, MySQL and SQL
Server database servers.

e TRA 5.6.1, TIBCO BusinessWorks 5.7.2, TIBCO Administrator 5.4.0, TIBCO EMS 5.1.2
must be installed on the system.

o UserID and password to access the BusinessConnect™ Admin console.

o Port 4080 or any other port on which BusinessConnect™ is listening needs to be
opened.

Setting up TIBCO Administrator

You need to set up a TIBCO Administrator to work with BusinessConnect.

Procedure
1. Install TIBCO Administrator in console mode, read the Installation guide.

2. For Linux and UNIX setup, create Domain using domain Utility TIBCO_TRA_
HOME/bin/domainutility.

o Set defaults settings, give domain names as: DOMAIN_NAME/, choose UTF-8 for
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character set, default ports -> http port=9090, AJP 1.3 port =8009, shutdown
port =8005, username=admin, password=admin

o If UTF-8 doesn't work, change the characters to other character set

o Change the owner to vsadmin and give all rights to tibco folder as -

sudo chown -R vsadmin:vsadmin /home/tibco/
sudo chmod -R 777 /home/tibco

3. On Windows, you can create a new domain using Programs > TIBCO > TIBCO
Runtime Agent & Adapter SDK 5.5 > Domain Utility.

4. After successfully configuring TIBCO Administrator, start TIBCO Administrator by
executing the following on Linux or UNIX platform: STIBCO_
HOME/administrator/domain/DOMAIN_NAME/bin/tibcoadmin_DOMAIN_NAME/ &

5. Start TIBCO Hawk Agent by executing the following on Linux / UNIX platform:
STIBCO_HOME/tra/domain/DOMAIN_NAME/hawkagent_DOMAIN_NAME/&

6. For Windows installations start TIBCO Hawk Agent must be started as NT service.
7. On Windows setup TIBCO Administrator must be started as NT service.

8. Access the administrator url as
http://machinename:9090/administrator/servlet/tibco_administrator

BusinessConnect™ Setup

You can configure BusinessConnect™ through a new configuration or import an existing
setup from another installation and customize the imported BusinessConnect™
configuration.

Prerequisites

« Database and Database user. A Database (which can be used by the
BusinessConnect™ setup) should be configured.

o« TIBCO EMS TIBCO EMS 5.1.2 should be installed and started as an NT service on
Windows; on Linux it should start on root.

« Install Unlimited Strength JCE Policy Files To use BusinessConnect™ security
features, download and install JavaTM Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files 1.5.0. To download and install the policy files,
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perform these steps:

o Download the required files from the Oracle and IBM web sites for Windows,
Linux, Sun Solaris, and HP-UX.

o Unzip jce_policy-1_5_0.zip

o Copy US_export_policy.jar and local_policy.jar t0:$STIBCO_
HOME\jre\1.5.0\lib\security

o TIBCO Administrator and TIBCO Hawk TIBCO Administrator and TIBCO Hawk should
be started.

Configuring New BusinessConnect™

Create a new BusinessConnect™ configuration.

Procedure

1. Start TIBCO Administrator (http://machinename:9090/administrator/servlet/tibco_
administrator).

2. Login as admin for both user name and password.

3. Check if the BusinessConnect™ link appears in the left side panel. If not, click
Application management > All service instance > machine name > Plug-Ins >
Add and browse to the bcwebadmin.war file of BusinessConnect™. The WAR file can
be found on:T18Cc0_HOME/bc/5.3/admin-plugins/ bcwebadmin.warAdding the .war file
takes some time.

4. On the left side panel, BusinessConnect™ option is available. Click BusinessConnect
> Manage Installation.

5. In the Manage Installation window, specify the database details for installation and
test connection for Oracle. The sample database details are:

o JDBC Driver: tibcosoftwareinc.jdbc.oracle.OracleDriver

« JDBC URL: jdbc:tibcosoftwareinc:oracle://oracleservername:1521;SID=DATABASE_
NAME

6. Click Test Connection and Done if successful.
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Creating Participant of Type Partner

After creating a new BusinessConnect™, create a participant of type Partner.

Procedure
1. Click BusinessConnect > Participants.
2. Select Partner in the Participant Type drop-down list and specify a name to the
participant in the Participant Name field. Click OK.
3. In the General tab, specify all relevant details, select the Active check box to activate
the participant.
4. In the New Certificate tab, specify the alias name and upload the certificate provided
by the Trading partner (Data pool in case of TIBCO MDM). Click Save.
5. In the Protocols tab, click the Enable tab and select the EZComm protocol check
box and click OK.
6. In the Protocols tab, click the newly enabled protocol EZComm.
7. In the Edit Enabled Protocol:EZComm window, click the Add New link to create a
new AS2 ID.
8. In the New window, select the newly created AS2 ID and specify the new AS2 ID. Click
OK.
9. In the Edit Enabled Protocol:EZComm window, click Transports > Add tab.
10. In the New Transport tab, select AS2_HTTP in the Transport Type drop-down list
and specify the transport name. Click OK.
11. In the Edit AS2_HTTP Transport window, enter the details for the newly created
transport. Change the URL as per the trading partner specification.
12. In the Proxy Settings tab, keep the default proxy settings as is.
13. Click Save to save the Participant.

Creating Participant of type Host

After creating a participant of type Partner, create a participant of type Host.

Procedure
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Click BusinessConnect > Participants.

Select Host in the Participant Type drop-down list and specify a name to the
participant in the Participant Name field. Click OK.

In the General tab, specify all relevant details, select the Active check box to activate
the participant.

Click CredentialsNew Private Key tabs. Specify the alias of the key, upload the private
key (public key of which has been sent to the Partner). Click Save.

In the Protocols tab, click the Enable tab and select the EZComm protocol check
box and click OK.

In the Protocols tab, click the newly enabled protocol EZCommAS2 Identifier > Add
new link. In the AS2 Identity field, specify GLN on the data pool. Click Save to save
the Participant.

Creating New Operations

After creating a participant of type Partner, create a participant of type Host.

Procedure

1.
2.
3.

10.

Click BusinessConnect > Operations Editor.
In the Operations Editor window, click Edit for the EZComm protocol.

In the Edit Operations: EZComm window, click the New Category tab and select
EZComm protocol and save the new category.

Click New Version to create a new version for the new category. Specify details and
Save the version.

Click the New Operation tab to create a new operation for this version.

In the Operation Type drop-down list, select Asynchronous Request-Response and
click OK.

In the Asynchronous Request-Response tab, enter a name for the new operation.

In the Request Action tab and select the Require Digital Signature and Require
Content Encryption check boxes.

Click the Response Action tab and select the check boxes as previously mentioned.

Click Save to save the newly created operation.
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Specifying System Settings

Specify the system settings for the newly created BusinessConnect™.

Procedure
1. Click the BusinessConnect > System settings.
2. Click JDBC Configuration in the right pane.
3. In the New JDBC Connection window, specify new JDBC connection details for
BusinessConnect™. Sample database details are:
o JDBC Driver Class: tibcosoftwareinc.jdbc.oracle.OracleDriver
o JDBC URL: jdbc:tibcosoftwareinc:oracle://localhost:1521;SID=bcdbDatabase
User: bcuserPassword: bcuser
4. Click Test Connection, if the connection is successful click Save.
5. In the Edit System Settings: JDBC Configuration window, select the newly created

BusinessConnect™ connection in Audit Logs, Non Repudiation Logs, Runtime Data
Store and click Done.

Creating Business Agreement

Create a business agreement.

Procedure

1.
2.
3.

Click BusinessConnect > Business Agreement.
Click the New tab to create a new Agreement.

In the New Agreement window in the Host party and Partner party sections, select
the names for which you want to make an agreement and click OK.

In the Business ConnectBusiness Agreements window in the New tab, click the newly
created agreement.

In Edit Agreement window,
o Select the Valid check box.
o Select dates for the start and end of the agreement.

o Click the Add Protocol Binding tab and select EZComm from available
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protocols to add a new protocol binding.

o Click the EZComm protocol link and specify the details.

6. In the Edit Protocol Binding: EZComm window, click the Document Security tab and
select the following values:

o Signing Key: Name of the TIBCO’s private certificate.
o Digest Algorithm: MD5
o Encryption Certificate: Name of Trading Partner Certificate
o Encryption Algorithm: Encryption algorithm used by Trading Partner
o Verification Certificate: Name of Trading Partner Certificate
o Decryption Key: Name of the TIBCO'’s private certificate
7. Click the Transports tab and select the following values:
e Primary Transport: 1SYNC_AS2
o AS2 MDN Async Reply Transport: 1SYNC_AS2
o AS2 Remote Server Certificate: 1Sync-PreProd-Certificate
o Client Authentication Identity for HTTPS, FTPS, HTTPSCA: TIBCO_private_key
o Client Authentication Identity for SSHFTP: None

8. Click Save.

Deploying the BusinessConnect™ Configuration (Single Server
Mode)

Deploy the newly created BusinessConnect™ configuration in a single server mode.

Procedure
1. Deploy the configuration, click Administrator > BusinessConnect > System Settings
> Deployment Configuration, click Create deployment Configuration.
The Business Connect link appears in Application Management.

2. Select a computer to deploy the BusinessConnect™ installation.

3. Click Application Management > BusinessConnect > Configuration > Single
Server.par.
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10.

11.

Select the computer name. If you do not see the computer name, it may be due to
the hawk agent.

Select Application Management > BusinessConnect > Configuration >
BusinessConnect > Configuration and click Save.

Click Application Management > BusinessConnect > Configuration > Business
Connect > HTTP.

a. In the Edit Transport Settings: HTTP, ensure the port is enabled and a proper
value is provided.

Click Application Management > BusinessConnect > Configuration >
BusinessConnect.

In the Edit Application Configuration: computername window, click the Private
Process Configuration tab and select the JMS option.

a. Click the JMS link and specify the following JMS details:

o JNDI Context Factory: com.tibco.tibjms.naming.TibjmslInitialContextFactory
o JNDI Context URL: tcp://localhost:7222

e Topic Connection Factory: TopicConnectionFactory

e Queue Connection Factory: QueueConnectionFactory

a. After completing all details click Test connection to test the JMS connection.
Save the details, if the test connection is successful.

Click Application Management > BusinessConnect > Configuration >
BusinessConnect > Deploy.

a. Click the Deploy tab. In the Deploy Configuration window, ensure that the
Start successfully deployed services check box is selected.

b. Check the status of BusinessConnect™ availability.

Click the Application Management > BusinessConnect > Service Instance. The
BusinessConnect instance status is displayed as either stand by or running.

If the deployment BusinessConnect™ instance is not started, click Application
Management > BusinessConnect > Service Instance > BusinessConnect instance
check box and click Start.

If everything is successful, the BusinessConnect™ instance must be in the running
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state.

If the BusinessConnect™ instance does not start successfully, check the TIBCO
Administrator logs (T18C0_HOME administrator\domain\DOMAIN_NAME\logs\audit.txt)
to find the cause.

Setting up TIBCO BusinessWorks

Set up TIBCO BusinessWorks and import your project.

Prerequisites

« Before you start a BW project, create a directory as follows: T78c0_

HomE\fsjndi\designerExtendedJars

« Copy the following JAR files inside the newly created directory:

o
fscontext.jarjndi.jarproviderutil.jar

o Open the designer.tra file located in T1BCc0o_HOoME\designer\5.5\bin and add following

entry: tibco.class.path.extended %CUSTOM_CP_EXT%%PSP%%STD_CP_EXT%:TIBCO_
Home/fsjndi/designerExtendedJars

Procedure

1.
2.
3.

Start TIBCO Designer.
In the Project tab, click New empty project.

In the Save Project window, select the project directory and TIBCO messaging
encoding.

Click Project > Import Full Project.

Import vcrepo.dat from the existing BW project directory (directory of the same
name as your existing BW configuration).

Alternately, if you do not want to import the existing project, copy the existing BW
project directory with another name. This is similar to importing the existing BW
project.

Edit the project as mentioned in the step 5 and 6.

Change the following global variables per the project requirement:
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« bindingFile: Provide the directory location where you want to place your
binding file for this project.

o receiveFile: Provide the directory location where you want received messages to
be saved.

o hostName: Provide the name of the Participant which you configured in BC as
Participant of type Host.

« tpName: Provide the name of the Participant which you configured in BC as
Participant of type Partner.

Sample values are as follows:

Project Edit View Resources Paleftes Mult-User Tools Window Help

BaB XA x=Gdap|BEENDE=FES

Deplanant=
- H8I DirLedger=""
~fBL DirTrace=""

“CimProtesses] Sane-00E50E5555551"

~HBI HawkEnabled = "false"

HIBI JrneProviderUr = "tep:ilocalhost 7222°

--fBL JmsSsIProviderUr = "sslMocalhost 7222

[l RemateRvDaeman=""

{8l RvDiaemon = "tep 7500

MBI RyMetwark ="

~fBL RvService = "7500"

-HIBI RvaHost = "localhost'

-HBL RvaPort = "7E00"

fI8L TIBHawkDaemaon = "tcp:7474"

- HBL TIBHawkNetwork = "

--[BL TIBHawkService ="7474"

B Cin

A(-HBL bindingsFile = "filedC/BWW-Projectsisindii Sync-0085085555551" )
+ Tl eveniGiuete = "Velosel_Quede_StandardInigrevent

qﬁ hostNarne = Tibco-Dev-I0RADEEEE5551" )

inboundGueue ="Yelosel_Gueue_Standardinboundintgridsg”

-+ HBI outhoundQueue = "velozel_Queus_StandardOutboundintgrisgy’
-84 parse0utboundhisg = "false”

receivedFile ="CUBW-ProjectsiCimProcesses! Syne-006506555555 receivedire ceive x
“| B[ tpkame = "1 Sync-AS52-A3801 60030003"

Palettes | Tester| Global Variables | Project

9. Click the Project tabShared Connection. If you already have a BusinessConnect
connection configured, update the connection.

10. Click Update from Configuration Store.
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11. Select the Select operations check box; click OK on the next page.

12. Click Import selected Business Protocol.

13. In the BusinessConnect Server Access tab, click Update from Configuration Store
followed by Import Selected Business Protocol.

14. In the JMS tab of the previous page, click Update from Configuration Store followed
by Import Selected Business Protocol.

If you have created a new BusinessConnect connection, ensure the property ‘Server
Details’ of all the activities to a valid BC connection. A sample activity ‘Send Request
to TP’ of process ‘Send to TP Process’ is as follows:

Browet Edil Yiew Resources Paiees Muih-User Tools Window Helo
Ba@EDix 5042k EEKEELHEE S
& 13 GonProcestestams- 0005065585551 # Processes Outbouna/Send to TP pracess [=]
N -
& & .
: B - — @
- = £ Inbouna .—_‘:__},__—4' o
i s R genvaaaors 2 = e
5 4o Recas tncaptacos toe TR rogquest -
o Receive rctptbmeoun aces e
_a s Fecet resoonse hom TP (1) Fecebm rurs -
S o Fecons securty s Ao =
o & 2 dutbound | £ E
g o Send 1 TP proces~ |
2 recownd | Sema aqnst o TR
gnaeed Connections
i ]
i 55 ME Conneston
L Shieed Patiitae
e |
Procass Deinsion L -]
reces i
T banseaxii ot a1 Send Request to TP {Send RequestiNotification} ()]
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Bescigion
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[msion O

15. Start the test engine by clicking the Tester tab on the left side followed by a green
start signal.
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)) Select Processes to Load

£
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=25 Outhound Clear Al
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Cancel

16. Click Load selected. After a successful start, all processes should be visible.
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Testing Connectivity of TIBCO MDM BusinessWorks

BusinessConnect

After the entire configuration is done, you can test the connectivity of TIBCO MDM
BusinessWorks BusinessConnect.

Prerequisites

o Have a ready to publish catalog in TIBCO MDM.

« In TIBCO Designer, ensure the BW tester is running, check for
Processes\Outbound\Send To TP Process, and all setup done.

« The Binding file accessed by BW setup must have the IP of the machine from where

testing must be done.
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e The BC engine should be running and all setups should be done.

Procedure

1.
2.
3.

Open TIBCO Administrator.
Publish product from TIBCO MDM.

Check BW for Processes\Outbound\Send To TP Process, whether the message
received, as the activities flow shows green.

Check TIBCO Administrator for BC, in Log Viewer, for Audit Logs, for selected time
range, whether the message reached and whether the message went out to the
trading partner.

Check for acknowledgement from the datapool.

Check for response in BC, BW and TIBCO MDM eventLog.

TIBCO BusinessConnect EZComm Protocol does not record advisory messages, such
as the Responder Acknowledgement, in the audit log.
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Upgrade to TIBCO MDM

You can upgrade from a previous release of TIBCO MDM to the current release. See the
Release Notes for additional information.

Use the following options if you are migrating to release 9.3.0 from an earlier release.

o Use the Migration Wizard

The Migration Wizard provides an easy to use interface for migration. Use the
Migration Wizard for migrating from 9.0.x, 9.1.x, and 9.2.x versions of TIBCO MDM to
9.3.0. For details, see Migrating Using Migration Wizard.

o Use Individual Scripts

The TIBCO MDM Migration utility internally invokes a number of scripts which
perform migration of different components. These scripts are also directly available
to you, if you need to migrate any component individually. For details, see Manually
Migrating Individual Components.

Premigration Steps

The premigration steps are common irrespective of how you choose to migrate.

Procedure
1. Collect Data

Ensure you have complete information to upgrade to the release of TIBCO MDM
(Application server information, JMS information, Database information, and so on).

2. Stop and un-deploy the Existing Version of TIBCO MDM
Stop the application and un-deploy TIBCO MDM from the application server.

3. Change Database Type and Copy JDBC Related Libraries

Ensure that you change the database type in the Configurator (admin > Settings)
before migration. For example, if the database is SQL Server, change the database-
type to SQL Server. Additionally, copy the JDBC driver JAR file required for database
into $MQ_HOME/configurator/server/lib/ext. For information about downloading
or copying JAR files for each database, see the JDBC Related Libraries section in
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Third-Party Libraries.
4. Backup TIBCO MDM data

Backup the database schema, $MQ_COMMON_DIR, and application files (previous
version of $MQ_HOME) that has the previous version of TIBCO MDM data. You can
ignore or delete the Temp folder located at $MQ_COMMON_DIR before backing it up.

o Note: Though not mandatory, TIBCO recommends this structure to have a
consistent backup and binary deployment process of the product.

Create the following folder structure to create backup data:
e tibcocim/rep: refers to TIBCO MDM repository.
e tibcocim/backups: stores TIBCO MDM backup.
e tibcocim/binaries: stores copies of TIBCO MDM distributed binary JAR files.
5. Create Stable Data (Only for the Oracle database)

If you have installed the Oracle database, you need to create the stable data.

a. Navigate to $MQ_HOME/db/oracle/migration/PrerequisiteFor83 and run
CheckDataForConstraints.sql and CheckTableNames.sql files.

CheckDataForConstraints.sql: displays the data that is not stable or includes
the hanging pointers, such as the parent and child tables are related to each
other. However, only the child table has reference to the parent table, and the
parent table does not have reference records. In such cases, remove or add
the data in the parent table.

CheckTableNames.sql: displays TIBCO MDM reserved table names, constraint
names, and indexes names if already exists. Rename the duplicate table
names, and run the migration.

6. Set Environment Variables

a. The SNODE_ID variable must see the previous environment and the $MQ_
CONFIG_FILE variable point to the current environment.

b. The $MQ_HOME must point to the new environment.

7. Install Hotfix

If you are migrating from the 9.0.x, 9.1.x, and 9.2.x versions, ensure that the previous
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version has the latest released hotfix installed.

8. Copying Optional files

To migrate optional files from the config folder and $MQ_HOME of the previous
installation to the new installation, set the properties to true in (current TIBCO MDM
version) $MQ_HOME /config/migrateConfigFolderFiles.prop. For example,

a. To copy allmenu.xml and defaultdata.xml files from the previous installation
to new installation, set the file path and its value as follows:
config/security/allmenu.xml= true and config/security/defaultdata.xml=
true

b. To copy CronSchedules.xml file from the previous installation to new
installation, set the file path and its value as follows:
config/CronSchedules.xml=true

c. For TIBCO MDM Add-on for GDSN, by default the plug-in folder is copied from
the previous installation to the new installation. If you do not want to copy the
plugins folder, set the plugins=false.

9. Upgrade to Microsoft SQL Server 2016 Database

Upgrade to Microsoft SQL Server 2016, and then follow the database migration
process.

Migrating Using Migration Wizard

A Migration Wizard provides a graphical user interface to help users migrate from the
previous versions, such as 9.0.x, 9.1.x, and 9.2.x versions of TIBCO MDM to the latest
version.

Migration done through the wizard includes migration of rules, database,
ConfigValues.xml, FileWatcher.xml, CacheConfig.xml, and other dependent files (such
as workflows, maps, and rulebases).

Procedure
1. Login to the Configurator.

2. Go to Hi, [username] > Settings.

Change the database as per your requirement.

3. Go to Tools > Migration Wizard.
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4. In the Specify Upgrade Details page, specify the upgrade details. This page handles
version and edition to which migration should be done.

a. The New Installation section displays the following fields:

Location (MQ_HOME): This is the installed path of your new version; your new MQ_
HOME location is automatically detected.

o Note: On Windows operating systems, while specifying the path, you
can use a backslash (\) as well as a forward slash (/).

Version: The latest version to migrate to is also detected.

GDSN enabled: By default, this is set to No, unless you have installed the GDSN
plugin in which case it will be set to Yes. This is a read only value and cannot
be changed.

. The Previously Installed Version section displays the following fields:

Location (MQ_HOME): Select the previously installed TIBCO MDM location.

Version: This is the version you are migrating from. The following options are
displayed in the drop-down list:

e 9.0.x:refers to 9.0.0 or 9.0.1
e 9.1.x:refers to 9.1.0

o 9.2.x: refers to 9.2.0

GDSN enabled: Select Yes if your previous version was GDSN.

a. Click Next.
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o Note:

o For the GDSN Edition, first you must migrate MDM to MDM,
install the GDSN latest version, and then run Add-on Plug-in
Installer.

o If the plugins=false is setin the
migrateConfigFolderFiles.prop file located at $MQ_
HOME/config, then copy the plug-in directory from the
previous MQ_HOME to new MQ_HOME directory.

« If you have previously installed GDSN version, an alert
message is displayed. Install GDSN Add-on plugin or change
the edition to MDM edition.

5. In the Identify Location page, specify existing and new common directory (MQ_
COMMON_DIR) and configuration (ConfigVvalues.xml) information.

o New MQ_COMMON_DIR path (the latest version MQ_COMMON_DIR directory)
o New ConfigValues.xml path (the latest version ConfigVvalues.xml location)

o Existing MQ_COMMON_DIR path (previous MQ_COMMON_DIR directory)

ﬂ Note: If the existing path of MQ_COMMON_DIR is set in the environment
variable then it is populated or else by default, the new MQ_COMMON_
DIR path is displayed. Manually enter the existing MQ_COMMON_DIR
path.

o Existing ConfigValues.xml path (previous version ConfigValues.xml location)

Click Next.

o Note: Ensure that you have specified the correct paths for successful
migration. In some cases, if you enter incorrect paths (for example,
for Configvalues.xml) during migration, the migration summary
shows Successfully migrated messages even when the migration is
not successful and errors are seen in $MQ_
HOME/log/configValues. log.

6. In the Select Migration Type page, select the migration type. You can optto do a
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complete migration or a custom one where you select the components.

a. Complete Migration: If you choose to do a complete migration, all
components are migrated, except rules which need to be migrated separately
(this is because the TIBCO MDM server needs to be up before migrating rules).

b. Custom Migration: In a custom migration, select from the following
components:

o Database

e ConfigValues.xml

o Dependent files (migration of workflows, FileWatcher.xml, rules, and so
on.)

o GDSN Add-on files (if applicable)

c. Rules Migration: If you choose rules migration, custom processes are
migrated, default template and new process selection rules are added.

o Note:

o Before running the rules migration, you need to perform the
prerequisites. For information, see the section, "Rules
Migration" in Manually Migrating Individual Components.

o For rules migration, ensure that TIBCO MDM server is up and
running.

e Previous MQ_COMMON_DIR is updated during migration to the
latest version. You must use the latest version MQ_COMMON_DIR.

o New ConfigValues.xml is updated during migration to the
latest version. You must use the latest version
ConfigValues.xml.

7. In the Database Migration page, specify the following details of the existing
database:

Note: This dialog is only displayed if you have selected the Complete
Migration option or if you have selected Database as a component under
Custom Migration option in Step 5.
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Database Host: Specify the database host name or IP address.
Database Port: Specify the database port.

Database Name: The database name.

User Name: The user name for the database.

Password: The password for the database.

MDM Tablespace: Name of the tablespace. For example, VELODBDATAL. This
field is enabled only if you have selected the Oracle database type.

8. Click Finish to start the migration.

If any one of the following components failed to migrate, an error message is
displayed:

Database

ConfigValues.xml

Dependent files

GDSN add-on files

9. In the Error window,

a. Click Open to view the logs.

b. Click Abort to stop the migration.

Result

c. Click Ignore to continue the migration.

o Note: You can ignore errors, such as dropping non-existing tables, views,

triggers, and so on; displayed during database migration. Such errors are
displayed in the database migration log located at $MQ_
HOME/db/database_type/migration/databaseMigration.log.For
example,

ERROR:-Cannot drop the index 'MV_SHARED_BOOLEAN_TABLE.MV_
SHARED_BOOLEAN_TABLE_IDX', because it does not exist or you
do not have permission.

A summary of the migration is displayed along with output logs, which can be
downloaded.
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Manually Migrating Individual Components

Individual scripts for each component migration are also available in the $MQ_
HOME/bin/migration folder. If you want to migrate an individual component, you can run
each script separately.

Compone Script Name Usage
nt
Database = $MQ_HOME/bin/migration/DatabaseMi- Use this utility to migrate the

gration.bat/sh database from the previous

version to the new version.

Migration

DatabaseMigration -path
DBProviderName
DatabaseName UserName
Password ServerName

Where

e path can be: -90_93, -
91 93, or-92_93

e DBProviderName can
be: ORACLE or
SQLSERVER,

e ServerName is
database-instance-name
or database-ip. If you
installed the Oracle
database, then
ServerName is not
required.

For PostgreSQL:
DatabaseMigration -path
DBProviderName PGHome
HostName Port
DatabaseNameUserName
Password

Where DBProviderName is
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Compone Script Name Usage
nt
PostgreSQL.
Configura o For MDM: $MQ_ Use this utility to migrate
tion HOME/bin/migration/ConfigValuesMe  configValues.xml from the
Migration rgeUtil.sh/bat previous version to the new
o For GDSN: $MQ_ version.
HOME /plugins/gdsn/version_ <ConfigValuesMergeUtil> -
number path -prop <version XML
/bin/gdsnxmlPropMergeUtil.bat configuration file> -xmlin

<Source configuration XML
file> -xmlout <Output

configuration XML file>
Where,

e path can be: -90_93, -91_
93, or 92_93

e <version XML
configuration file> is
the previous version of
ConfigValues.xml with
an absolute path

e <Source configuration
XML file> is the new

version of
ConfigValues.xml

e <Output configuration
XML file> is the
absolute path to an user
ConfigValues.xml file.

For example, $MQ_
HOME /config/Migratio

n_Config_Values.xml.

After migration, back up
the new
ConfigValues.xml file,
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Compone Script Name Usage
nt

and then rename the
Migration_Config_
Values.xml file to
ConfigValues.xml to
use it.

o Copy the
hibernate3.jar file

from $MQ_
HOME\lib\external\hib

ernate to $SMQ_
HOME\lib\external of
the latest version.

(when merging MDM and GDSN
Configuration)

<gdsnxmlPropMergeUtil> -
GDSN -prop <9.1 MDM XML
configuration file> -xmlin
< 9.1 GDSN configuration
XML file> -xmlout <Output
configuration XML file>

Configura « Indexer Configuration: $MQ_ e The Indexer configuration
tion HOME /bin/migration/CopyConfigDirF refers to the

Directory iles.bat/sh. IndexerConfig.xml file.
Migration e Cache Conﬁguration: $MQ_ This is an optional file,

HOME /bin/migration/CacheConfigMer migrate if needed.

geUtil.bat/sh.
The utility copies specific

files from the old Config
directory to the new
Config directory based

on
migrateConfigFolderFi

les.prop configuration.

o The utility upgrades the
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Compone Script Name
nt

Usage

CacheConfig.xml file in
the Config directory. The
CacheConfig.xml file
includes setup and
configuration of Apache
Ignite cache.

<CopyConfigDirFiles.b
at> —-<path>: It prompts
for the previous version
$MQ_HOME.

Where path can be: -90_93, -
91_93, or -92_93
<CacheConfigMergeUtil> -
<path> -prop <version
CacheConfig file> -xmlin
<Source CacheConfig XML
file> -xmlout <Output
CacheConfig XML file>"

Where,

e <path> can be: -90_93, -
91_93, or -92_93

e <versionCacheConfig
XML f1ile> is the
previous version of
CacheConfig.xml with
an absolute path

e <Source CacheConfig
XML file> is the new
version of
CacheConfig.xml

e <Output CacheConfig
XML file> is the
absolute path to an user
CacheConfig.xml file.
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Compone Script Name
nt

Rules $MQ_
Migration

HOME/bin/migration/MigrateRules.bat./s
h

Usage

For example, $MQ_
HOME/config/Migration_

Cache_Config.xml.

After migration, back up the
new CacheConfig.xml file, and
then rename the Migration_
Cache_Config.xml file to
CacheConfig.xml to use it.

This utility adds new rules and
new default template to the
existing organization, and it
adds the new process selection
rule. You can also migrate
custom processes, forms, maps,
and rulebases.

o Ensure that the TIBCO
MDM server is up before
running this utility. Also
ensure that the OLD_MQ_
HOME variable is set.

¢ Ensure that you have
provided organization ID
in %MQ_
HOME%\bin\migration\o
rglist.txt and
orglist-
processSelection.txt.

o The organization IDs are
procured from the ID

column of the
ORGANIZATION table.

The following parameters are
mandatory:
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Compone

nt

FileWatch
er
Migration

Script Name

$MQ_
HOME/bin/migration/fileWatcherMergeUti
1.bat/sh

Usage

. -
addNewProcessSelectio
nRules: Adds new
process selection rule to
the existing organization
as defined in orglist-
processSelection.txt.

e -addDefaultTemplate:
Adds new default
template existing rule in
organization as defined
inorglist-
processSelection.txt.

¢ -addNewRules: Adds new
rules to the existing
organization as defined
inorg.list.

e —migrateRulesActions:
Migrates rules.

This utility allows you to
migrate the FileWatcher.xml
file from the previous version to
the new version.

fileWatcherMergeUtil -
<path> -prop <old
FileWatcher file>. -xmlin
<new FileWatcher file> -
xmlout <Output FileWatcher
file>
Where <path> can be: -90_93, -
91 93, or -92_93

<old FileWatcher file> is the
previous version of
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Compone
nt

Common
Directory
Migration

Script Name

$MQ_
HOME /bin/migration/CopyCommonDirFiles.
bat/sh

Usage

FileWatcher.xml with an
absolute path.

<new FileWatcher file> is the
new version of
FileWatcher.xml .

<Output FileWatcher file> is
the absolute path to the
FileWatcher.xml file of a user.

For example, $MQ_
HOME/config/Migration_

File_Watcher.xml.

After migration, back up the
new FileWatcher.xml file, and
then rename the Migration_
File_Watcher.xml file to
FileWatcher.xml and use it.

This script replaces standard
files from 9.x versions to 9.3.

CopyCommonDirFiles -
<path>

Where <path> can be: -90_93,
-91 93, or -92_93

e It prompts for new $MQ_
COMMON_DIR (Current
version $MQ_
HOME / common)

« It prompts for previous
$SMQ_COMMON_DIR
(Previous version $MQ_
HOME / common)

Note: Previous $MQ_
COMMON_DIR is updated
during migration to a
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Compone
nt

Work Item
Migration

Repositor
y Index
Migration
for

PostgreSQ

L

(Required
only if
you are
migrating

from 91 to

93)

Script Name

SMQ_
HOME/db/

databasename /migration/Migrate901_91/
createAndMigrateWIAttributes.sql

Run the createAndMigrateWIAttributes.sql
script only if you are migrating from the 9.0.x
version or previous version.

NA

Usage

new version. You must
use this $MQ_COMMON_DIR

Run the script to migrate the
values of work item attributes
from the WorkItemDetail table
to the WorkItemAttribute
table.

When the value of an attribute
is changed through work item
modification, the value in the
WorkItemAttribute table is
updated. The table is used for
sorting of work items based on
configured attributes.

Execute the script on a
particular enterprise.

Repository table contains
unique index, which includes
the PRODUCTIDEXT column. The
PRODUCTIDEXT column can
have NULL values.

PostgreSQL allows duplicate
nulls in the unique columns.
Therefore, you need to update
the unique indexes on the
repository table.

For every repository table,
remove index Repository_
Table_Name_IDX99 and
create two new indexes based
on the following new indexes:
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Compone Script Name Usage
nt

CREATE Unique index MCT_
34522_1DX99_10on MCT_
34522(CPRODUCTID,
CPRODUCTIDEXT,
CMODVERSION) WHERE
CPRODUCTIDEXT

IS NOT NULL;

CREATE Unique index MCT_
34522_1DX99_2 on MCT_
34522(CPRODUCTID,
CMODVERSION) WHERE
CPRODUCTIDEXT IS NULL;

A Caution: Caution: Ensure that you run all utilities from the directories in which
they are present (such as $MQ_HOME/bin/migration); do not run it from remote
locations by providing the absolute paths.

For example, do not run a script from a remote directory by providing $MQ_
HOME/bin/migration/scriptname.sh. Instead navigate to the $MQ_
HOME/bin/migration directory and then run scriptname.sh.

Postmigration Steps

o If DatabaseServerType=SQLSERVER, run copyRulesForSQLServer script from $MQ_
HOME /bin/migration on the current TIBCO MDM version.

« On migration, all the old workflows at the enterprise level are migrated.
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If any standard workflows exist with the custom activity, the old workflows are
backed up and replaced with new workflows on migration.

Custom workflows are not migrated. Previously, if you have customized any standard
workflows, after migration you need to re-customize them.

For the existing users, the old password is applicable until it expires. To enforce the
new password policy, keep the Password expiry period =0, and change Forgot
Password to true. For information about password configuration properties, see the
section, "Configuration Properties for Password" in TIBCO MDM System
Administration.

To resolve the migration errors that you may come across postmigration, see the
section Migration Troubleshooting.

Limitation
For TIBCO MDM, if Microsoft SQL Server is on Linux platform, migration to 9.3.0 is not
supported.

Applying Hotfixes

An updated customUtil.sh file is provided with a hotfix. Extract it to the $MQ_
HOME /build/custom directory.

Procedure

1.

2
3.
4

o

Uninstall TIBCO MDM from the Application Server.

. Create the directory $MQ_HOME/customEAR.

Copy the hotfix TAR file to $MQ_HOME /customEAR.

. Change directory to $MQ_HOME/customEAR and untar the hotfix tar file.

Copy customUtil.sh to $MQ_HOME/build/custom.

Change directory to $MQ_HOME/build/custom and run the following command:
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./customUtil.sh -updateEarFile

7. Enter y when prompted with "Ready to continue".

8. Enter the name of the hotfix JAR file when prompted for.

This creates an updated EAR file in the $MQ_HOME/customEAR directory.

9. Install the updated ECM. ear file in the Application Server.

o Note: See the TIBCO MDM Readme for more details.

Rolling Upgrades and High Availability Configuration

You can upgrade application servers using rolling upgrade, however with a few conditions.

The following conditions must be considered:
« If the database is changed, everything must be upgraded.

« If application servers share configuration, upgrade requires change to configuration.

Version of Infrastructure

In general, most infrastructure upgrades require upgradation of all the components at the
same time.

o Database version - All database servers must be upgraded at the same time.

o Operating system upgrade - Most operating system version upgrades can be done
one server at a time depending on compatibility matrix published by TIBCO and OS
vendors. In fact, all the servers are not required to be on the same OS platforms.

o Web server upgrade - Web server upgrade can be done independent of other
upgrades. You must upgrade each web server.

o JMS server - JMS server can be upgraded independent of other servers. Within a
JMS cluster, each of them must be upgraded at the same time.
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TIBCO MDM Application Server Upgrade

Application server version upgrade - As long as application server version is
supported by a TIBCO MDM release, it can be upgraded one at a time.

TIBCO MDM version upgrade - TIBCO MDM version may require an upgrade.

Database schema or seed data changes - If schema changes are required, all TIBCO
MDM instances must be upgraded together.

Configuration file changes - Each server can be upgraded by using a new
ConfigValues.xml file; while the previous version continues to use the previous
config file.

Executables - In some cases, all servers need to be upgraded at the same time
(assuming there are no database schema changes). For example, when an object
distributed over a queue has changed, it requires that all recipients are on the same
version to avoid deserialization errors.

Cache server - The Cache server may require a restart when TIBCO MDM server is
upgraded due to change in data objects, which are stored in cache. In this case, all
TIBCO MDM instances and all cache instances must be upgraded at the same time.

Advanced Search Engine - It is shipped with TIBCO MDM and follows the same
upgrade path as TIBCO MDM version upgrade.

High Availability

Each component can be clustered
o Database, that is, Oracle RAC
o TIBCO MDM instances
o Web servers
o Advanced Search Engines (Patterns)
o Cache servers
o JMS servers

TIBCO MDM can be configured to use clusters of other engines (database, cache,
JMS, Advanced search engine, and so on).

When a component fails, work is transferred to another server except for the
following points:
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o TIBCO MDM user sessions are not replicated. When TIBCO MDM server fails, in-
progress user transactions are discarded and the user is redirected to another
server. The transactions or operations, which are incomplete only those are
discarded. User must login again.

o When workflows failover to another server; depending on the workflow
configurations, sometimes a workflow activity may repeat. For example, when
a work item is created, distributed cache is updated to indicate that the work
item has been created. When workflow restarts, it does not generate duplicate
work items if such a marker is found. However, if cache has also failed, this
marker may be lost and a duplicate work item is generated. Same scenario
applies for any outgoing messages generated by the workflow.

o The workload is shared amongst all engines.

o TIBCO MDM instances share the workload using JMS queues. On failure of an
instance, workload is automatically redistributed.

o Cache can be set up to replicate data to more than one instance. On cache
failure, critical cached data is transferred to another server or a replicated
copy is used. Most of the cached data does not have to be replicated as it is
persisted to the database.

o TIBCO MDM server automatically connects to the next database, Advanced
Search Engine, cache, or JMS server.

o TIBCO MDM implements a wait and retry algorithm for transient system failures while
executing workflows. For example, if an intermittent network failure happens, which
causes database connection to be dropped, TIBCO MDM rolls back to the last
commit state and retry the operation.

o The web server can be setup to automatically redirect the users to next working
TIBCO MDM instance.

Migration Troubleshooting

Resolve the migration errors that you may come across after migrating to TIBCO MDM.

Issue Description Solution

TIBCO MDM After migration from the previous =~ Manually update the CacheConfig.xml
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Issue Description Solution
server start-  version to 9.0 version, the file. Perform any one of the following
up failure following exception may occur at  changes:
after the server startup: . -
migration P e Adjust limits of the DISTRIBUTED
8 INF-7508: Total of all and NEAR cache types. Ensure the
e 'FC.)I" T sum of these limits should be less
and near caches should than or is equal to (<=) 100.
not exceed 100 .
T o Replace the <Limit> cache

attribute with the <ListSize>
cache attribute. Specify the
appropriate value for the
<ListSize> cache attribute.
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Standard Predefined Components

All standard predefined components are shipped with the application, which include
standard MDM specific components and incremental GDSN specific components, if you
have installed the GDSN plugin.

« MDM Components: includes maps, rulebases, workflows, templates, forms, samples,
and misc. All these components are located in the relevant folders under $MQ_
HOME /common/standard.

o GDSN Components: includes maps, rulebases, workflows, and templates. All these
components are located in the relevant folders under $MQ_
HOME /datapool/common/standard.

The out-of-the-box templates and samples of TIBCO MDM are located in the $MQ_
HOME /Standard folder.

Warning: TIBCO does not recommend you to modify all components supplied in
this directory. If a modification is required, maintain the modified file in an
enterprise- specific directory.

MDM Specific Maps

The translation maps are located in the $MQ_HOME/common/standard/maps folder.

MDM Specific Maps

File Description

mp26importto26cateditadd.xsl This XSLT is used to translate a process
definition from the xpdl2 format to the TIBCO
MDM process definition (workflow) format.

mp26importto26cateditchange.xsl This file translates the import workflow request
mIXML document to a 'Record Modify'
workflow request mIXML document and sets
the document type and subtype before
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File

mp26importto26cateditdelete.xsl

mpfrom26topdfprodspecvl.xsl

mpfromebxml2lenvelopetomlxml_
Samplel.xsl

mpfromebxml2lenvelopetomlxml_
Sample2.xsl

mpfromebxml2lenvelopetounknown.xsl

mpfromebxml2lenvelopetounknownxml.xsl

mpfromebxml21ltotransportevent.xsl

Description
spawning the modify record subflow.

This file translates the import workflow request
mIXML document to a 'Record Delete'
document and sets the document type and
subtype before spawning the delete record
subflow.

This file provides a sample translation map for
conversion of record data to PDF. The record
data is in the mIXML format, typically output
of one of the workflow activities.

This file removes the ebXML wrapper and
extracts the mIXML payload from the received
message.

This file removes the ebXML wrapper and
extracts the mIXML payload from the received
message.

This file is used during
CommStandardinboundintgrMsg unmarshalling
for converting an ebXML message into the
mIXML format. Use this file if the ebXML
payload is within CDATA in the envelope.

This file is used during
CommStandardinboundintgrMsg unmarshalling
for converting an ebXML message into the
mIXML format. Use this file if the ebXML
payload is XML and is NOT within CDATA in
ebXML envelope.

This file is used during the unmarshalling

process for converting an ebXML message into
internal commEvent format.
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File Description

mpfromunknowntoebxml2lenvelope.xsl This file is used by the
CommStandardOutboundintgrMsg marshalling
pipeline to convert an internal message to the
ebXML format before sending it to an external
application.

mptrcommandtype.xslt This file is used by the ProcessServiceMessage
activity to translate the command type from
Query to Update in the response XML before
adding it to the response jar file.

Native80ToNew80MetaDataConverter.xsl During export of metadata (when only
repository export is requested), this stylesheet
is used to convert application generated
metadata into a new format which is more
structured, has a schema defined and hence
offers better validation.

New80ToNative80MetaDataConverter.xsl During import of metadata (when only
repository import is being processed) this
stylesheet is used to convert incoming
metadata (new format) into the native format
which the application s and processes
internally. Before this is done, incoming meta
data is validated against a schema.

xpd1l2Tocim.xsl This XSLT is used to translate a process

definition from the xpd|2 format to the TIBCO
MDM process definition (workflow) format.

GDSN Specific Maps

The translation maps specific to GDSN are located in the $MQ_
HOME /datapool/common/standard/maps folder.
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GDSN Specific Maps

File

mpfromlsync62cicwlto26vl.xsl

mpfromagentrics50cdnto26vl.xsl

mpfromagentrics50cicwlto26vl.xsl

mpfromagentrics50rfcinwlto26vl.xsl

mpfromagentrics50wlto26vl.xsl

mpfromcatact26tolsync62vl.xsl

mpfromcatact26toagentrics50cicvl.
xs'l

mpfromcatact26toagentrics50rfcinv
1.xsl

mpfromcatact26toagentrics50vl.xsl

Description

This XSLT translates an incoming CIC
message (1SYNC Item Authorization
Response) to the mIXML format.

This XSLT translates an Agentrics CDN
(Catalogue Delivery Notification) message
to the mIXML format.

This XSLT translates an Agentrics CIC
(Catalogue Item Confirmation) message to
the mIXML format.

This XSLT translates an Agentrics RFCIN
(Request for CIN) message to the mIXML
format.

This XSLT translates an Agentrics CIN
(Catalogue Item Notification) message to
the mXML format.

This XSLT translates an outgoing mIXML
message to the 1Sync Catalog Request
message format (1SYNC Item Maintenance
message).

This XSLT translates an outgoing mIXML
message to Agentrics CIC (Catalogue Item
Confirmation) message format.

This XSLT translates an outgoing mIXML
message to the Agentrics RFCIN (Request for
CIN) message.

This XSLT translates an outgoing mIXML
message to Agentrics CIN (Catalogue Item
Notification) message format.
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File

mpfromcatact26tononebxml70vl.xsl

mpfromcatact26toveloselcinvl.xsl

mpfromcatact26toveloselcinvl_all_
Attributes.xsl

mpfromveloselcintoveloselcinrvl.x
sl

mpfromveloseltomlxml26vl.xsl

MDM Specific Rulebases

Description

This sample map file generates a non-ebxml
outbound message.

This file translates outgoing mIXML
messages to a message format used in CIM-
to-CIM synchronization.

This file translates outgoing mIXML
messages to the message format used in
CIM-to-CIM synchronization. It maps all the
catalog attributes rather than filtering out
EAN.UCC format specific attributes.

This file is used in CIM-to-CIM
synchronization to generate a response for
an incoming message.

This file translates an incoming message to
the mIXML format during CIM-to-CIM
synchronization.

The rulebases are located in the $MQ_HOME/common/standard/rulebase folder.

MDM Specific Rulebases

File
allowAttrList.xml

DisplayAttrList.xml

skipAttrList.xml

Description
Use to specify the allow merge attributes.

Use to specify the name of the attributes
that you want to display in the report.

Use to specify the skip merge attributes.
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File

MatchAttrList.xml

rbconnectorprotocolderivation.xml

rbdefault.xml

rbexpirydate.xml

rbformatattributes.xml

rbgenerateid.xml

rbmessageprocessorderivation.xml

Description

Use to specify the name of matching
attributes and weightage. Using the
matching attributes, you can search for
close, not necessarily exact, matching
records.

This rulebase decides the protocol to be
used by the messaging handler for outgoing
messages or the response handler for
incoming messages.

This is the default synchronization
choreography derivation rulebase. It
provides a simple default operation for
outgoing messages.

This is a sample rulebase to demonstrate
work item expiry date calculation based on
record attributes. This rulebase is used to
determine if a work item is timed out if the
expiry method is set to COMPUTE.

This is a sample rulebase to customize
synchronization profile pages.

This is an empty placeholder rulebase which
is used in incoming message processing
workflows. Customize this rulebase to
provide a product ID generation algorithm, if
needed.

This rulebase evaluates the message
processor property key prefix(es) based on
various parameters associated with the
message being received. This prefix string is
used to pick up the message processor class
name from the Configurator to be
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File Description

instantiated to process the received
message.

rbpasswdval.xml This sample rulebase allows you to apply
certain policies for valid passwords.

rbresponsehandlerprotocolderivation.xml This rulebase is used to identify the protocol
used for message processing.

rbsendmessage.xml The generic page is available from the
Product View page, where there is an action
link for SendMessage based on the user
privileges (Role). The Ul that opens on
clicking this link is completely customizable
based on the underlined rulebase
rbsendMessage.xml. Currently, it is used to
send an RFCIN message and generate a fact
sheet.

The following customizations are possible:

o Customize the product attributes that
can be displayed.

e Customize action that can be
performed.

e Customize the MarketPlace and
TradingPartner Credentials.

e Customize the user defined attributes

rbveloselsupplier.xml This rulebase identifies different synch
operations for CIM2CIM.

rbworkitemdescription.xml This rulebase derives out-of-box work-item
descriptions.

RulebaseCustomFunction.JAVA This is a sample rulebase custom function
implementation.
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File

RulebaseCustomFunction.class

statusderivation.xml

GDSN Specific Rulebases

Description

This is a sample rulebase custom function
implementation.

This rulebase identifies the response status
received from the datapool and translates
the status into a TIBCO MDM-specific status.

This rulebase is used to summarize
synchronization status and to map the
status to business terms. Default
implementation is provided to support
standard synchronization for Agentrics and
1Sync.

The rulebases specific to GDSN are located in the $MQ_
HOME /datapool/common/standard/rulebase folder.

GDSN Specific Rulebases
File

_1lsync_catalogvalidation.xml

_1lsync_mastercatalog_
catalogvalidation.xml

_wwre_catalogvalidation.xml

Description

This rulebase declares validation rules for out-
of-the-box catalog synchronization for 1Sync
datapool.

This rulebase declares validation rules for
master catalog used in synchronization having
1SYNC catalog output map.

This rulebase declares validation rules for out-
of-the-box catalog synchronization for WWRE
(Agentrics) datapool.
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File

_wwre_mastercatalog_
catalogvalidation.xml

rbapprover.xml

rbconnectorprotocolderivation_

gdsn.xml

rbconnectorrolederivation.xml

rbduplicate.xml

rbeditor.xml

rbformatattributes_gdsn.xml

Description

This rulebase declares validation rules for
master catalog having WWRE (Agentrics)
catalog output map.

This is an empty rulebase which is used in the
workflow wfin26prodnotifretailerv4.xml
to flag any errors or warnings in the incoming
message data. This rulebase should be
customized as per your business process needs.

This rulebase decides the protocol to be used
by the messaging handler for outgoing
messages or the response handler for incoming
messages.

This rulebase decides the protocol to be used
by the messaging handler for outgoing
messages or the response handler for incoming
messages.

This rulebase provides a sample duplicate
check constraint for incoming messages. The
sample rulebase is used to implement
duplicate checks for GDSN incoming messages.

This is an empty rulebase which is used in
workflow wfin26prodnotifretailerv4.xml
and other incoming message processing
workflows to flag any errors or warnings in the
incoming message data. This rulebase should
be customized as per your business process
needs.

Format specific attributes to be used for a
marketplace.
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File

rbgdsnrelationship.xml

rbGPCClassificationscheme.xml

rbresponsehandlerprotocolderiva
tion_gdsn.xml

rbretailerval.xml

rbsendmessage_gdsn.xml

rbsyncstatusupdatederivation.xml

Description

This rulebase is used to identify the
relationship to be used in the GDSN edition.

This rulebase drives the classification codes for
the GPC predefined classification scheme.

This rulebase is used to identify the protocol
used for message processing.

This is a sample retailer validation rulebase.

The generic page is available from the Product
View page, where there is an actions link for
SendMessage based on the user privileges
(Role). The Ul that opens on clicking this link
is completely customizable based on the
underlined rulebase rbsendMessage. xml.
Currently, it is used to send an RFCIN message
and generate a fact sheet.

Following customizations are possible:

o Customize the product attributes that
can be displayed.

« Customize action that can be performed.

e Customize the MarketPlace and
TradingPartner Credentials.

o Customize the user defined attributes

This sample rulebase is used to customize
manual synchronization status update action.

TIBCO® MDM Installation and Configuration Guide



295 | Standard Predefined Components

File Description

Permissible values for attributes are defined in

rbtolerance.xml ]
this rulebase.

This rulebase identifies different sync

rbtransorasupplier.xml
PP operations for the 1SYNC datapool.

This rulebase derives the classification codes

rbUDEXClassificationscheme.xml . e .
for the UDEX predefined classification scheme.

This rulebase derives out-of-box work-item

rbworkitemdescription_gdsn.xml
P = descriptions for the GDSN edition.

This rulebase identifies different sync
operations for the Agentrics (WWRE) datapool
on the retailer side.

rbwwreretailer.xml

This rulebase identifies different sync
operations for the Agentrics (WWRE) datapool
on the supplier side.

rbwwresupplier.xml

MDM Specific Templates

The templates specific to MDM are located in the $MQ_HOME /common/standard/template
folder.

MDM Specific Templates
File Description
. Workflow request template for initiating import subflows for
tm26catimportvl.xm

1 approval and conflict resolution.

Workflow request template for initiating a synchronization
tm26catpubwcatvl.x . L. _
ml workflow - typically used when a synchronization profile is used.
Synchronization is initiated for all the records specified in the
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File Description
synchronization profile.
Workflow request template for initiating a synchronization

workflow - typically used when synchronization profile is NOT
used. Synchronization is initiated for one bundle of records.

tm26catpubwoutcatv
1.xml

MDM Specific Workflows

The workflows specific to MDM are located in the $MQ_COMMON_DIR/Standard/workflow
folder.

MDM Specific Workflows
File Description
cancelworkflowvl.xml Predefined workflow to cancel event. This sub
workflow is called from a cancelled workflow

before the cancel transition is executed. It is
advised not to change this workflow.

checkrestart_subflowvl.xml Subflow to check if the parent event should be
restarted.
wfin24classimpv2.xml Workflow to import classification codes based

on a datasource.

wfin26BackEndIntegrationVl_ Sample workflow for setting up integration
Samplel.xml with a backend system.

For more details, see TIBCO MDM System

Administration.
wfin26BackEndIntegrationVl_ Sample workflow for setting up integration
Sample2.xml with a backend system.

For more details, see TIBCO MDM System
Administration.
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File

wfin26catactionv2.xml

wfin26catmassupdate2vl.xml

wfin26catmassupdatevl.xml

wfin26catmultipartysynchv2.xml

wfin26dqcatsourceimportvl.xml

wfin26catsourceimportv2.xml

wfin26catsourcev4.xml

wfin26catsourcevs.xml

wfin26catsourcev6.xml

wfin26catsourcev7.xml

Description

Publication request notification (RFCIN)
workflow for GDSN.

Mass update workflow. This is a sub flow
called by wfin26catmassupdatevl.

The UpdateAutomaticHierarchies activity has
been added in this workflow. Additionally, the
workflow XML files are updated in built-in
MDM templates to include the new activity.

Mass update workflow.

Workflow to kick off synchronization when
more than one partner or backend system is
selected for synchronization. This workflow
iterates over each selected partner and
initiates synchronization for each partner.

Data quality workflow to process import
records sequentially.

Workflow for import or load and import
events.

The UpdateAutomaticHierarchies activity is
included in this workflow.

Workflow for data source loads.

Workflow for data source loads and import of
records.

Workflow for data source upload and import
of records.

Workflow for data source upload and import
of records. The following activities are added
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File

wfin26catsynchdbdumpv2.xml

wfin26catsynchdbdumpv3.xml

wfin26catsynchdbdumpv4. xml

wfin26catsynchdbdumpv4_
incremental.xml

wfin26catsynchv6.xml
wfin26catsynchv7.xml

wfin26dataservicev2.xml

Description

in this workflow:
o AddressCleansing

o UpdateAutomaticHierarchies

Workflow to extract the master catalog data
into a CSV file. The workflow does not create
any history and does not support incremental
extraction.

Workflow to extract and process repository
data.

Workflow to extract all relationships and
related records. Used by the Export Records
feature. You can customize the workflow for
exporting the selected records using the
EvaluateSubset activity.

Workflow to export data in an incremental
mode, that is, only records that are added or
updated after the last export are exported.
Used by the Incremental Export Records
feature.

Data Synchronization workflow.

Data Synchronization workflow.

Workflow to import or export metadata into
XML.
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File

wfin26dqcatsourcevl.xml

wfin26dgproductaddapprovalvl.xml

wfin26dqcatAddRecordApprovalvl.xml

wfin26dgscheduleddedupvl.xml

wfin26prodpubreqgapprovalv2.xml

wfin26productaddapprovalv3.xml

wfin26productaddinternaleditvl.xml

wfin26productcorrectvl.xml

wfin26producteditapprovalv3.xml

Description

o Import workflow for data quality.

« Data quality workflow for new record
introduction through the UI.

The UpdateAutomaticHierarchies activity is
included in these workflows.

Data quality workflow for new record
introduction with the match and merge
operation.

Scheduler duplicate detection workflow.
Synchronization request notification workflow.

Workflow to implement record introduction,
conflict resolution, and lights-out
synchronization of a new record.

The UpdateAutomaticHierarchies activity is
included in this workflow for add record
approval.

Invoked as a subflow process from
wfin26dgproductaddapprovalvl.xml.

Workflow to implement record correction. This
workflow is applicable only for Ul operation
correction.

Workflow to implement record modification,
conflict resolution, and lights-out
synchronization of changes.

The UpdateAutomaticHierarchies activity is
included in this workflow for modify and
delete record approval.
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File

wfin26productfactsheetpdfv2.xml

wfin26productmanualmergevl.xml

wfin26productmergeapprovalvl.xml

wfin26purgev2.xml
wfin26purgev3.xml
e wfin26hierarchycreateapprovalvl.
xml

e wfin26hierarchyeditapprovalvl.xm
1

e wfin26hierarchydeleteapprovalvl.
xml

wfin26hierarchylinkapprovalvl.xml

GDSN Specific Workflows

Description

Sample workflow to demonstrate how to
generate a PDF using translate activity. The
workflow generates a PDF file for record data.

Workflow to execute manual merge process.

Invoked as a subflow process from
wfin26dgcatsourcevl.xml.

Workflow to execute data purge.

Workflows to process approval of the
hierarchy operations. The following activities
are added in these workflows:

o GetHierarchy

¢ CheckHierarchyState
o LockHierarchy
o CheckLockState

o UpdateHierarchyState

The CreateWorkltem activity is updated for
hierarchy approval, that is, for create, edit,
delete, and link operations.

For more information, see TIBCO MDM
Workflow Reference.

Workflow to process approval of hierarchy link
operation. The UpdateHierarchyLink activity is
added in this workflow.

The workflows specific to GDSN are located in the $MQ_
HOME /datapool/common/standard/workflow folder.
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GDSN Specific Workflows

File Description

wfin26RFCINv2.xml

wfin26catsynchv7_gdsn.xml

wfin26cim2cimsyncVl.xml

wfin26proddatanotifbasicv
2.xml

wfin26prodnotifbasicv3.xml

wfin26prodnotifprocessv2.
xml

wfin26prodnotifretailerv4
.xml

wfin26prodnotifv2.xml

wfin26catactionRFCINvV2.xml

Workflow to receive and process publication request
(RFCIN) for suppliers.

Workflow to initiate synchronization with datapool or
custom channel.

CIM to CIM synchronization workflow.

Incoming record notification workflow for, primarily,
data add/change messages. Recommended for GDSN
retailers and similar usage where received data needs
to be processed and saved.

Incoming record notification workflow, primarily, for
data publication messages. It is a variation of
wfin26proddatanotifbasicv2.

Workflow to process incoming record messages and
save data.

Workflow to process incoming record messages and
save data. It is a variation of wfin26prodnotifprocessv2
targeted towards datapools and integration hubs.

Workflow to receive a notification of a response for a
previous synchronization request sent. Notification is
issued by TIBCO MDM when a response is received and
processed.

Workflow to implement initiation of publication
request (RFCIN) for retailers.
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File

wfoutlsync62cic26vl.xml

wfoutagentrics50cin26v2.x

ml

wfoutveloselcin26v2.xml

Forms

Description

Workflow to translate incoming 1Sync CIC message to
the mIXML format.

Workflow to translate incoming Agentrics CIN
message to the mIXML format.

Workflow to translate incoming CIM2CIM message to
the mIXML format.

The form files are located in the $MQ_HOME /common/standard/forms folder.

Forms

File

fm26ca.xml

fm26catpubtemplatev
1.xml

fm26importtemplatev
1.xml

Catalogs

Description

Used to define data mappings for most of the emails.

Used to define data mappings to create a spawn workflow request
for synchronization workflows.

Used to define data mappings to create an import approval
workflow request for a record. Such workflows are initiated when
import is done.

The catalogs are located in the $MQ_HOME /common/standard/catalog/master folder.
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Catalogs
File Description
CatalogProductvali Sarpplg custom record.valldator class. Out-of-the-box _
dator validations supported in the StandardCatalogProductValidator

can be overridden to provide custom validations.

Miscellaneous Files

The miscellaneous files are located in the $MQ_HOME /common/standard/misc folder.

Miscellaneous Files
File Description

This subscription pack contains catalog metadata and a SQL script

subscriptionpac .
required to handle RFCIN messages.

k.zip

o A Jar file which contains:

o Master catalog and output map for catalog format
EAN.UCC.Subscription. Master catalog will be associated
with GPC predefined classification.

o The catalog which uses the EAN.UCC.Subscription and
master catalog for RFCIN generation.

o Data source for import of subscription and corresponding
input map.

o Input map for master catalog.
¢ Rulebase validation file for master catalog.

o A SQL script to create associations with the datapools and a
sequence, MQ_SEQUENCE_SUBSCRIPTION, used in rulebase
validation to assign unique value to PRODUCTID.

Sample Files

The sample files are located in the $MQ_HOME/common/standard/samples folder.
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Sample Files

Folder/File

/authentication/LdapHelp
er.JAVA

/authentication/rolecrea
tion_sample.SQL

/BackEndIntegration_Using_
BW/Samplel.zip
/BackEndIntegration_Using_
BW/Sample2.zip

/BC-BW-
Configuration/SampleBC-
Configuration.csx

Description

Sample for LDAP authentication.

The following samples demonstrate how to integrate
TIBCO MDM with TIBCO BusinessWorks using JMS.

o Samplel.zip - Inbound Integration: In this
sample, BusinessWorks sends a JMS message to
add a record in TIBCO MDM and receives the
response message on the outbound queue which
can be consumed by BusinessWorks to verify if the
record was added successfully.

For more details, see Chapter 3 "Integration with
TIBCO Business Works - Sample 1" of the T/IBCO
MDM System Administrator’s Guide.

o Sample2.zip - Outbound Integration: When a
record add event occurs in TIBCO MDM, the
workflow sends a JMS message as an mIXML
document wrapped in ebXML payload to
BusinessWorks and the workflow is suspended till
it receives a notification from BusinessWorks.
Once the notification is received, the workflow is
successfully completed.

For more details, see Chapter 4 "Integration with
TIBCO Business Works - Sample 2" of the TIBCO
MDM System Administrator’s Guide.

This sample demonstrates how to integrate TIBCO MDM
with datapools like WWRE and 1Sync using TIBCO
BusinessConnect and TIBCO BusinessWorks.

For more details, see Chapter 7 "Configure TIBCO
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Folder/File

/BC-BW-
Configuration/SampleBWConfig
uration.zip

/CIM Repackaging and
code Reorg/8.0
Repackaging snapshot.xls
/CIM Repackaging and
code Reorg/Repackaging
impact on workflows and
rules

/configuration/insertCon
figDefinition_sample.sql

/CustomResponseHandler/C
ustomResponseHandler.jav
a

/EmailWorkitemHtmls/*x.ht
ml

/Java

Description

BusinessConnect and TIBCO BusinessWorks" of the
TIBCO MDM Installation and Configuration.

Sample documents to show repackaging impact.

This sample demonstrates how to add a rulebase file
entry to the ConfigurationDefinition table. The rulebase
added here is executed on the record before it is
published. The rulebase file must be present in the $MQ_
COMMON_DIR/mydir/rulebase folder.

Edit the script to change the data as per your business
requirement.

Connect to the database and run the following
script:sqlplus user/passwd@connect_string
@insertConfigDefinition_sample.sql

This sample demonstrates how to use more than one
registration key to queue the event accordingly.

See /CustomResponseHandler/Configuring Custom
Handler.txt for more information.

Sample work item emails that can be customized.

This workflow sample XML demonstrates how to use
Java-based transitions.
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Folder/File

Transitions/CustomCondit
ionEval.java

/Java
Transitions/wfin26productadd
deletevl.xml

/ISXAPPS/CIMTestGIProjec
t/*

Description

Compile the CustomConditionEval.java file and place
the generated class in the velosel patches folder.

In this class, a rule is defined which specifies the
condition in the Java format. The CDATA section
contains the custom condition
com.tibco.eval.CustomConditionEval.translateJmsToMLT
oDeleteRecord(Mcname) to be evaluated.

In this sample, if the master catalog name is "asset", the
"DeleteRecord" activity is executed. If the master
catalog name is not "asset", the "SaveRecord" activity is
executed. Here is how it is implemented:

e The method translateJmsToMLToDeleteRecord
evaluates to true only if the MasterCatalogName
is equal to "asset", so when the result returned is
true, "DeleteRecord" Activity is executed. Based
on the result returned, a further transition path is
decided.

e The method translateJmsToMLToSaveRecord
evaluates to true only if the MasterCatalogName
is not equal to "asset". So, if the result returned is
true, the "SaveRecord" Activity is executed.

This project allows you to build custom screens for
various operations such as the following using web
services:

1. Record Add

2. Record View

3. Record Modify

4. Inbox (work item list)
5. Work Item detail

See the /JSXAPPS/readme.txt for more information.
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Folder/File

/rulebase/connectsample.xml
/rulebase/disconnectsample.x
ml

/rulebase/queryanotherca
talog

rulebase/RulebaseCustomF
unction.java

Description

This sample demonstrates how to create a "Shipping
Address" relationship between two catalogs: Customer
and Address.

The rulebase declares two variables:

ADDRESSCATALOG link type="catalog"
ADDRESSRECORDS 1link type="record"

The constraint "AddressSoftlink" returns ADDRESS
records having the same CUSTOMERID as that of the
record being processed.

The constraint "AddressConnect" connects ADDRESS
records with the record being processed using the
relationship "Shipping Address". The following syntax is
used:

<constraint>
<name>AddressConnect</name>
<description>
Connect Address records using 'Shipping
Address' relationship
</description>
<action>
<connect>
<literal>Shipping Address</literal>
<!--relationship name -->
<var>ADDRESSRECORDS</var>
<literal>10</literal>
<!--quantity/optional/default 0-->
</connect>
</action>
</constraint>

This sample code defines the interface for third-party
product validators.

The code generates a product ID and assigns it to the
productid attribute if it does not exist. It then proceeds
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Folder/File

rulebase/nested/

Description
to call Standard validations.

The files in this folder demonstrate how to embed one
rulebase into another.

You can embed a rule in the following two rulebase
format files:

CatalogValidation.xml: In the
catalogvalidation.xml file the following rulebase
exists:

<constraint>

<name>Include embedl</name>
<description>RECORD_TYPE
dropdown</description>
<action>

<include>

<literal>/standard/rulebase/embedl.xml</1
iteral>
</include>
</action>
</constraint>

NewRecord.xml: The new record is embedded in
newrecord.xml.

<constraint>

<name>Include newrecord_embed</name>
<description>default
propagation</description>

<action>

<include>
<literal>/standard/rulebase/newrecord_
embed.xml</literal>
<literal>embed</literal>

</include>

</action>

</constraint>
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Folder/File

/scripts/Create_Purge_
Package.sql

scripts/denyAccessForAFu
nction.sql

/workflow/Merge_Match_
Record_Sample/
MatcherWorkItem.html

MatcherWorkItemServlet.j
ava

wfin26productaddapproval
v3.xml

wfin26productaddinternal
editvl.xml

rulebase/skipAttrlist.xm
1

workflow/FilesAndDirecto
riesCleaner.java

Description

This script creates a SQL package that is used to purge
all redundant data on TIBCO MDM 7.x installation. The
SQL package contains the procedure
PurgeHistoricalData, which actually purges the data.

For more information, see the usage guidelines
documented in the SQL script.

This script shows how access to a new function may be
denied for selected roles.

For more information, see the usage guidelines
documented in the SQL script.

The folder contains files that demonstrate how to
implement data quality using the match and merge
records functionality.

The MatcherWorkItem.html and
MatcherWorkltemServlet.java are used for the data
quality work item page. You can customize the work
item page. For more details, see TIBCO MDM
Customization.

This sample code demonstrates how to customize
purging. The workflow wfin26purgev3.xml has a
PurgeFilesThroughShellScript activity which calls
com.tibco.mdm.workflow.engine.activities.FilesAndDirect
oriesCleaner.purgeWorkDirectoryContent
(purgefilepath,waitForPurgeProcessFlag).

This method purges all physical files for the redundant
GeneralDocument entries using an OS-specific script.
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Folder/File Description

The script is generated by the Purge activity
(DocumentHandler.generateDocumentList()).

e (@param purgeFilePath — Relative path of the file
having list of the files to be purged.

e @param waitForPurgeProcess — A flag to identify
whether the child process which executes the
script should wait for the parent process. The
default value is false.

The following is a sample activity that calls the
method
FilesAndDirectoriesCleaner.purgeWorkDirectoryCon
tent.

<Activity Name="PurgeFilesThroughShellScript">
<Action>InterpretCommand</Action>

<Description lang="en">Delete the files associated with
purged data</Description>

<Parameter
direction
="in"

eval
="variable"

type
="string"
name="purgefilepath">relativepath</Parameter>

<l--<Parameterdirection="in" eval="constant"
type="boolean"
name="waitForPurgeProcess">true</Parameter> -->

TIBCO® MDM Installation and Configuration Guide



311 | Standard Predefined Components

Folder/File

workflow/MgActivityInstP
ostProcessl.java

Description

<Script format="bsh"><I/[CDATA[
java.lang.Boolean waitForPurgeProcessFlag = null;
if(waitForPurgeProcess != void)

waitForPurgeProcessFlag = waitForPurgeProcess;
com.tibco.mdm.workflow.engine.activities.FilesAndDirect
oriesCleaner.purgeWorkDirectoryContent
(purgefilepath,waitForPurgeProcessFlag);

</Script>

</Activity>

This sample demonstrates how to write a custom
workflow activity.

Every custom activity must be derived from
MgActivitylnstimpl and must provide the custom
implementation in the "execActivity" method. The
activity takes masterCataloglD as input parameter
(which is extracted from MgWorkflowState) and the
PostProcess method is called which in turn calls the
stored procedure post_processor.

The method getRequiredParameters() returns the array
of parameters required by this activity.

The workflow engine validates the input parameter list
before the activity is called.

The method getOptionalParameters() returns the
optional parameters. The list of optional parameters is
used by workflow to ensure that no parameter values
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Folder/File

workflow/wfin26productaddapp
rovalv3.xml

workflow/wfin26Testl.xml

Description

are carried over from a previous activity.

For example, if ReferenceSteplD is not defined in the
current activity, but was defined for a previous activity,
this parameter has to be reset to 'null’. Otherwise, the
value of ReferenceStepID used in the current activity will
be the value carried over from the previous activity.

This is a sample workflow that demonstrates "product
add approval". It routes the Product Add to editors and
approvers.

Following are the main steps involved in this workflow:

InternalEdit — Uses 'New Product Introduction Edit'
rules to identify editors.

InternalApproval — Uses 'Product Edit Approval' rules to
identify approvers.

TargettedRejection — Uses 'Data Custodian' rules to
identify data custodians.

This sample workflow demonstrates how to spawn a
subflow. The following is the sample fragment for
spawning the subflow.

<Activity Name="TestSubflow">
<Action>NoOperation</Action>
<Description>Test
Subflow</Description>
<Execution>ASYNCHR</Execution>
<!-- Assign some more values -->
<Parameter direction="in"
type="string" eval="constant"
name="eventState">SPAWNWORKFLOW</Paramete
r>
<Parameter direction="in"
type="document" eval="variable"
name="InDocument'">inDoc</Parameter>
</Activity>
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Folder/File Description

Activity implementation for Noop activity: The Noop
activity expects no IN parameters and returns the same
state. It is supplied primarily for routing when an empty
workflow or an activity that does nothing is required.
For example, a Noop activity can be useful in split/join
transitions.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation

website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current
than any other documentation included with the product. To access the latest

documentation, visit https://docs.tibco.com.

Product-Specific Documentation

The following documentation for TIBCO® MDM is available at the TIBCO® MDM Product
Documentation page:

TIBCO® MDM Release Notes

TIBCO® MDM Installation and Configuration

TIBCO® MDM Custom Installation
TIBCO® MDM Cloud Deployment
TIBCO® MDM User's Guide
TIBCO® MDM System Administration
TIBCO® MDM Customization
TIBCO® MDM Workflow Reference
TIBCO® MDM Web Services
TIBCO® MDM Best Practices
TIBCO® MDM Performance Tuning
TIBCO® MDM Troubleshooting
TIBCO® MDM Security Guidelines
TIBCO® MDM API Reference

To access documentation for this product, go to the following location:

TIBCO_HOME /release_notes/TIB_cim_9.3.0_docinfo.html
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Here, TIBCO_HOME is the top-level directory in which TIBCO products are installed. On
Windows, the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME
is /opt/tibco.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:
o For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

o For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support portal at
https://support.tibco.com.

» For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to
https://support.tibco.com. If you do not have a user name, you can request one by
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE
LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN
THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS
AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN
AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, and BusinessConnect, ActiveMatrix BusinessWorks, and
Enterprise Message Service are either registered trademarks or trademarks of TIBCO Software Inc. in
the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
Corporation and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which
is available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.
All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.
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THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN
THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer
to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1999-2020. TIBCO Software Inc. All Rights Reserved.
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